SIMATIC HMI

WinCC V6
Communication Manual

Order number of this manual is
6AV6392-1CA06-0AB0

Edition 12/2004
A5E00391331-01
Safety Guidelines

This manual contains notices which should be observed for your own personal safety as well as for the protection of property. Personal safety notices are indicated by a warning triangle while notices for property only are posted without any warning triangle. Warning notices are posted in descending order of risk level as follows:

Danger
Indicates an imminently hazardous situation which **will** result in serious injury or death unless precautionary measures are complied with.

Warning
Indicates an imminently hazardous situation which **may** result in serious injury or death unless precautionary measures are complied with.

Caution
Indicates an imminently hazardous situation which **may** result in minor to moderate injury unless precautionary measures are complied with.

Caution
Without a warning triangle indicates that property damage may occur unless precautionary measures are complied with.

Attention
Indicates that an unwanted event or status may occur unless the respective notice is complied with.

Note
Contains important information on product, product handling, or a particular part of the documentation to be noted.

Upon the occurrence of several risk levels at the same time, the warning notice for the highest risk level shall be used at all times. If a warning notice with triangle warns of personal dangers, the same warning notice may also have attached a warning for property damages.

Qualified Personnel
Implementation and operation of this software shall be permitted for **qualified personnel** only. Qualified personnel in the sense of this documentation shall be persons capable of giving due consideration to safety engineering standards during system usage of this software.

Brands
Registered trademarks of Siemens AG are listed in the preface.
Preface

Purpose

This Communication Manual is part of the WinCC documentation. It is concerned with planning, installation, and commissioning of a communication link from WinCC to an automation device.

This Communication Manual was created with the goal of supporting the user in the selection of optimized communication, its configuration and installation, all the way to its implementation. In addition, problems are supposed to be solved in the quickest way possible.

The Communication Manual is divided into three main chapters:

- General Part:
  This first part provides the reader with a general view of the topic of communication, especially communication using WinCC. It provides the necessary technical background knowledge, it discusses applicable components, and it explains general procedures during configuration.

- Decision Support:
  The second part guides the reader during the selection of optimized types of communication for his particular application. General circumstances are discussed which must be taken into consideration during the decision making process.

- Project Examples:
  The third part contains detailed descriptions of a multitude of project examples on various communication options, discussing the path from hardware installation all the way to successful commissioning of connections in single steps.

Diagnostics of communication link: The project examples each contain instructions on error search and error elimination, in case there are problems during commissioning of the communication link.

Changes from previous versions

<table>
<thead>
<tr>
<th>Edition</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>09/1999</td>
<td>WinCC Communication Manual V5.0</td>
</tr>
</tbody>
</table>

This Communication Manual was upgraded to the state of WinCC V6.0 SP2.

The Manual was expanded by the following topics:

OPC Historical Data Access (OPC HDA)
OPC Alarms & Events (OPC A&E)
OPC eXtensible Markup Language DA (OPC XML-DA)
PROFINET
<table>
<thead>
<tr>
<th>Documentation</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation Notes</td>
<td>Contains important information on scope of delivery, installation, and operation of WinCC.</td>
</tr>
<tr>
<td>WinCC V6 Basic Documentation</td>
<td>Provides information on</td>
</tr>
<tr>
<td></td>
<td>• WinCC in general</td>
</tr>
<tr>
<td></td>
<td>• Working with projects</td>
</tr>
<tr>
<td></td>
<td>• Working with tags</td>
</tr>
<tr>
<td></td>
<td>• Creating process pictures</td>
</tr>
<tr>
<td></td>
<td>• Dynamizing process pictures</td>
</tr>
<tr>
<td></td>
<td>• Creating procedures and actions using VBS</td>
</tr>
<tr>
<td></td>
<td>• Creating C functions and actions in Global Script</td>
</tr>
<tr>
<td></td>
<td>• Setting up a message system</td>
</tr>
<tr>
<td></td>
<td>• Archiving messages and process values</td>
</tr>
<tr>
<td></td>
<td>• Documenting configuration and Runtime data</td>
</tr>
<tr>
<td></td>
<td>• Setting up multi-language projects</td>
</tr>
<tr>
<td></td>
<td>• Setting up user administration</td>
</tr>
<tr>
<td></td>
<td>• Automated configuration using VBA</td>
</tr>
<tr>
<td></td>
<td>• Process communication</td>
</tr>
<tr>
<td>Reference data on VBS</td>
<td>Contains reference data on VBS</td>
</tr>
<tr>
<td>KHB</td>
<td>Provides information on planning, installation, and commissioning of a communication link from WinCC to an automation device.</td>
</tr>
<tr>
<td>WinCC V6 options (User Archives, Server, Redundancy)</td>
<td>Provides information on options</td>
</tr>
<tr>
<td></td>
<td>• User Archives: Creating and operating user archives</td>
</tr>
<tr>
<td></td>
<td>• Server: Set-up and operation of WinCC in multi-user system</td>
</tr>
<tr>
<td></td>
<td>• Redundancy: Set-up and operation of redundant systems</td>
</tr>
<tr>
<td>ProAgent</td>
<td>Provides information on ProAgent option (process diagnostics)</td>
</tr>
<tr>
<td></td>
<td>• Configuration of system-specific process diagnostics</td>
</tr>
<tr>
<td></td>
<td>• Determination of process errors and their causes</td>
</tr>
</tbody>
</table>
## Documentation

<table>
<thead>
<tr>
<th>Documentation</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebNavigator Dat@Monitor</td>
<td>Provides information on WebNavigator and Dat@Monitor options</td>
</tr>
<tr>
<td></td>
<td>• Configuration of web project</td>
</tr>
<tr>
<td></td>
<td>• Access to process pictures of web projects using intranet/internet</td>
</tr>
<tr>
<td></td>
<td>• Functions to display archive data and current process values in Excel</td>
</tr>
<tr>
<td></td>
<td>• Functions to display archive data from WinCC Historian in tables and trends</td>
</tr>
<tr>
<td></td>
<td>• Monitoring function for process pictures</td>
</tr>
<tr>
<td>Connectivity Pack</td>
<td>Provides information on Connectivity Pack option</td>
</tr>
<tr>
<td></td>
<td>• Installation of Connectivity Pack Server and Client</td>
</tr>
<tr>
<td></td>
<td>• Access to archive data using WinCC OLE DB Provider</td>
</tr>
<tr>
<td></td>
<td>• Access to archive data using Visual Basic</td>
</tr>
<tr>
<td>Basic Process Control</td>
<td>Provides information on controlling options of WinCC</td>
</tr>
<tr>
<td></td>
<td>• Picture Tree Manager</td>
</tr>
<tr>
<td></td>
<td>• Audio Alarm</td>
</tr>
<tr>
<td></td>
<td>• Chip card</td>
</tr>
<tr>
<td></td>
<td>• Lifebeat Monitoring</td>
</tr>
<tr>
<td></td>
<td>• Time Synchronization</td>
</tr>
<tr>
<td></td>
<td>• OS Project Editor</td>
</tr>
<tr>
<td>Process Control Runtime</td>
<td>Provides information on controlling options of WinCC for operation in Runtime</td>
</tr>
<tr>
<td>Operations Manual PCS 7 OS Process Control</td>
<td>Provides information on safe operation during process operation and monitoring using the SIMATIC PCS 7 process control system.</td>
</tr>
<tr>
<td>Open Development Kit</td>
<td>Enables programmer to utilize API functions of WinCC and access to data</td>
</tr>
</tbody>
</table>
Conventions

The Communication Manual uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>Indicates an operation using the left mouse button.</td>
</tr>
<tr>
<td>R</td>
<td>Indicates an operation using the right mouse button.</td>
</tr>
<tr>
<td>D</td>
<td>Indicates an operation using a double-click of the left mouse button.</td>
</tr>
<tr>
<td>Italics</td>
<td>Indicates terms from the WinCC environment, as well as terms referring to elements of the programming user interface.</td>
</tr>
<tr>
<td>Blue</td>
<td>Cross references are indicated in blue, with color codes only in the online document.</td>
</tr>
</tbody>
</table>

Locating information

In the printed version of the Communication Manual, information may be found as follows:

- The Table of Contents lists information by topic.
- The Index lists information by key words.

An online version of the Communication Manual is located in Technical Support.
An online version of the Communication Manual is located in Comprehensive Support.

- The Contents register tab contains information listed by topic.
- The Index register tab contains information listed by key word.
- The Search register tab permits word searches throughout the entire document.

Trademarks

The following names are registered trademarks of Siemens AG:
SIMATIC®, SIMATIC HMI®, SIMATIC Multi Panel®, SIMATIC Panel PC®, SIMATIC Multifunctional Panel®, HMI®, WinCC®, ProTool®, ProTool/Lite®, ProTool/Pro®

Other names in this document might be trademarks for which use by third parties for their own purposes may constitute an infringement of trademark ownership rights.
Service & Support Online Services

SIMATIC Customer Support offers comprehensive additional information on
SYMATIC products using online services:

- General current information may be obtained online under
  http://www.siemens.com/simatic

- Current product information, FAQ (Frequently Asked Questions), Tips and
  Tricks, and downloads may be obtained online under
  http://www.siemens.com/automation/service&support

Training Center

Siemens offers a number of training courses to provide easier familiarization with
automation systems. Please contact your regional training center, or our central
training center in D-90327 Nuremberg.

Telephone: +49 (0) 911-895-3200

Internet: http://www.sitrain.com

Email: info@sitrain.com

Additional Support

For any additional questions concerning SIMATIC HMI products, please contact
your Siemens representative in your respective agencies or branch offices.

The addresses may be found:

- In the Siemens catalog ST 80
- Online under http://www.siemens.com/automation/partner
- In the interactive catalog CA01 http://www.siemens.com/automation/ca01
## Contents

### 1 Basics Part

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1 Basics of Communication</td>
<td>1</td>
</tr>
<tr>
<td>1.1.1 Basic Terms of Communication</td>
<td>1</td>
</tr>
<tr>
<td>1.1.2 Network Topology</td>
<td>2</td>
</tr>
<tr>
<td>1.1.3 Classification of Networks</td>
<td>5</td>
</tr>
<tr>
<td>1.1.4 Access Methods</td>
<td>8</td>
</tr>
<tr>
<td>1.1.5 ISO-OSI Reference Model</td>
<td>9</td>
</tr>
<tr>
<td>1.1.6 Connection of Bus Systems</td>
<td>13</td>
</tr>
<tr>
<td>1.2 Communication Networks</td>
<td>15</td>
</tr>
<tr>
<td>1.2.1 Overview of Industrial Communication</td>
<td>16</td>
</tr>
<tr>
<td>1.2.2 Sub-Networks in Industrial Communication</td>
<td>18</td>
</tr>
<tr>
<td>1.2.3 Industrial Communication Using MPI</td>
<td>20</td>
</tr>
<tr>
<td>1.2.4 Industrial Communication Using PROFIBUS</td>
<td>22</td>
</tr>
<tr>
<td>1.2.4.1 Access Method in PROFIBUS</td>
<td>23</td>
</tr>
<tr>
<td>1.2.4.2 Protocol Architecture of PROFIBUS</td>
<td>24</td>
</tr>
<tr>
<td>1.2.4.3 Transfer Media</td>
<td>25</td>
</tr>
<tr>
<td>1.2.5 Industrial Communication Using Ethernet</td>
<td>27</td>
</tr>
<tr>
<td>1.2.5.1 Protocol Profiles of Industrial Ethernet</td>
<td>28</td>
</tr>
<tr>
<td>1.2.5.2 Transport Protocols</td>
<td>28</td>
</tr>
<tr>
<td>1.2.5.3 Transfer Media</td>
<td>29</td>
</tr>
<tr>
<td>1.2.5.4 PROFINET</td>
<td>30</td>
</tr>
<tr>
<td>1.3 Interface Standard OPC</td>
<td>32</td>
</tr>
<tr>
<td>1.3.1 OPC Data Access (OPC DA)</td>
<td>33</td>
</tr>
<tr>
<td>1.3.2 OPC Historical Data Access (OPC HDA)</td>
<td>34</td>
</tr>
<tr>
<td>1.3.3 OPC Alarms &amp; Events (OPC A&amp;E)</td>
<td>34</td>
</tr>
<tr>
<td>1.3.4 OPC eXtensible Markup Language DA (OPC XML-DA)</td>
<td>35</td>
</tr>
<tr>
<td>1.4 Communication Configuration</td>
<td>36</td>
</tr>
<tr>
<td>1.4.1 WinCC Process Communication</td>
<td>36</td>
</tr>
<tr>
<td>1.4.2 WinCC Communication Configuration</td>
<td>38</td>
</tr>
</tbody>
</table>

### 2 Decision Support

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1 Project Analysis</td>
<td>44</td>
</tr>
<tr>
<td>2.1.1 Quantity Structure</td>
<td>44</td>
</tr>
<tr>
<td>2.1.2 Notes on Configuration</td>
<td>51</td>
</tr>
<tr>
<td>2.1.2.1 Cycle of Data Updates</td>
<td>52</td>
</tr>
<tr>
<td>2.1.2.2 Type of Data Updates</td>
<td>53</td>
</tr>
<tr>
<td>2.1.2.3 Organization of Data</td>
<td>55</td>
</tr>
<tr>
<td>2.2 Performance Data</td>
<td>57</td>
</tr>
<tr>
<td>2.2.1 Process Communication</td>
<td>57</td>
</tr>
<tr>
<td>2.2.2 Comparison of Communication Systems</td>
<td>60</td>
</tr>
<tr>
<td>2.2.3 Serial Communication</td>
<td>63</td>
</tr>
<tr>
<td>2.2.4 Communication Using MPI</td>
<td>63</td>
</tr>
<tr>
<td>2.2.4.1 Communication Processors</td>
<td>64</td>
</tr>
<tr>
<td>2.2.4.2 SIMATIC S7 PROTOCOL SUITE</td>
<td>65</td>
</tr>
</tbody>
</table>
## Contents

2.2.5 Communication Using PROFIBUS .......................................................... 66
2.2.5.1 Communication Processors .................................................................... 66
2.2.5.2 Communication Driver ............................................................................. 67
2.2.5.3 PROFIBUS DP ........................................................................................ 69
2.2.5.4 PROFIBUS FMS ...................................................................................... 70
2.2.5.5 SIMATIC S7 PROTOCOL SUITE ............................................................ 71
2.2.5.6 SIMATIC S5 PROFIBUS FDL ................................................................. 72
2.2.6 Communication Using Industrial Ethernet ............................................... 73
2.2.6.1 Communication Processors .................................................................... 73
2.2.6.2 Communication Driver ............................................................................. 74
2.2.6.3 Communication Using SIMATIC S5 ........................................................ 76
2.2.6.4 Communication Using SIMATIC S7 ........................................................ 78

3 Project Examples ....................................................................................... 81
3.1 Installation of SIMATIC NET Software .................................................... 82
3.2 Communication with SIMATIC S7 Using Industrial Ethernet (Hard Net) .......................................................... 84
3.2.1 Commissioning of CP 1613 Communication Processor .......................... 86
3.2.2 Creating the STEP7 Project S7_IEH ....................................................... 92
3.2.3 Creating WinCC Project WinCC_S7_IEH ............................................. 110
3.2.4 Diagnostics of Communication Link Using Industrial Ethernet (Hard Net) .......................................................... 125
3.3 Communication with SIMATIC S7 Using Industrial Ethernet (Soft Net) .......................................................................................... 129
3.3.1 Commissioning of Communication Processor CP 1612 ....................... 131
3.3.2 Creating STEP7 Project S7IES ............................................................ 136
3.3.3 Creating WinCC Project WinCC_S7IES .............................................. 155
3.3.4 Diagnostics of Communication Link Using Industrial Ethernet (Soft Net) .......................................................................................... 170
3.4 Communication with SIMATIC S7 Using TCP/IP .................................. 174
3.4.1 Commissioning of CP 1612 Communication Processor ....................... 176
3.4.2 Creating STEP7 Project S7_IETCP ...................................................... 181
3.4.3 Creating WinCC Project WinCC_S7_IETCP ....................................... 201
3.4.4 Diagnostics of Communication Links Using TCP/IP ............................. 217
3.5 Communication with SIMATIC S7 Using OPC .................................. 221
3.5.1 Configuring WinCC Stations .................................................................. 223
3.5.2 Commissioning of Communication Processor CP 5611 ....................... 231
3.5.3 Creating STEP7 Project S7_OPC ............................................................ 237
3.5.4 Configuring S7-OPC Server .................................................................... 263
3.5.5 Creating WinCC Project WinCC_S7_OPC ........................................... 271
3.5.6 Diagnostics of Communication Link Using OPC ................................ 287
3.6 Communication with SIMATIC S7 Using PROFIBUS ........................... 290
3.6.1 Commissioning of CP 5613 Communication Processor ....................... 292
3.6.2 Creating STEP7 Project S7_PB ............................................................ 297
3.6.3 Creating WinCC Project WinCC_S7_PB ............................................ 324
3.6.4 Diagnostics of Communication Link Using PROFIBUS ....................... 340
3.7 Redundant Communication with SIMATIC Highly Available Through CP 1613 .......................................................... 344
3.7.1 Commissioning of CP 1613 Communication Processor ....................... 346
3.7.2 Creating STEP7 Project S7_Redundancy .............................................. 353
3.7.3 Creating WinCC Project WinCC_Redundancy ................................... 383
3.7.4 Diagnostics of Redundant Communication Connection Using Industrial Ethernet .......................................................... 396
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.8</td>
<td>Communication WinCC - SlotPLC</td>
<td>399</td>
</tr>
<tr>
<td>3.8.1</td>
<td>Installation of WinAC Basis</td>
<td>401</td>
</tr>
<tr>
<td>3.8.2</td>
<td>Creating STEP7 Project S7_SlotPLC</td>
<td>406</td>
</tr>
<tr>
<td>3.8.3</td>
<td>Creating WinCC Project WinCC_SlotPLC</td>
<td>419</td>
</tr>
<tr>
<td>3.8.4</td>
<td>Diagnostics of Communication Link Using SlotPLC</td>
<td>433</td>
</tr>
<tr>
<td>3.9</td>
<td>Communication WinCC - WinCC Using OPC DA</td>
<td>435</td>
</tr>
<tr>
<td>3.9.1</td>
<td>Configuring WinCC Stations for OPC (WinCC - WinCC)</td>
<td>437</td>
</tr>
<tr>
<td>3.9.2</td>
<td>Creating WinCC Project WinCC_OPC_SERVER</td>
<td>445</td>
</tr>
<tr>
<td>3.9.3</td>
<td>Creating WinCC Project WinCC_OPC_CLIENT</td>
<td>455</td>
</tr>
<tr>
<td>3.9.4</td>
<td>Diagnostics of Communication Link Using OPC</td>
<td>467</td>
</tr>
<tr>
<td>3.10</td>
<td>Communication WinCC - WinCC Using OPC XML</td>
<td>471</td>
</tr>
<tr>
<td>3.10.1</td>
<td>Requirement for Utilization of OPC XML</td>
<td>473</td>
</tr>
<tr>
<td>3.10.2</td>
<td>Configuration of WinCC Stations for OPC XML</td>
<td>474</td>
</tr>
<tr>
<td>3.10.3</td>
<td>Creating WinCC Project WinCC_OPC_XML_SERVER</td>
<td>478</td>
</tr>
<tr>
<td>3.10.4</td>
<td>Creating WinCC Project WinCC_OPC_XML_CLIENT</td>
<td>488</td>
</tr>
<tr>
<td>3.10.5</td>
<td>Diagnostics of Communication Link Using OPC XML</td>
<td>501</td>
</tr>
<tr>
<td>3.10.6</td>
<td>Error Diagnostics (OPC XML)</td>
<td>505</td>
</tr>
<tr>
<td>3.11</td>
<td>Communication Using WinCC Web Navigator</td>
<td>507</td>
</tr>
<tr>
<td>3.11.1</td>
<td>Configuring WinCC Stations for Web Navigator</td>
<td>509</td>
</tr>
<tr>
<td>3.11.2</td>
<td>Creating WinCC Project WinCC_Web_Server</td>
<td>512</td>
</tr>
<tr>
<td>3.11.3</td>
<td>Configuring WinCC Web Navigator Server</td>
<td>522</td>
</tr>
<tr>
<td>3.11.4</td>
<td>Commissioning of WinCC Web Client</td>
<td>531</td>
</tr>
<tr>
<td>3.11.5</td>
<td>Error Diagnostics (WinCC Web Navigator)</td>
<td>533</td>
</tr>
</tbody>
</table>
1 Basics Part

Introduction

This chapter will allow you a general view on the subject of communication, in particular communication with WinCC. It will provide you with the necessary technical background, address the applicable components, and describe the general procedures during configuration.

This chapter is divided into the following sections:

• Basics of Communication
• Communication Networks
• Communication Project Planning

1.1 Basics of Communication

Introduction

This section of the manual will provide you with basic information on the subject of communication. It will provide you with generally accepted knowledge which maintains validity beyond the specific subject matter of communication using WinCC.

This present section gives information on the following topics.

• Basic Terms of Communication
• Network Topology
• Classification of Networks
• Access Procedures
• ISO-OSI Reference Model
• Linkage of Bus Systems
1.1.1 Basic Terms of Communication

Introduction

This section will explain basic terms on the subject of communication. Primarily those areas are discussed which are concerned with the exchange of information between a PLC and WinCC.

The following explains the most important communication terms which are important for the exchange of information between a PLC and WinCC.

Communication

The transfer of data between two communication partners is described as communication.

The transferred data may serve several purposes. During communication between a PLC and WinCC, the following options exist:

- Control of communication partners
- Status display of communication partners
- Message of unexpected statuses in communication partner
- Archiving
Communications partners

Communications partners are modules capable of exchanging data with each other. This may be central modules and communication processors in the PLC, or communication processors in the PC.

Station

A station is a device which, as a unit, may be attached to one or several subnets. This may be a PLC or a PC, for example.

Subnet

A subnet describes the unit of all physical components necessary to build a data transfer route, as well as the necessary procedures for data exchange.

Network

A network represents a unit consisting of one or several, similar or different, subnets connected with each other. The net encompasses all stations capable of communicating with each other.

Connection

A connection is a configured logical assignment of two communication partners to implement a certain communication service.

Each connection has two endpoints which contain the necessary information to address the communication partner, as well as additional attributes for establishing the connection.

Communication functions

Communication functions are functions offered by a software interface which make use of a communication service.

Communication functions are capable of transferring data between communication partners with different performance data. They are capable of controlling the communication partner or may inquire about its current operational status.

Communication service

A communication service describes communication functions with defined performance features, such as data exchange, controlling, or monitoring of equipment.
Software interface

Software interfaces offer communication services in end-user systems. A software interface not necessarily offers all communication functions of a communication service.

A communication service may be provided in the respective end-user system (PLC, computer) using different software interfaces.

Protocol

A protocol is an exact bit agreement between communication partners to implement a certain communication service.

The protocol defines the structural contents of data transmission on the physical link. Among others, it specifies operation mode, procedure during establishment of connection, data safety, and transmission rate.
1.1.2 Network Topology

Introduction

This section explains the different structures within a subnet. If several independent automation components exchange information between each other, these structures must physically be connected. This physical connection may be structured quite differently. The term network topology describes the principal geometric arrangement of this structure. Individual communication partners form the nodes of this structure.

Point-to-Point

The simplest structure is obtained if the network consists of exactly two communication participants. This arrangement is described as "Point-to-Point connection".

![Point-to-Point Diagram]

Line

A network arrangement with line structure is based on a main line, the so-called bus. All communication partners are connected to the main line by an access line. It is not possible that several communication partners communicate at the same time. It must be specified that only one participant communicates at any given time. This requires regulations which are called bus access procedures. These are also required for the structures described in the following.

Failure of one communication partner hardly has any effect on the entire network.

![Line Diagram]
Ring

In this structure, the communication partners are connected such that they form a ring.

A ring may be structured such that it consists of serial "Point-to-Point connections". In such a structured network, each node may also function as an amplifier. This will allow to bridge larger distances.

Failure of one communication partner in a ring structure, however, will cause greater problems than in a line structure.

Star

In a star structure, all communication partners are connected to a central star coupler. This star coupler will control the entire communication.

Failure of the star coupler will generally cause a network failure. Failure of another communication partner hardly has any effect on the entire network.
Tree

A tree structure is a hierarchical connection of several line structures. These may be of different dimensions but also of different types.

The elements linking the individual lines are of special importance. If the linked parts are of the same type, they may be pure amplifiers. However, if the linked parts are of different types, transformers are necessary.
1.1.3 Classification of Networks

Introduction

This section explains network classes which are dependent upon geographical extent of the networks.

With respect to geographical extent of the networks, these may be divided into three classes.

- LAN (Local Area Network): Extent < 5km
- MAN (Metropolitan Area Network): Extent < 25km
- WAN (Wide Area Network): Extent > 25km

An exact assignment to these classes, however, cannot be made in each case due to diffuse boundaries between them.

Topology

Because of different distances to be bridged, a statement on topologies used may be made as well.

Topology of a WAN will be dictated by geographic conditions. For economic reasons, mostly irregularly meshed networks in tree structure are created. In contrast, topology of a LAN is more clearly structured since the focus is less on line economy and more on overall functionality. Typical topologies for LAN are line, ring and star.

Transfer Medium

The choice of physical transmittal medium depends especially on desired network extent, intended interference protection and transfer rate.

The following transfer media are listed by increasing complexity and performance:

- Two-conductor untwisted, unshielded
- Two-conductor twisted, unshielded
- Two-conductor twisted, shielded
- Coax cable
- Fiber optic conductor
1.1.4 Access Methods

Introduction

This section explains mechanisms used to regulate bus access to individual communication partners.

On a bus, only a single node may telegram at any given time. The access method regulates which communication partner may telegram at what times. The number of listening receivers is of no importance.

Master/Slave

In a Master/Slave method, the master controls the entire bus communication. It sends data to the connected slaves and requests them to send data in return.

Direct communication between slaves is usually not intended. This process is characterized especially by simple and therefore efficient bus control.

The Master/Slave method is also used in the area of field buses, such as Profibus-DP.

Token Passing

In the Token Passing method, a token circulates through the communication network as a message of transmitting authorization. Here, the token describes a fixed bit pattern.

The owner of a token may transmit. However, he must pass on the token no later than a previously specified time.

Bus access by the master in the PROFIBUS network is regulated using the Token Passing method.

CSMA/CD

In the CSMA/CD method (Carrier Sense Multiple Access with Collision Detection), each participant may transmit at any time. However, the condition is that no other bus participant transmits.

Conflicts arise because of transmittal run times if two communication partners transmit simultaneously upon a free bus. In this case, the participants recognize the collision and stop their transmittal. They will attempt another transmittal after a certain amount of time.

The Industrial Ethernet uses the CSMA/CD method.
1.1.5 ISO-OSI Reference Model

Introduction

During data exchange between two sites using a common bus system, the transfer system and access method must be defined. For this reason, the International Standardization Organization (ISO) defined a 7 layer model.

General Information

For sufficient and secure communication, layers 1, 2 and 4 are required.

- Layer 1 specifies the physical conditions, such as current and voltage level.
- Layer 2 specifies the access mechanism and addressing of partners.
- Layer 4 is responsible for data security and data consistency. This layer is also called the transport layer. Aside from transport control, the transport layer also handles tasks for data flow control, blocking and acknowledgment.

ISO-OSI Reference Model

Layers defined in the ISO-OSI Reference Model regulate the behavior of communication partners. The layers are arranged in horizontal tiles. Layer 7 is the top layer. Communication partners may only communicate within the same layer.

The Reference Model does not specify how the individual layers are realized in each case. This is up to the specific implementation.

Individual layers are specified as follows.

<table>
<thead>
<tr>
<th>Layer</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Application Layer</td>
<td>Supplies the application-specific communication services.</td>
</tr>
<tr>
<td>6</td>
<td>Presentation Layer</td>
<td>Transforms the data from the standard display of the communication system to the site-specific form.</td>
</tr>
<tr>
<td>5</td>
<td>Session Layer</td>
<td>Responsible for connecting, disconnecting, and monitoring of communication link.</td>
</tr>
<tr>
<td>4</td>
<td>Transport Layer</td>
<td>Responsible for transport control.</td>
</tr>
<tr>
<td>3</td>
<td>Network Layer</td>
<td>Responsible for data path from one address to another.</td>
</tr>
<tr>
<td>2</td>
<td>Data Link Layer</td>
<td>Responsible for error recognition and error elimination.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specifies bus access method.</td>
</tr>
<tr>
<td>1</td>
<td>Physical Layer</td>
<td>Specifies physics of data transmission.</td>
</tr>
</tbody>
</table>
Physical Layer (Bit transfer layer)

This layer is responsible for the transparent transmission of bits through the physical medium. It specifies the electrical and mechanical properties, as well as transmittal types.

Data Link Layer (Connection layer)

This layer ascertains the transmittal of bit sequences between two systems. This includes recognition, elimination and passing on of transmittal errors, as well as flow control. In local networks, the connection layer is additionally responsible for the exclusive access to the transfer medium.

The connection layer is separated into two partial layers. These are referred to as Layer 2a and Layer 2b.

- Medium Access Control (MAC)
- Logic Link Control (LLC)

Network Layer (Exchange layer)

This layer is concerned with the exchange of data between end systems. End systems are sender and receiver of a message whose path may go through several transit systems under certain circumstances. The network layer will determine the optimum path (Routing).

Transport Layer (Transport layer)

This layer provides the user with a reliable End-to-End connection. Services offered include establishment of a transport connection, data transmittal, and termination of the connection. The service user may typically demand a particular quality of service (QoS, Quality of Service). Quality parameters, for example, are transmission rate or remaining error rate.

Session Layer (Communication control layer)

The main task of the communication control layer is synchronization of communication links. Using the services of the communication control layer, synchronization points may be set during a longer transmittal. During an unwanted disconnect, the transmittal process may be reestablished from a certain synchronization point on.
**Presentation Layer (Presentation layer)**

This layer is responsible for the transformation of data into the application-required format. Furthermore, it compresses texts and converts different codes used by the communication partners. A particular feature of this layer is also the realization of a common communication language.

**Application Layer (Application layer)**

The application layer encompasses the application-specific services of different communication applications. Since there is a multitude of applications, it is particularly difficult to achieve a unified standard.
1.1.6 Connection of Bus Systems

Introduction

For a continuous flow of information between two different subnets, special connection elements are required. The following section contains information on different types of these connection elements.

General Information

Depending on the extent of connection and subnets to be connected, respectively, network connections differentiate between Repeaters, Bridges, Routers and Gateways.

These connection elements may be projected onto the ISO Reference Model based on their tasks.

Repeater

A Repeater copies the information received on the line to the respective other side, and amplifies it in the process. A Repeater functions transparently for all layers of the communicating participants, i.e., the physical layers of both networks must be identical.

Repeaters are often not used for connecting two equal subnets but are used to expand or extend an existing subnet, e.g. a bus system.

Bridge

The Bridge is used to connect subnets which work with the same protocols at the connection layer (Logical Link Control, LLC). The transfer media and bus access methods (Medium Access Control, MAC) of the subnets may be different.

The Bridge is primarily used to connect local networks of different topologies, or to connect specific structures to subnets by special applications.
Router

The Router serves to connect ISO networks which differ in layers 1 and 2.

The Router determines the optimum path (communication path) of a message through an existing network (Routing). Criteria for the optimum path may, for example, be the path length or the least delay in transmission. In order to fulfill its task, the Router will change target address and source address of network layers for incoming data packages before passing on the data.

Since Routers must perform a much more complex task than Bridges, they offer a slower processing speed.

Gateway

A Gateway serves to connect networks of different architecture. This allows to connect two arbitrary subnets. With respect to the ISO Reference Model, the task of a Gateway is the compilation of communication protocols of all layers. A Gateway also allows the connection of an ISO network with a non-ISO network.

Network connections using Gateway are typically characterized by significant effort and lower speed.
1.2 Communication Networks

This section of the manual contains information on different options in industrial communication. It will discuss different applicable communication types, explain their features, and showcase the components applicable in each case.

In this chapter you will find information on the following subjects:

- Overview of Industrial Communication
- Subnetworks in Industrial Communication
- Industrial Communication Using MPI
- Industrial Communication Using PROFIBUS
- Industrial Communication Using Ethernet
1.2.1 Overview of Industrial Communication

Introduction

This section contains information on industrial communication and categorizes different communication types into their respective industrial environment.

General Information

Corresponding to different requirements, different communication networks are available for industrial communication. The following representation offers a rough assignment between different automation levels and their appropriate communication networks.
Management Level

At the management level, superordinate tasks are processed which concern the entire operation. Among tasks of the management level are:

- Archiving of process values and messages
- Processing and analysis of process values and messages
- Logging of process values and messages

Operational data may also be collected and processed for more than one site. From the management level, access to other sites is possible as well. The number of participants in such a network can exceed 1,000.

The dominating network type at the management level is the Ethernet. In order to bridge large distances, the TCP/IP protocol is used primarily.

Cell Level

At the cell level, automation tasks are processed. Here, PLCs, operating and monitoring devices, as well as computers are connected to each other.

Depending on performance requirements, the cell level uses primarily Industrial Ethernet and PROFIBUS network types.

Field Level

The field level represents the link between PLCs and the system. Devices deployed at the field level supply process values and messages, for example, and pass on commands to the system.

Data amounts to be transmitted at the field level are low in the majority of cases.

The dominating network type at the field level is the PROFIBUS. Communication with field devices often uses the DP protocol.

Actuator-Sensor Level

At the actuator-sensor level, a master communicates with actors and sensors connected to its subnet. A characteristic of this level is the transmittal of extremely low data amounts, but with an extremely fast response time.
1.2.2 Sub-Networks in Industrial Communication

Introduction

This section contains information on various sub-networks used in industrial communication. However, only sub-networks are considered which are of relevance to communication with WinCC. Therefore, the Actor/Sensor interface (AS-i) is not described.

General Information

Corresponding to different requirements in industrial communication, different sub-networks are offered. The following list is sorted by increasing sub-net performance:

- MPI
- PROFIBUS
- Industrial Ethernet

MPI

The MPI (Multi Point Interface) is suitable for networking at the field and cell level with small aerial extent. However, it may only be used jointly with SIMATIC S7. The MPI interface of the central module group is used for communication with the PLC. The MPI interface has been designed as a programming interface and quickly approaches its performance limits upon increasing communication demands.

A computer may use its own MPI card to access an MPI sub-net. Furthermore, all communication processors may be used which permit access to the PROFIBUS.
PROFIBUS

The PROFIBUS (Process Field Bus) is a sub-net designed for field and cell level. It represents an open, manufacturer-independent communication system.

The PROFIBUS is used to exchange smaller to medium-sized amounts of data between a few communication partners.

Using the DP (decentralized peripheral) protocol, the PROFIBUS facilitates communication with intelligent field devices. This type of communication is characterized by rapid cyclical data exchange.

Industrial Ethernet

The Industrial Ethernet is a sub-net suitable for control and cell levels. It facilitates the exchange of extensive amounts of data over large distances between many participants.

The Industrial Ethernet represents the most powerful sub-net available in industrial communication. It may be configured with a small amount of effort and may be expanded without problems.
1.2.3 Industrial Communication Using MPI

Introduction

This section contains information of MPI sub-nets. In addition to features and application options of this sub-net, components are described which are necessary or applicable within the network.

General Information

The MPI sub-net may be used at the field or cell level. Communication partners to be networked must be members of the SIMATIC S7 family.

Using MPI, up to 32 participants may be networked at reasonable costs. However, a cutback in the network performance must be acceptable for the decision regarding a communication solution using MPI.

MPI facilitates communication using the MPI interface which is integrated into PLCs of the SIMATIC S7 family. This interface has been designed as a programming interface.

The following display shows an example of an MPI network. Bus access by the individual communication partners is implemented using the programming interface of the respective central module groups.
Access Methods

MPI uses the "Token Passing" access method. Access permission to the bus is passed from station to station. This access permission is referred to as a token. If a site has received the token, it may telegram. Upon expiration of a set waiting period, at the latest, the token must be passed on. If a site has no telegram to send, the token is passed on directly to the next site within the logical ring.

Transfer Media

The same transfer technology may be used for the MPI network as for the PROFIBUS network. Optical and electrical networks may also be installed. The transfer rate is typically at 187.5 kBit/s. However, the most recent version of S7-400 achieves transfer rates of up to 12 MBit/s.
1.2.4 Industrial Communication Using PROFIBUS

Introduction

This section contains information on PROFIBUS sub-nets. In addition to features and application options of this sub-net, components are described which are necessary or applicable within the network.

General Information

The PROFIBUS sub-net is designed for the field and cell level with a maximum number of 127 participants.

PROFIBUS represents an open, manufacturer-independent communication system. It is based on the European standard EN 50170, Volume 2, PROFIBUS. Through compliance with these requirements, PROFIBUS guarantees openness for linking standard components by other manufacturers.

The following display shows an example of a PROFIBUS network. It offers a gross overview of which components are used mainly for implementation of bus access by individual communication partners. Because of the open PROFIBUS concept, devices by other manufacturers may also be connected to the communication network.
1.2.4.1 Access Method in PROFIBUS

Access Method

The PROFIBUS network differentiates between active and passive network participants. Active participants utilize the "Token Passing" access method, passive participants utilize the "Master/Slave" access method. The access method in PROFIBUS is therefore also referred to as "Token Passing" with subordinate Master/Slave.

All active sites form a logical ring in a specified sequence. Each active site knows of the other active stations and their sequence within PROFIBUS. The sequence is independent of the physical order of active sites on the bus.

Access permission to the bus is passed from active station to active station. This access permission is referred to as a token. If a site has received the token, it may telegram. Upon expiration of a set waiting period, at the latest, the token must be passed on. If a site has no telegram to send, the token is passed on directly to the next site within the logical ring.

If an active station with subordinate passive stations receives the token, the station will request data from the subordinate station, or will send data to the other stations. Passive stations cannot receive the token.
1.2.4.2 Protocol Architecture of PROFINET

Protocol Architecture

For different applications of PROFINET, optimized protocols are available for the respective requirements. From the user point of view, the following protocol variants exist:

- PROFINET-FMS (Fieldbus Message Specification) is suitable for communication of PLCs in smaller networks at the cell level, as well as communication with field devices with FMS interface. The high-performing FMS services offer an additional application and greater flexibility for handling extensive communication tasks.

- PROFINET-DP (Decentralized Peripheral) represents a profile for connecting decentralized peripherals with very fast response times, such as ET 200.

- PROFINET-PA (Process Automation) represents an expansion of PROFINET-DP compatible with PROFINET-DP. PROFINET-PA was especially designed for the area of process technology and permits connection of field devices even in areas subject to explosion risks.

All protocols use the same transfer technology and a unified bus access protocol. They may therefore be operated with one single line.

In addition to the protocols listed above, the following communication options are supported as well:

- FDL services (SEND/RECEIVE) permit a simple and quickly realizable communication to any communication partner which supports FDL (Field Data Link).

- S7 functions permit optimized communication within the SIMATIC S7 system.
1.2.4.3 Transfer Media

Introduction

The PROFIBUS network may be installed as an optical or an electrical network. Mixed structures of electrical and optical PROFIBUS networks may also be implemented.

Electrical Network

The electrical PROFIBUS network uses as transfer medium shielded, twisted two-conductor wires. The RS 485 interface works on voltage differences. It is therefore less sensitive to interference than a voltage or current interface.

Different PROFIBUS partners are connected to the bus using a bus terminal or a bus connector plug. Up to a maximum of 32 participants may be connected to one segment. Individual segments are connected to each other using a repeater. The transfer rate may be set in increments from 9.6 kBit/s to 12 MBit/s. The maximum segment length depends on the transfer rate.

The following table contains maximum distances which may be bridged with and without use of repeaters:

<table>
<thead>
<tr>
<th>Transfer rate</th>
<th>Distance without Repeater</th>
<th>Distance with Repeater</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.6 - 93.75 kBit/s</td>
<td>1000 m</td>
<td>10 km</td>
</tr>
<tr>
<td>187.5 kBit/s</td>
<td>800 m</td>
<td>8 km</td>
</tr>
<tr>
<td>500 kBit/s</td>
<td>400 m</td>
<td>4 km</td>
</tr>
<tr>
<td>1.5 Mbit/s</td>
<td>200 m</td>
<td>2 km</td>
</tr>
<tr>
<td>3 - 12 MBit/s</td>
<td>100 m</td>
<td>1 km</td>
</tr>
</tbody>
</table>
Optical Network

The optical PROFIBUS network uses fiber optic cables as transmittal medium. The fiber optic variant is insensitive to electromagnetic interference, is suitable for large ranges, and optionally uses plastic or glass optical conductors. The transfer rate may be set in increments from 9.6 kBit/s to 12 MBit/s. The maximum segment length is independent of transfer rate, except for redundant optical rings.

For the design of an optical PROFIBUS network, two different connector technologies are available.

- Using Optical Link Modules (OLM) with plastic or glass fiber optic cables:
  Using OLM permits the design of an optical network in linear, ring, or star structure. Connection of end devices takes place directly at the OLM. Optical rings may be designed as single strand rings (cost-optimized) or as dual strand rings (increased network availability).

- Using Optical Link Plugs (OLP), passive bus participants may be connected to an optical single strand ring in a very simple manner. The OLP is plugged directly onto the PROFIBUS interface of the bus participant.

Maximum bridgeable distances for the optical PROFIBUS network range beyond 100 km for all transfer rates.
1.2.5 Industrial Communication Using Ethernet

Introduction

This section contains information on Industrial Ethernet sub-nets. In addition to features and application options of this sub-net, components are described which are necessary or applicable within the network.

General Information

The Industrial Ethernet is the most powerful sub-net used in the industrial field. It is suitable for the cell level as well as the management level. The Industrial Ethernet permits the exchange of extensive amounts of data over large distances between many participants.

The Industrial Ethernet has been standardized as an open communication network in accordance with IEEE 802.3. It was specifically designed to provide economical solutions to demanding communication tasks in the industrial environment. Among the decisive advantages of this sub-net are its speed, simple expandability and openness, as well as high degree of availability and worldwide distribution. Configuration of an Industrial Ethernet sub-network requires very little effort.

Access Method

The Industrial Ethernet uses the access method of CSMA/CD (Carrier Sense Multiple Access/Collision Detection). Each communication participant must check prior to telegramming whether or not the bus trunk is available at the time. If the bus trunk is available, the communication partner may telegram immediately.

If two communication partner begin to telegram at the same time, a collision occurs. This collision is recognized by both partners. The communication partners terminate their telegrams and reinitiate another telegram attempt after a certain amount of time has passed.
1.2.5.1 Protocol Profiles of Industrial Ethernet

Protocol Profiles

Using the Industrial Ethernet, communication may be facilitated by using the following protocol profiles:

- **MAP (Manufacturing Automation Protocol)** uses MMS services as user interface.
- The **TF protocol** contains the open automation protocol SINEC AP proven in many applications. Building on these, the technological functions of TF are available.
- **SEND/RECEIVE** offers functions which permit simple and quick implementation of communication between S5 and S7 with each other on the one hand, and with the PC on the other hand.
- **S7 functions** permit optimized communication within the SIMATIC S7 system. A change of communication profile without changing the user programs is possible.

1.2.5.2 Transport Protocols

Possible Transport Protocols

Several transport protocols are available for communication using Industrial Ethernet:

- **ISO transport** offers services for transfer of data using process-to-process connections. User data may be split into several data telegrams.
- **ISO-on-TCP transport** corresponds to the TCP/IP standard with RFC 1006 expansion. This expansion is necessary since TCP/IP uses data stream communication without splitting user data.
- **UDP** offers only unsecured data transfer.
1.2.5.3 Transfer Media

Introduction

The Industrial Ethernet may be installed as an optical or an electrical network. Mixed structures consisting of electrical and optical networks may also be realized. This allows to use advantages and configuration options of both network types.

Electrical Network

The electrical Industrial Ethernet offers two wiring options:

- Triax cables (AUI)
- Industrial Twisted Pair cables (ITP)

In order to connect communication module groups to an ITP network using only one AUI interface, a twisted pair transceiver (TPTR) must be used.

Optical Network

The optical network may be designed in linear, ring, or star structure. Glass fiber optic cables are used exclusively for this.
1.2.5.4 PROFINET

Introduction

As part of Totally Integrated Automation (TIA), PROFINET represents the logical continuation of the following systems:

- PROFIBUS DP (established field bus)
- Industrial Ethernet (communication bus for cell level)

Functions and services from both systems are integrated into PROFINET.

PROFINET, as an Ethernet-based automation standard by PROFIBUS International, therefore defines an all-manufacturer encompassing model for:

- Communication
- Automation
- Engineering

PROFIBUS International originated from PROFIBUS Nutzerorganisation e.V. (User Organization).

WinCC & PROFINET

You may access PROFINET modules using the S7 PROFINET Master.

Additionally, WinCC can communicate with PROFINET using OPC. In order to do so, you must operate the SIMATIC PC Station as the PROFINET IO Controller.
SIMATIC PC Station

A "PC Station" is a PC with communication modules and software components within the automation solution using SIMATIC.

PC Station as PROFINET IO Controller

Using the appropriate communication modules and software components, you may operate any PC station as the PROFINET IO Controller.

PC applications of the PC station have the following access options to the PROFINET IO Controller:

- As OPC Client using the OPC Server PROFINET IO
- Directly using the PROFINET IO user interface (RTE Base programming interface)

PC applications may use only one of these access options (Open/Close sequence) at any given time.

Communication

<table>
<thead>
<tr>
<th>Functions</th>
<th>OPC Server PROFINET IO</th>
<th>RTE Base Programming Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reading and writing of IO data</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Reading and writing of data sets</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Receiving and acknowledging of alarms</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Note

Additional information may be found in the Siemens documentation on the subject of "Profinet".
1.3 Interface Standard OPC

Introduction

This section contains information on interface standard OPC and its application options.

General Information

OPC (OLE for Process Control) represents an open communication standard for components in the automation area. Using this concept achieves the integration of office applications, operating, and monitoring systems such as WinCC, controlling, and field devices.

OPC is defined by the OPC Foundation as an open interface standard. The OPC Foundation represents an association of more than 320 companies in the automation industry. The current specification of OPC is accessible to anyone free of charge using the internet. Information on individual members of the OPC Foundation and their product offerings are also available.

The internet address of the OPC Foundation is:

- [http://www.opcfoundation.org](http://www.opcfoundation.org)

Communication Concept

Minimum components of an OPC Configuration are always an OPC server and an OPC client. The OPC server represents an application which provides data to an OPC client. The OPC client downloads the data for further processing.

WinCC and OPC

WinCC supports the following OPC specifications:

- OPC Data Access (DA)
- OPC Alarms & Events (OPC A&E)
- OPC Historical Data Access (OPC HDA)
- OPC eXtensible Markup Language DA (OPC XML-DA)
1.3.1 OPC Data Access (OPC DA)

Introduction

The OPC DA specification defines an interface for reading and writing of realtime data.

WinCC OPC-DA Server

The WinCC OPC-DA Server complies with OPC DA specifications 1.0a, 2.0, and 3.0.

The WinCC OPC-DA Server makes available online tag values of the WinCC project to other applications. Applications may be running on the same computer or on computers as part of the connected network.

The WinCC OPC-DA Server is activated once the OPC Client accesses the WinCC OPC-DA Server through a connection. In order to successfully establish an OPC communication, you must observe the following:

• The WinCC project of the WinCC OPC-DA server must be activated.
• The computer of the WinCC OPC-DA must be accessible through its IP address.

WinCC OPC-DA Client

The WinCC OPC-DA client may access the process values of a PLC using the OPC-DA server of a manufacturer XYZ. There are a multitude of OPC-DA servers by different manufacturers. Each of these OPC-DA servers has a unique name (ProgID) for identification purposes. This name must be used by the OPC-DA client in order to address the OPC server.

The WinCC OPC-XML client consists of two parts:

• OPC Item Manager for displaying and browsing of OPC servers, establishing WinCC connections, and creating WinCC tags
• Communication drivers (WinCC channel) for data exchange in activated project

Using the OPC Item Manager, you may inquire the name of the OPC-DA server.

The WinCC OPC-DA client may access OPC DA servers compliant with specifications 1.0a, 2.0, or 3.0.
1.3.2 OPC Historical Data Access (OPC HDA)

Introduction

The OPC HDA specification defines an interface for access to archived data.

WinCC OPC-HDA Server

The WinCC OPC-HDA Server complies with OPC-HDA specification 1.1. The WinCC OPC-HDA server provides required data from the WinCC archive system to the OPC-HDA client. Data access may be read or write.

All OPC-HDA clients of specification OPC Historical Data Access 1.1 may access the WinCC OPC-HDA server.

Additional information on configuration of WinCC OPC-HDA servers may be found in the WinCC documentation in Chapter "Interfaces" > "OPC - OLE for Process Control".

1.3.3 OPC Alarms & Events (OPC A&E)

Introduction

The OPC Alarms & Events specification defines an interface for monitoring events.

WinCC OPC-A&E Server

The WinCC OPC-A&E server is compliant with OPC-A&E specification 1.0. The WinCC OPC-A&E server may only be used on a WinCC server. The WinCC OPC-A&E server represents a Condition Related Event Server.

In a Condition Related Event Server, the event is linked to a certain condition. For example, the condition may be a limit value violation of a tag.

In addition, there is a Simple Event Server and a Tracking Event Server:

- In a Simple Event Server, the event represents simple information, such as start, stop, or user logon.
- A Tracking Event Server differs from a Simple Event Server by the fact that additionally a UserID is issued. Events for a Tracking Event Server are, for example, operations by a user.

All OPC-A&E clients of specification OPC Alarms & Events 1.0 may access the WinCC-OPC A&E Server.

Additional information on configuration of WinCC OPC-A&E servers may be found in the WinCC documentation in Chapter "Interfaces" > "OPC - OLE for Process Control".
1.3.4 OPC eXtensible Markup Language DA (OPC XML-DA)

**Introduction**

OPC XML represents a standard which enables communication using a platform-independent protocol over the internet. A client is no longer restricted to the Windows environment. Data access using OPC XML has a functional extent similar to OPC Data Access.

**WinCC OPC-XML Server**

The WinCC OPC-XML is implemented as the web service of Microsoft Internet Information Server (IIS). The WinCC OPC-XML server supplies the OPC-XML client with OPC process data as a website. The website is accessed using the internet via HTTP.

The WinCC OPC-XML server is not visible in WinCC. If an OPC-XML client requests data, the web service is automatically started by the web server. In order to successfully establish an OPC communication, you must observe the following:

- The WinCC project of the WinCC OPC-XML server must be activated.
- The computer of the WinCC OPC-XML server must be accessible through HTTP.

**WinCC OPC-XML Client**

The WinCC OPC-XML client may access the process values of a PLC using the OPC-XML server of manufacturer XYZ.

The WinCC OPC-XML client consists of two parts:

- OPC Item Manager for displaying and browsing of OPC servers, establishing WinCC connections, and creating WinCC tags
- Communication drivers (WinCC channel) for data exchange in activated project
1.4 Communication Configuration

Introduction

This section contains information on configuration of a communication connection in a WinCC project. The general concept of WinCC process communication is explained, as well as configuration procedure for process communication and its diagnostics.

This present section will provide information on the following topics.

- WinCC Process Communication
- WinCC Communication Configuration

1.4.1 WinCC Process Communication

Data Manager

Administration of a data set is handled by the data manager in WinCC. However, this manager is not visible for the user. The data manager works with data created within the WinCC project and saved in the project data bank. It assumes the entire administration of WinCC tags during the runtime of WinCC Runtime. All WinCC applications must request the data from the data manager as WinCC tags. These applications include Runtime, Alarm Logging Runtime, and Tag Logging Runtime, among others.

Communication Drivers

In order for WinCC to communicate with different available PLCs, different communication drivers are used. The WinCC communication drivers connect the data manager to the PLC.

A communication driver represents a DLL which communicates with the data manager using a Channel API interface. The Channel API interface is specified by the data manager. The communication driver supplies the WinCC tags with process values.
Communication Structure

The administration of WinCC tags in Runtime is handled by the WinCC data manager. Different WinCC applications direct their tag requests to the data manager.

The data manager obtains the requested tag values from the process. This is facilitated using the communication driver tied into the respective WinCC project. The communication driver forms an interface between WinCC and the process through one of its channel units.

The hardware connection to the process is usually facilitated using a communication processor. The WinCC communication driver sends requests to the PLC using the communication processor. The PLC sends the requested process values back to WinCC in respective response telegrams.
1.4.2 WinCC Communication Configuration

Introduction

This section contains information on configuration steps for establishing a communication link to a PLC in WinCC.

Communication Drivers

In WinCC, communication is facilitated through various communication drivers. There is a multitude of communication drivers available for linking different automation systems through different bus systems.

Linking a communication driver in the WinCC project takes place in WinCC Explorer. The communication driver is linked to tag management. In general, this takes place by clicking on the "Tag Management" entry and the "Add New Driver" entry. Afterwards, all communication drivers installed on the computer are offered in a selection dialog. Each communication driver can only be linked to the WinCC project once, not several times.
Communication drivers are files with the file extension ".chn". Communication drivers installed on the computer are located in the WinCC installation directory in subdirectory "bin".

Following linkage of the communication driver to the WinCC project, it will be displayed WinCC Explorer as an additional sub-item next to the "Internal Tags" entry in Tag Management.

Channel Unit

The communication driver entry in Tag Management contains at least one, in many cases several sub-items. These are the so-called Channel Units. Each Channel Unit forms an interface to exactly one subordinate hardware driver and therefore to exactly one communication module in the computer. For the Channel Unit, you define which communication module should be addressed.

You configure this assigned module in the "System Parameter" dialog. You open the dialog by clicking on the entry of the respective Channel Unit in WinCC Explorer and the "System Parameter" entry.

This dialog has a different appearance in different communication drivers. Here you configure the module to be used by the Channel Unit. However, input of additional information on communication using this module may be necessary.
Connection
You establish a connection to a PLC so that the Channel Unit may read process values from the PLC and may write process values. A new connection is established by clicking on the entry of the respective Channel Unit in WinCC Explorer and on the "New Driver Connection" entry.

The type of parameters to be set for the connection may differ from one communication driver to the next. The connection must definitely be assigned a unique name within the project. In general, using the additional parameters to be set will specify the communication partner to be addressed.

WinCC Tags
In order to obtain access to specific data of the PLC, you need to configure WinCC tags. In contrast to internal tags which do not have any process connection, these tags are referred to as external tags.

WinCC tags are created for each configured connection. Creation of a new WinCC tag is facilitated by clicking on the entry of the respective connection in WinCC Explorer and selecting the "New Tag" entry.
The property dialog of the tag opens. In this dialog you will specify various properties of the tag.

Assign a unique name to the tag.

Furthermore, the data type of the tag must be specified. In relation to external tags, WinCC supports the following tag types:

- Binary tag
- Unsigned 8-bit value
- Signed 8-bit value
- Unsigned 16-bit value
- Signed 16-bit value
- Unsigned 32-bit value
- Signed 32-bit value
- Floating-point number 32-bit IEEE 754
- Floating-point number 64-bit IEEE 754
- Text tag 8-bit character set
- Text tag 16-bit character set
- Raw Data Type

For numeric data types, with the exception of data type "Binary tag", you may execute a type conversion. This means that a WinCC tag may reference a data area in the PLC which does not correspond to the data type of the WinCC tag.

No type conversion is executed by default. The WinCC tag is assigned a data area in the PLC which corresponds to the data type of the WinCC tag.
For numeric data types, with the exception of data type "Binary tag", you may also perform linear scaling. The value range of a quantity available within the process may then be linearly projected onto a certain value range of a WinCC tag.

For example, the process may demand presentation of actual values in units "bar". However, in WinCC you are supposed to enter this value in "mbar". The simplest solution to this problem is the use of linear type conversion shown in the following figure.

Tags of data type "Text tag 8-bit character set" as well as "Text tag 16-bit character set" require a length statement. This length statement is in characters. This means that for a tag of type "Text tag 16-bit character set", intended to take on 10 characters, a length of 10 characters must be configured.

WinCC must be assigned to a data area in the communication partner. They must be addressed in a certain way in the communication partner. The type of addressing depends on the type of communication partner. The dialog for setting the address of a tag may be opened by clicking the "Select" button.
2 Decision Support

Introduction

This chapter offers support in the decision for one of the communication solutions offered. General procedures are presented, based on the existing circumstances and requirements posed for a project, which will allow you to select the best-suited communication solution.

Factors for Selecting a Communication Solution

Factors which enter the decision for a communication solution are extremely complex. The timing for the decision to be made is important. The best time for this is the planning state for a system. If it is supposed to build on an existing system, the available latitude to play with existing circumstances is typically quite limited.

Experience from a multitude of existing projects shows: It makes sense to plan for a sufficiently large reserve during configuration of a communication solution. The rule of thumb is approximately 20%. The comparatively low additional costs for this pay off as savings many times over during later configuration and expansion.

The main factors in a decision for one of the communication solutions offered are:

- Data amount to be handled
- Number of participants
- Network extent
- Expected expandability

Procedure in selecting the communication solution

This chapter is divided into the following sections:

- Project Analysis Requirements posed to communication by the own project must be specified exactly.
- Performance Data Specified requirements posed to communication must be compared to services offered by various communication options.
2.1 Project Analysis

Introduction

This section offers you a guide with support for exact specifications of requirements for the communication system.

In order to come to the proper decision on a communication solution, it is important to know which requirements are asked of the communication system in the first place. You must gather and analyze all necessary data. The following information refers exclusively to determining such communication requirements.

An important foundation for determining such requirements is the quantity structure. Furthermore, you must take into consideration the existing specifications for hardware and software used.

This chapter is divided into the following sections:

• Quantity Structure Determining the projected data amounts and origin of data.
• Notes on Configuration Reduction of communication load and increase in performance.

2.1.1 Quantity Structure

Introduction

The assessment of quantity structure will help you in determining the data amount to be handled by the communication system. This will require, among others, what data amounts are needed by the WinCC project and where the WinCC project must obtain the data from.

You obtain the needed data amount by adding the data amounts required by individual applications. Therefore, you determine the requirements of the following applications:

• Graphics Runtime
• Alarm Logging Runtime
• Tag Logging Runtime
• Global Script Runtime (including C actions in individual WinCC pictures)
• Customer-specific applications
Requirements of Graphics Runtime

Graphics Runtime will require from data manager only those data needed for updating the values in the currently displayed WinCC picture. This means that requirements imposed upon the communication system depend on individual pictures and may be rather different from one WinCC picture to the next.

The communication load caused by Graphics Runtime which will enter your decision is determined by the picture with the highest communication volume.

Requirements of Alarm Logging Runtime

Alarm Logging Runtime will require from data manager all tags to be monitored in a cycle set by the system. This may be event tags or tags for boundary value monitoring.

If no configurations have been implemented in Alarm Logging, the data to determine the number of messages may typically be deduced from measurement points and I/O lists.

Requirements of Tag Logging Runtime

Tag Logging Runtime will require from data manager all tags to be archived. Tag Logging Runtime will follow the update cycle specified for the respective tag. Whether these archived tag values are displayed as a trend or table will have no influence on the entire requirements for the communication system.

If no configurations have been implemented in Tag Logging, the data to determine the number of tags whose values are to be archived may typically be deduced from customer requirements for archiving and production run logs.

Requirements of Global Script Runtime

Requirements imposed by Global Script Runtime upon the communication system depend on the type of tag request in WinCC scripts and their runtime cycles.

Take note that WinCC scripts may be executed globally as well as locally only in individual WinCC pictures.

Determination of Global Script Runtime requirements may therefore, in a worst case scenario, permit only a rough estimate of data amounts to be handled.
**Communication Telegrams**

Communication between individual communication partners is facilitated by sending telegrams. This is concerned with communication between:

- PLCs and operating and monitoring stations
- Between PLCs
- PLCs and their peripherals

Instead of the term telegram, one often uses the term PDU (Protocol Data Unit).

For example, a WinCC station requests certain data from a PLC by sending request telegrams. In return, the PLC sends the requested data in the form of a response telegram to the WinCC station.

The following display shows an example of a telegram structure.

<table>
<thead>
<tr>
<th>Telegram Header</th>
<th>Contains general telegram information. This can include, among other things, information about the telegram type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telegram Body</td>
<td>Contains the user data of the telegram. This can be tag values</td>
</tr>
<tr>
<td>Address Information, e.g. 4 Byte</td>
<td></td>
</tr>
<tr>
<td>Net Data, e.g. 2 Byte</td>
<td></td>
</tr>
</tbody>
</table>
Net space requirement of WinCC tags

In order to determine the data volume required by WinCC, information is needed on the space requirements of individual WinCC tags. This space requirement will vary greatly between individual data types. The following table lists the space requirement of WinCC tag types.

<table>
<thead>
<tr>
<th>Pos.</th>
<th>Tag type:</th>
<th>Space requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Binary tag</td>
<td>1 byte</td>
</tr>
<tr>
<td>2</td>
<td>Unsigned 8-bit value</td>
<td>1 byte</td>
</tr>
<tr>
<td>3</td>
<td>Signed 8-bit value</td>
<td>1 byte</td>
</tr>
<tr>
<td>4</td>
<td>Unsigned 16-bit value</td>
<td>2 bytes</td>
</tr>
<tr>
<td>5</td>
<td>Signed 16-bit value</td>
<td>2 bytes</td>
</tr>
<tr>
<td>6</td>
<td>Unsigned 32-bit value</td>
<td>4 bytes</td>
</tr>
<tr>
<td>7</td>
<td>Signed 32-bit value</td>
<td>4 bytes</td>
</tr>
<tr>
<td>8</td>
<td>Floating-point number 32-bit IEEE 754</td>
<td>4 bytes</td>
</tr>
<tr>
<td>9</td>
<td>Floating-point number 64-bit IEEE 754</td>
<td>8 bytes</td>
</tr>
<tr>
<td>10</td>
<td>Text tag 8-bit character set</td>
<td>1 byte per character</td>
</tr>
<tr>
<td>11</td>
<td>Text tag 16-bit character set</td>
<td>2 bytes per character</td>
</tr>
<tr>
<td>12</td>
<td>Raw data type</td>
<td>Set length</td>
</tr>
</tbody>
</table>

Please note in determining the net space requirement that for certain data types a configuration of type conversion is possible. In this case, the net space requirement of a WinCC tag in the communication telegram corresponds to the space requirement of the format to which the tag is adjusted.

**Example:**

For the type conversion, a tag of the "Unsigned 32-bit value" data type is projected onto the memory space of 16 bits in the PLC. This is achieved through type conversion DwordToUnsignedWord. The space requirement of the WinCC tag in the communication telegram no longer corresponds to the 4-bit value listed in the table but only to 2 bits instead.

Adapt format: DwordToUnsignedWord
**Total space requirement of WinCC tags**

For the transfer of a tag using a telegram between communication partners, not only net data are of relevance. Address information is also necessary to enable an assignment of individual tags by the communication partner.

For communication using SIMATIC S7, for example, each tag requires an additional 4 bytes for additional information. This represents a significant increase in space requirement for individual tags. The space requirement of a tag with a net space requirement of 1 byte increases by a factor of 4 by the additionally transmitted information.

This example specifically applies to communication using SIMATIC S7. Communication using other systems will be based on comparable situations.

**Update cycle**

For various WinCC tags, whether or not these are requested by Graphics Runtime, Alarm Logging Runtime, or some other application, an update cycle must be specified. This update cycle will have great influence upon the demands the WinCC project will impose upon the communication system. Specification of the update cycle will therefore have to be planned very carefully.

In connection with WinCC, update cycles listed in the following table are generally used. In addition, using the user cycles, a maximum of 5 individual cycle times may be defined. In order to determine data traffic caused by WinCC, a table in accordance with the following template may be useful. The individual columns will record the data amounts (in bytes) needed by various applications.

<table>
<thead>
<tr>
<th>Update cycle</th>
<th>Graphics RT</th>
<th>Alarm Lg. RT</th>
<th>Tag Lg. RT</th>
<th>Global Sc. RT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upon change</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>250 [ms]</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>500 [ms]</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 [s]</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 [s]</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5 [s]</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 [s]</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 [min]</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5 [min]</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 [min]</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 [h]</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User cycle 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User cycle 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User cycle 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User cycle 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User cycle 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The update cycle "Upon change" is of importance for the communication system as the tag is requested in a cycle of 250 ms.
Determining the total data volume

For individual applications, add the projected data amounts corresponding to their respective update cycles. You thus determine the entire load on the communication system caused by WinCC.

Determination of data amounts is not exact to the very byte. It is an estimate of the data throughflow to be facilitated by the communication system during system operation later on.

Determination of number of telegrams

Using the total data volume per application per time unit, the approximate number of telegrams needed may be calculated. This also requires knowledge of the maximum telegram length possible. This, however, cannot be specified prior to the decision on a particular communication solution. The maximum telegram length varies greatly depending on communication network used and communication modules used.

You may, however, estimate the approximate data volume for various communication solutions and include these numbers in your decision for one communication solution.

In determining the approximate number of telegrams per time unit, several different factors must be considered. These include the number of communication partners requesting data, and the method these communication partners use in their response to the requests.

SIMATIC S5 uses its own telegram for each module. SIMATIC S7 may additionally group the data from several data modules into one telegram.
Restrictions on number of telegrams

A PLC is usually connected to the communication system through a communication processor. Such a communication processor may only process a certain number of telegrams during a time unit. These numbers are typically between 15 and 20 telegrams per second.

The determining property of a communication system is the thus implemented transmittal rate. Based on this value and a certain telegram length, the approximate number of telegrams per time unit may be determined. With an increasing transmittal rate, the maximum number of telegrams per time unit will also increase.

Consideration of additional communication participants

Aside from the demands imposed upon the communication system by WinCC, additional factors will influence the decision for a specific communication solution.

- Communication between individual PLCs
- Communication between PLCs and connected field devices
- Communication by other WinCC stations
- Communication by additional connected stations (Operator panels, tele service stations, and similar)
2.1.2 Notes on Configuration

Introduction

The type of configuration may significantly affect the demands on the communication system. While observing some basic guidelines, you are able to configure a well performing and easily expandable communication system.

This section will explain how you may reduce the load on the communication system already during the planning phase. Certain configurations will have an effect on the communication system.

A configuration tuned to the communication system will offer the following advantages:

- A well performing system
- More latitude for expansions later on
- Reduced costs for the current project as well as expansions later on

Therefore you will achieve greater customer satisfaction.
2.1.2.1 Cycle of Data Updates

Introduction

A well thought-out configuration of update cycles will make or break the performance of a communication system.

Specification of updates should always be determined by the overall picture of the entire system:

- What type of values are we concerned with from a technical point of view?
- How often should new values be requested from the PLC?

For example, the following considerations should be included in the decision on update cycles:

- Is it of great disadvantage if the user of a system will learn of a temperature change by 1°C only 10 sec after its occurrence, or does he need to know within 250 ms?
- Is it necessary to archive the temperature time series of a boiler of 5000 liters every 500 ms?

If you adjust the updates of these measurements to the process involved, the data volume may be reduced significantly.

Request telegrams will summarize those tags updated within the same cycle. If many different update cycles are used, the total number of telegrams will increase and therefore negatively influence performance.
2.1.2.2 Type of Data Updates

Introduction

The WinCC data manager supplies various applications of the WinCC project with process data. It must update its data inventory at the required cycles in order to do so. The type of updates will affect the load on the communication system.

Active WinCC Station

There are several options for updating the required data. If the WinCC Station is supposed to act as an active partner, the updates may be performed through so-called acyclic or cyclic reads.

During an acyclic read, each update requires two communication telegrams. The WinCC station sends a request to the PLC where it is processed in one or several response telegrams.

During a cyclic read, the WinCC station registers a read request at the PLC where it is processed in its respective cycle. If the data are no longer needed or their composition changes, the WinCC station will unregister the corresponding request.
Active PLC

In another variant of data updates, the PLC actively sends data to WinCC if it recognizes a change in data. This reduces the data traffic to its necessary amount. The configuration effort for the PLC, however, will increase.

**PLC Transmission active**

Configuration guidelines

A meaningful combination of different types of data updates will generally be the most advantageous configuration variant.
2.1.2.3 Organization of Data

Introduction

The organization of data available in the PLC may significantly affect the communication volume. This will greatly depend on the type of PLC.

Summarize data areas

SIMATIC S5 systems summarize requested data in data modules. The greater the degree of distribution of required data in the PLC, the higher the number of required telegrams.

Communication-relevant data should be accessible in a maximum of 3 to 5 data modules in the PLC. If a greater distribution of data is unavoidable, rearrangement of distributed data into a common data area may have some advantages. You must weight the disadvantages created within the PLC versus the advantages achieved within the communication system.
Telegram optimization

SIMATIC S7 may also summarize distributed data in a communication system. This does not mean, however, that a summary of communication-relevant data in a few data modules would not bring any advantages here.

The PLC may optimize the telegram structure. This will enable sending more requested user data using one telegram. In general, for each requested tag its process value (net data) as well as its address information must be transmitted. If the tags are located in neighboring or closely co-located data areas in the PLC, the necessary address information may be reduced.

<table>
<thead>
<tr>
<th>Telegram without Optimization</th>
<th>Telegram with Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Telegram Header (Header)</strong></td>
<td><strong>Telegram Header (Header)</strong></td>
</tr>
<tr>
<td>Address Information</td>
<td>Address Information</td>
</tr>
<tr>
<td>Net Data</td>
<td>Net Data</td>
</tr>
<tr>
<td>Address Information</td>
<td>Net Requested</td>
</tr>
<tr>
<td>Net Data</td>
<td>Net Data</td>
</tr>
<tr>
<td>Address Information</td>
<td>Net Data</td>
</tr>
<tr>
<td>Net Data</td>
<td>Net Data</td>
</tr>
<tr>
<td>Address Information</td>
<td>Net Data</td>
</tr>
<tr>
<td>Net Data</td>
<td>Net Data</td>
</tr>
<tr>
<td>Header</td>
<td>Header</td>
</tr>
<tr>
<td>Addresses</td>
<td>Addresses and not requested data</td>
</tr>
<tr>
<td>Net Data</td>
<td>Net Data</td>
</tr>
</tbody>
</table>
2.2 Performance Data

Introduction

This section contains detailed information on performance of various communication systems, as well as their strengths and weaknesses.

The first section will compare different communication systems. Subsequent sections will contain detailed performance data on individual communication systems, as well as various options for communication in WinCC.

Based on the assessed communication requirements, you may select the best solution for your application. The decision for a communication solution will contain the decision for an available communication system, as well as hardware to be used.

2.2.1 Process Communication

Introduction

The following table provides information on possible configurations and maximum number of connections.

Note

Limit values listed in the table will depend on performance of your system and quantity structure of your WinCC project (such as number of process values / time unit).
## Configuration

<table>
<thead>
<tr>
<th>Communication channels in WinCC</th>
<th>PC based</th>
<th>MPI/Profibus Soft Net</th>
<th>MPI/Profibus Hard Net</th>
<th>Industrial Ethernet Soft Net</th>
<th>Industrial Ethernet Hard Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC S7 Protocol Suite 1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- MPI</td>
<td>---</td>
<td>8</td>
<td>44</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>- Soft PLC</td>
<td>---</td>
<td>1</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>- Slot PLC</td>
<td>---</td>
<td>1</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>- Profibus (1)</td>
<td>---</td>
<td>8</td>
<td>44</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>- Profibus (2)</td>
<td>---</td>
<td>8</td>
<td>44</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>- Named Connections</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>64</td>
<td>60</td>
</tr>
<tr>
<td>- Industrial Ethernet ISO L4 (1)</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>64</td>
<td>60</td>
</tr>
<tr>
<td>- Industrial Ethernet ISO L4 (2)</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>64</td>
<td>60</td>
</tr>
<tr>
<td>- Industrial Ethernet TCP/IP</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>64</td>
<td>60</td>
</tr>
<tr>
<td>SIMATIC S5 Programmers Port</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- AS 511</td>
<td>2</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>SIMATIC S5 Serial 3964R</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- RK 512</td>
<td>2</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>SIMATIC S5 Profibus FDL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- FDL</td>
<td>---</td>
<td></td>
<td>---</td>
<td>50</td>
<td>---</td>
</tr>
<tr>
<td>SIMATIC S5 Ethernet Layer 4 + TCP/IP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Industrial Ethernet ISO L4 (2)</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>- Industrial Ethernet ISO L4 (2)</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>- Industrial Ethernet TCP/IP</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>60</td>
<td>60</td>
</tr>
<tr>
<td>SIMATIC S5 Ethernet TF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Industrial Ethernet TF</td>
<td>---</td>
<td></td>
<td>---</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>SIMATIC 505 Serial</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- NITP / TBP</td>
<td>2</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>SIMATIC 505 Ethernet Layer 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Industrial Ethernet ISO L4 (1)</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>- Industrial Ethernet ISO L4 (2)</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>SIMATIC 505 Ethernet TCP/IP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Industrial Ethernet TCP/IP</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>60</td>
<td>60</td>
</tr>
<tr>
<td>Profibus FMS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- FMS</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profibus DP (V0 Master)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- DP 1</td>
<td>---</td>
<td></td>
<td>122</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>- DP 2</td>
<td>---</td>
<td></td>
<td>122</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>- DP 3</td>
<td>---</td>
<td></td>
<td>122</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>- DP 4</td>
<td>---</td>
<td></td>
<td>122</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>OPC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- OPC</td>
<td>100</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
</tbody>
</table>
Remarks

1) In general, all types of communication channels may be combined with each other. Subordinate communication drivers may lead to limitations, however.

Using the SIMATIC S7 Protocol Suite, a maximum number of 64 S7 connections may be operated. For example, in a typical configuration, there are 60 S7 connections configured.

Example:
- 8 S7 connections using "MPI" and 52 S7 connections using "Industrial Ethernet TCP/IP"

or
- 60 S7 connections using "Industrial Ethernet TCP/IP"

2) COM1/COM2 and internal software interface for SIMATIC S7 Protocol Suite communication "Soft PLC" and "Slot PLC" as well as DCOM for OPC.

3) Using Soft Net, communication runs on the PC processor. Using Hard Net, the communication card has its own micro processor and therefore reduces the PC processor load during communication.

For process communication, only one Soft Net module may be operated on the PC. Combinations with Hard Net communication cards are possible. You may obtain the driver software for Hard Net communication cards from the enclosed SIMATIC NET CDs.

Hard Net communication cards allow for parallel operation of a maximum of 2 protocols, e.g., Ethernet communication using SIMATIC S7 Protocol Suite and SIMATIC S5 Ethernet. In this case, a reduction of approx. 20% of the table values must be taken into consideration.

Example:
- 40 connections using the combination of "SIMATIC S7 Protocol Suite" and 8 connections using "SIMATIC S5 Ethernet".

4) Expandable by using communication cards with several serial interfaces, such as Digi-Board with 8/16 serial interfaces.

5) Guidance.

The maximum number of connections depends on system resources.
2.2.2 Comparison of Communication Systems

Introduction

The decision for a certain communication system will require information on performance of the various options. This section will compare individual communication systems.

Performance of individual communication systems will be assessed using the following criteria:

- Transfer rate
- Number of participants
- Length of telegrams
- Extent of network
- Possible communication partners
- Costs
Communication data

The following table provides a summary of various performance features of individual communication systems.

<table>
<thead>
<tr>
<th></th>
<th>Serial</th>
<th>MPI</th>
<th>PROFIBUS</th>
<th>Ind. Ethernet</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Area of application</strong></td>
<td>Field Level</td>
<td>Field level, cell level</td>
<td>Field level, cell level</td>
<td>Cell level, management level</td>
</tr>
<tr>
<td><strong>Transfer rates</strong></td>
<td>9.6 kBit/s to 256 kBit/s</td>
<td>187.5 kBit/s to 12 Mbit/s</td>
<td>9.6 kBit/s to 12 MBit/s</td>
<td>10 MBit/s (100 MBit/s)</td>
</tr>
<tr>
<td><strong>Typical telegram length</strong></td>
<td>60 bytes</td>
<td>60 bytes</td>
<td>120 bytes</td>
<td>240 bytes</td>
</tr>
<tr>
<td><strong>Maximum telegram length</strong></td>
<td>128 bytes</td>
<td>240 bytes</td>
<td>240 bytes</td>
<td>512 bytes to 4096 bytes</td>
</tr>
<tr>
<td><strong>Extent of network</strong></td>
<td>50 m</td>
<td>50 m to 100 m</td>
<td>10 km to 90 km</td>
<td>1 km to global</td>
</tr>
</tbody>
</table>

Communication partners

The following table provides a summary of which PLCs may be accessed by a WinCC station using which communication systems.

<table>
<thead>
<tr>
<th>System</th>
<th>Serial</th>
<th>MPI</th>
<th>PROFIBUS</th>
<th>Ind. Ethernet</th>
</tr>
</thead>
<tbody>
<tr>
<td>S5-90U, S5-95U, S5-100U</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>S5-115U, S5-135U, S5-155U</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>S7–200</td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S7-300</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>S7-400</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
</tbody>
</table>
Cost factor

With increasing demands on a communication system, the costs for implementing same will naturally increase as well. The following diagram will compare individual communication systems in relation to expected implementation costs.
2.2.3 Serial Communication

Introduction

The most cost-effective option to communicate with a PLC from a WinCC station is to establish a serial communication link. The COM port of the WinCC station is used as the communication module.

Communication partners

In WinCC, there are two communication drivers available in order to establish a serial communication link to the SIMATIC S5 family.

- SIMATIC S5 PROGRAMMERS PORT AS511 Communication using programming interface of the respective CPU.
- SIMATIC S5 Serial 3964R Communication using serial interface

The following display shows which PLCs are accessible using the communication drivers.

Communication links

For each COM port of the WinCC station, a maximum of one PLC is accessible. Information on communication links may be found in Chapter "Performance Data"->"Process Communication". The displayed table shows the number of communication links which may be established using a certain communication driver.

2.2.4 Communication Using MPI
2.2.4.1 Communication Processors

Introduction

In order to establish a communication link between the WinCC station and the MPI network, the WinCC station must be equipped with a suitable communication processor.

Communication processors for communication using MPI

You may use the same communication processors utilized to connect to the PROFIBUS network. Additional information may be found in Chapter "Communication using PROFIBUS/Communication Processors".

The following table lists communication processors which may be used to connect a WinCC station to the MPI network.

<table>
<thead>
<tr>
<th>Communication Processor</th>
<th>Build/Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP 5613</td>
<td>PCI card/ Hard Net</td>
</tr>
<tr>
<td>CP 5614</td>
<td>PCI card/ Hard Net</td>
</tr>
<tr>
<td>CP 5511</td>
<td>PCMCIA card/ Soft Net</td>
</tr>
<tr>
<td>CP 5611</td>
<td>PCI card/ Soft Net</td>
</tr>
</tbody>
</table>
2.2.4.2 SIMATIC S7 PROTOCOL SUITE

Introduction

The "SIMATIC S7 PROTOCOL SUITE" communication driver, through several channel units, offers all options relevant to communication with PLCs of the SIMATIC S7-300 and S7-400 family. An MPI channel unit is also offered for communication using MPI.

Communication partners

Using the communication driver SIMATIC S7 PROTOCOL SUITE, communication may be facilitated with PLCs of the SIMATIC S7-300 and S7-400 family. The following display shows details of possible communication partners upon utilization of the MPI channel unit.

Communication links

The MPI channel unit supports communication using hard net modules and soft net modules. For each computer, only one module may be used for MPI communication.

Information on communication links may be found in Chapter "Performance Data">"Process Communication". The displayed table shows the number of communication links which may be established using a certain communication driver.
2.2.5 Communication Using PROFIBUS

2.2.5.1 Communication Processors

Introduction

In order to establish a communication link between the WinCC station and the PROFIBUS network, the WinCC station must be equipped with a suitable communication processor. Furthermore, suitable driver software must be installed for the desired communication protocol.

Communication processors for communication using PROFIBUS

There are two different types of communication processors available for a WinCC station. These are communication processors for the so-called Hard Net and Soft Net. The main difference is that Hard Net modules have their own microprocessors to reduce the load on the computer CPU, and Soft Net modules do not.

Hard Net

• The entire protocol software runs on the module.
• Two protocols may be operated at the same time. (Multi-protocol operation)
• The module has better performance when compared to Soft Net modules.

Soft Net

• The entire protocol software runs on the computer CPU.
• Only one protocol may be operated at any time. (Mono-protocol operation).
• Module is more cost-effective when compared to Hard Net modules.

The following table lists communication processors available for connecting a WinCC station to the system.

<table>
<thead>
<tr>
<th>Communication Processor</th>
<th>Build/Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP 5613</td>
<td>PCI card/ Hard Net</td>
</tr>
<tr>
<td>CP 5614</td>
<td>PCI card/ Hard Net</td>
</tr>
<tr>
<td>CP 5511</td>
<td>PCMCIA card/ Soft Net</td>
</tr>
<tr>
<td>CP 5611</td>
<td>PCI card/ Soft Net</td>
</tr>
</tbody>
</table>
2.2.5.2 Communication Driver

Introduction

In WinCC, several communication drivers are available for communication using PROFIBUS.

Communication Protocols

Communication drivers available for PROFIBUS will each implement communication using a specific communication protocol.

In the following table, communication drivers are assigned to the respective communication protocols.

<table>
<thead>
<tr>
<th>Communication driver</th>
<th>Protocol</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC S7 PROTOCOL SUITE (PROFIBUS)</td>
<td>S7 functions</td>
</tr>
<tr>
<td>SIMATIC S5 PROFIBUS FDL</td>
<td>FDL</td>
</tr>
<tr>
<td>PROFIBUS FMS</td>
<td>FMS</td>
</tr>
<tr>
<td>PROFIBUS DP</td>
<td>DP</td>
</tr>
</tbody>
</table>

Communication links

Information on communication links may be found in Chapter "Performance Data">"Process Communication". The displayed table shows the number of communication links which may be established using a certain communication driver.
PLCs

PLCs may be connected to the PROFIBUS network using either interfaces integrated into the central module, or using special communication modules.

In WinCC, several communication drivers are available for communication using PROFIBUS. The following table lists which communication driver may be combined with which module. Please note the legend following the table.

<table>
<thead>
<tr>
<th>System</th>
<th>Module</th>
<th>PB DP</th>
<th>PB FMS</th>
<th>S5 FDL</th>
<th>S7 PB</th>
</tr>
</thead>
<tbody>
<tr>
<td>S5-90U, S5-95U, S5-100U</td>
<td>CPU 95U</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CP 541</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S5-115U, S5-135U, S5-155U</td>
<td>CP 5431</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>IM 308-C</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S7--200</td>
<td>CPU 215</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CP 242-8</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S7-300</td>
<td>CPU 315-2 DP</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>CP 342-5</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CP 343-5</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>S7-400</td>
<td>CPU 41x-2 DP</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>CP 443-5 Ext.</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CP 443-5 Basic</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>IM 467</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>DP Slaves</td>
<td>e.g. ET 200</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Legend:
- **PB DP** - PROFIBUS DP
- **PB FMS** - PROFIBUS FMS
- **S5 FDL** - SIMATIC S5 PROFIBUS FDL Note: SIMATIC S5 PMC PROFIBUS only using CP 5431
- **S7 PB** - SIMATIC S7 PROTOCOL SUITE (PROFIBUS channel unit)
2.2.5.3 PROFIBUS DP

Introduction

Using the "PROFIBUS DP" communication driver, a WinCC station may communicate with all PLCs and field devices operated as DP Slaves.

Application of the PROFIBUS DP communication driver in WinCC makes sense for communication with many subordinate devices requiring only low data volumes. Despite the distributed data, very rapid tag updates may be achieved. Communication uses the cyclic data exchange of PROFIBUS DP. The WinCC station acts as the DP Master.

Communication partners

Using the "PROFIBUS DP" communication driver, a WinCC station may communicate with all PLCs and field devices operated as DP Slaves. The following display shows details of possible communication partners.

Communication links

Information on communication links may be found in Chapter "Performance Data"->"Process Communication". The displayed table shows the number of communication links which may be established using a certain communication driver.

Required software

The following table lists software components necessary for implementation of a communication link of a WinCC station using PROFIBUS DP.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC</td>
<td>Communication driver PROFIBUS DP</td>
</tr>
<tr>
<td>SIMATIC NET</td>
<td>All existing communication drivers</td>
</tr>
</tbody>
</table>
2.2.5.4 PROFIBUS FMS

Introduction

Using the "PROFIBUS FMS" communication driver, a WinCC station may communicate with PLCs which support the FMS protocol.

The "PROFIBUS FMS" communication driver may be used for communication with devices from different manufacturers. In terms of communication technology, large data volumes can be handled.

Communication partners

Using the "PROFIBUS FMS" communication driver, communication is possible with all PLCs which support the FMS protocol. The following display shows details of possible communication partners.

Communication links

Information on communication links may be found in Chapter "Performance Data">"Process Communication". The displayed table shows the number of communication links which may be established using a certain communication driver.

Communication software

The following table lists software components necessary for implementation of a communication link of a WinCC station using PROFIBUS FMS.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC</td>
<td>Communication driver PROFIBUS FMS</td>
</tr>
<tr>
<td>SIMATIC NET</td>
<td>All existing communication drivers</td>
</tr>
</tbody>
</table>
2.2.5.5 SIMATIC S7 PROTOCOL SUITE

Introduction

The "SIMATIC S7 PROTOCOL SUITE" communication driver, through several channel units, offers all options relevant to communication with PLCs of the SIMATIC S7-300 and S7-400 family. Among others, the PROFIBUS two channel units are intended for communication using PROFIBUS.

Communication partners

Using the "SIMATIC S7 PROTOCOL SUITE" communication driver, communication is possible with PLCs of the SIMATIC S7-300 and S7-400 family. The following display shows details of possible communication partners upon utilization of the PROFIBUS channel unit.

Communication Links

Information on communication links may be found in Chapter "Performance Data">"Process Communication". The displayed table shows the number of communication links which may be established using a certain communication driver.
2.2.5.6 SIMATIC S5 PROFIBUS FDL

Introduction

The "SIMATIC S5 PROFIBUS FDL" communication driver supports communication using the SEND/RECEIVE interface (FDL) to systems of the SIMATIC S5 family.

Communication partners

The following display shows details of possible communication partners.

Communication links

Information on communication links may be found in Chapter "Performance Data" -> "Process Communication". The displayed table shows the number of communication links which may be established using a certain communication driver.

Communication software

The following table lists software components necessary for implementation of a communication link of a WinCC station using FDL to SIMATIC S5.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC</td>
<td>Communication driver SIMATIC S5 PROFIBUS FDL</td>
</tr>
<tr>
<td>SIMATIC NET</td>
<td>All existing communication drivers</td>
</tr>
<tr>
<td>STEP5</td>
<td>Standard communication modules</td>
</tr>
</tbody>
</table>
2.2.6 Communication Using Industrial Ethernet

2.2.6.1 Communication Processors

Introduction

In order to establish a communication link between the WinCC station and the Industrial Ethernet network, the WinCC station must be equipped with a suitable communication processor. Furthermore, suitable driver software must be installed for the desired communication protocol.

Communication processors for communication using Industrial Ethernet

There are two different types of communication processors available for a WinCC station. These are communication processors for the so-called Hard Net and Soft Net. The main difference is that Hard Net modules have their own microprocessors to reduce the load on the computer CPU, and Soft Net modules do not.

Hard Net

- The entire protocol software runs on the module.
- Two protocols may be operated at the same time. (Multi-protocol operation)
- The module has better performance when compared to Soft Net modules.

Soft Net

- The entire protocol software runs on the computer CPU.
- Only one protocol may be operated at any time. (Mono-protocol operation)
- Module is more cost-effective when compared to Hard Net modules.

The following table lists communication processors available for connecting a WinCC station to the system.

<table>
<thead>
<tr>
<th>Communication Processor</th>
<th>Structure</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP 1613</td>
<td>PCI card</td>
<td>Hard Net</td>
</tr>
<tr>
<td>CP 1612</td>
<td>PCI card</td>
<td>Soft Net</td>
</tr>
<tr>
<td>CP 1512</td>
<td>PCMCIA card</td>
<td>Soft Net</td>
</tr>
</tbody>
</table>
2.2.6.2 Communication Driver

Introduction

In WinCC, several communication drivers are available for communication using Industrial Ethernet.

Protocols

Communication drivers available for Industrial Ethernet implement communication to a certain automation system using one specific communication protocol each.

In the following table, communication drivers are assigned to the respective transport and communication protocols.

<table>
<thead>
<tr>
<th>Communication Driver</th>
<th>Transport/Communication</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC S5 ETHERNET LAYER 4</td>
<td>ISO with SEND/RECEIVE</td>
</tr>
<tr>
<td>SIMATIC S5 Ethernet TF</td>
<td>ISO with TF</td>
</tr>
<tr>
<td>SIMATIC S7 PROTOCOL S. (Industrial Ethernet)</td>
<td>ISO with S7 functions</td>
</tr>
<tr>
<td>SIMATIC S7 PROTOCOL S. (TCP/IP)</td>
<td>ISO-on-TCP with S7 functions</td>
</tr>
</tbody>
</table>

Communication links

Information on communication links may be found in Chapter "Performance Data">"Process Communication". The displayed table shows the number of communication links which may be established using a certain communication driver.
PLCs

Connection of a PLC to the Industrial Ethernet uses specific communication modules.

In WinCC, several communication drivers are available for communication using Industrial Ethernet. The following table lists which communication driver may be combined with which module. Please note the legend following the table.

<table>
<thead>
<tr>
<th>System</th>
<th>Module</th>
<th>S5 SR</th>
<th>S5 TF</th>
<th>S7 ISO</th>
<th>S7 TCP</th>
</tr>
</thead>
<tbody>
<tr>
<td>S5-115U, S5-135U, S5-155U</td>
<td>CP 1430</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S7-300</td>
<td>CP 343-1</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CP 343-1 TCP</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>S7-400</td>
<td>CP 443-1</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CP 443-1 TCP</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CP 443-1 IT</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

Legend:

- **S5 SR** - SIMATIC S5 ETHERNET LAYER 4, SIMATIC S5 PMC ETHERNET
- **S5 TF** - SIMATIC S5 ETHERNET TF
- **S7 ISO** - SIMATIC S7 PROTOCOL SUITE (Industrial Ethernet channel unit)
- **S7 TCP** - SIMATIC S7 PROTOCOL SUITE (TCP/IP channel unit)
2.2.6.3 Communication Using SIMATIC S5

Introduction

For communication with automation systems SIMATIC S5 115U, S5 135U, and S5 155U using Industrial Ethernet, the following communication drivers are available:

- SIMATIC S5 ETHERNET LAYER 4
  Communication using interfaces "SEND/RECEIVE" and "WRITE/FETCH"

- SIMATIC S5 PMC Ethernet
  Communication using interface "SEND/RECEIVE" with PMC handling modules

- SIMATIC S5 Ethernet TF
  Communication using TF

The "SIMATIC S5 Ethernet Layer 4" communication driver offers better performance when compared to the "SIMATIC S5 Ethernet TF" communication driver.

Communication partners

Different communication drivers enable communication with PLCs SIMATIC S5 115U, S5 135U, and S5 155U. These PLCs must be equipped with the communication processor CP 1430 TF.
SIMATIC S5 ETHERNET LAYER 4

The "SIMATIC S5 ETHERNET LAYER 4" communication driver enables communication using the interfaces "SEND/RECEIVE" and "WRITE/FETCH". Using the "WRITE/FETCH" interface enables the active sending of data from the PLC.

The following table lists software components necessary for implementation of a communication link of a WinCC station using the "SEND/RECEIVE" interface to SIMATIC S5.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC</td>
<td>Communication driver &quot;SIMATIC S5 ETHERNET LAYER 4&quot;</td>
</tr>
<tr>
<td>SIMATIC NET</td>
<td>Driver software</td>
</tr>
</tbody>
</table>

SIMATIC S5 Ethernet TF

The "SIMATIC S5 ETHERNET TF" communication driver enables communication using the "TF" (Technological Function) interface.

The following table lists software components necessary for implementation of a communication link of a WinCC station using the "TF" interface to SIMATIC S5.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC</td>
<td>Communication driver &quot;SIMATIC S5 ETHERNET TF&quot;</td>
</tr>
<tr>
<td>SIMATIC NET</td>
<td>Driver software</td>
</tr>
</tbody>
</table>
2.2.6.4 Communication Using SIMATIC S7

Introduction

Communication with SIMATIC S7 uses the "SIMATIC S7 PROTOCOL SUITE" communication driver. Through several channel units, this driver offers all options relevant for communication with PLCs of the SIMATIC S7-300 and S7-400 family.

- ISO Transport Protocol The Industrial Ethernet 2-channel units are intended for communication using ISO Transport Protocol.
- ISO-on-TCP Transport Protocol The TCP/IP channel units is intended for communication using ISO-on-TCP Transport Protocol.

It is intended to use the ISO Transport Protocol for networks of less spatial extent because of its higher performance. Communication for more expansive networks connected by routers, the ISO-on-TCP Transport Protocol must be used.

Communication partners

Using the "SIMATIC S7 PROTOCOL SUITE" communication driver, communication is possible with PLCs of the SIMATIC S7-300 and S7-400 family. These must be equipped with communication processors which support transport protocols "ISO" or "ISO-on-TCP". The following display shows details of possible communication partners.
Communication data

The Industrial Ethernet channel units as well as TCP/IP support communication using Hard Net and Soft Net modules. The following table lists driver software required by various communication processors.

<table>
<thead>
<tr>
<th>Communication Processor</th>
<th>Driver software</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP 1613</td>
<td>SIMATIC NET</td>
</tr>
<tr>
<td>CP 1612</td>
<td>SIMATIC NET</td>
</tr>
<tr>
<td>CP 1512</td>
<td>SIMATIC NET</td>
</tr>
</tbody>
</table>

Communication links

Information on communication links may be found in Chapter "Performance Data">"Process Communication". The table shown lists the number of communication links which may be established using a certain communication driver.
3 Project Examples

This chapter will show project examples for configuring communication between a WinCC station and a PLC. Each of the project examples is based on the use of a certain communication option as well as a certain hardware combination.

Contents of Examples

You will find the example projects described below at the Online Support under the following URL for downloading:


If you click onto "Info", a second page with the example projects will be displayed.

You can either copy the data onto the hard disk drive or open and unpack it immediately. The projects are filed in the directory C:\Communication_Manual by default.

The functionality of the example projects is essentially restricted to the use and display of a few tag values. The focus will be on the procedure for configuring communication.

Design of Examples

There are detailed descriptions of steps for successful implementation of the respective communication link. Individual descriptions are generally structured into sections listed as follows.

- Summary of the respective project example
- Installation of necessary components on computer
- Project creation for the respective PLC
- WinCC project creation
- Diagnostics of communication links

Generation systems

The current examples were generated using the following software issues:

- WinCC Version 6.0 SP 2
- STEP7 Version 5.2
- SIMATIC NET 11/03
3.1 Installation of SIMATIC NET Software

User Documentation for Software Installation

Prior to installing the software from the SIMATIC NET CD, you should read the following documents and follow their notes:

- Installation Manual for Software
- Additional information

Additional notes supplemented with product.

Notes on documentation
Please note that any paper documents attached to your product shall take precedence over documents available in file format. There may be additional service packs available for product expansion. You may obtain additional information from SIMATIC Customer Support.

<table>
<thead>
<tr>
<th>Installation of SIMATIC NET Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
</tbody>
</table>

![SIMATIC NET Software Installation Dialog](image)
Installation of SIMATIC NET Software

1. Install the following components
   SIMATIC NET PC products
   Contains the necessary tools for installing and operating a PC station. These components are essentially required:
   - Drivers for PC modules
   - Configuration console "Install PC stations"
   - Station configuration editor
   - Configuration notification service
   - OPC Server
   - OPC Scout
   SIMATIC NCM PC
   The configuration tool is required for the Engineering Station application. However, you will need SIMATIC NCM PC only if you are not already using STEP7 on your single-user station. With SIMATIC NCM PC, the Configuration Wizard is installed as well.

   ![SIMATIC NET Setup](image_url)
3.2 Communication with SIMATIC S7 Using Industrial Ethernet (Hard Net)

Projects and files to be generated in this chapter may also be loaded onto your hard disk directly from the Online Support (link "Info" on http://support.automation.siemens.com/WW/view/en/21320307).

There is the option of copying the following components to hard disk:

- S7_IEH
  The STEP7 project to be generated.
- WinCC_S7_IEH
  The WinCC project to be generated.

This chapter describes in detail the implementation of a communication link between SIMATIC S7 and WinCC. The communication link is implemented by using the Industrial Ethernet. The CP 1613 communication processor used on the computer has its own CPU. This removes communication loads from the computer's CPU load. Such a constellation is typically referred to as a Hard Net.

Summary on Example Design

On the computer side, the network connection is established using a CP 1613 communication processor. Its installation requires the installation of SIMATIC NET on the computer. Using SIMATIC NET, all necessary drivers are installed.

In the WinCC project, the SIMATIC S7 Protocol Suite communication driver must be installed. Using its Industrial Ethernet channel unit, the connection to SIMATIC S7 is configured.

The PLC is equipped with a central module CPU 416-1. Connection to the network is established using the CP443-1 communication processor. In order to configure this communication processor with STEP7 software, the NCM S7 Industrial Ethernet options package is required.
Summary of Configuration Steps

The following summary lists all configuration segments necessary for establishing the communication link.

- Commissioning of CP 1613 communication processor
- Generation of STEP7 project S7_IEH
- Generation of WinCC project WinCC_S7_IEH
- Diagnostics of Communication Link

Required software

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC NET</td>
<td>Using installation from the SIMATIC NET CD, all drivers are installed.</td>
</tr>
<tr>
<td>STEP7</td>
<td>STEP7 software with option package NCM for Industrial Ethernet to generate the STEP7 project.</td>
</tr>
<tr>
<td>WinCC</td>
<td>WinCC with SIMATIC S7 Protocol Suite communication driver to generate the WinCC project.</td>
</tr>
</tbody>
</table>

Required hardware on computer

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Processor</td>
<td>Communication processor CP 1613 to establish connection to communication processor in PLC.</td>
</tr>
</tbody>
</table>

Required hardware in PLC

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack</td>
<td>Module rack UR1.</td>
</tr>
<tr>
<td>Power supply unit</td>
<td>Power supply unit PS 407 10A in slots 1 and 2.</td>
</tr>
<tr>
<td>Central module</td>
<td>Central module CPU 416-1 in slot 3.</td>
</tr>
<tr>
<td>Communication Processor</td>
<td>Communication processor CP 443-1 in slot 4.</td>
</tr>
</tbody>
</table>
3.2.1 Commissioning of CP 1613 Communication Processor

The following description shows detailed configuration steps necessary for successful installation of the CP 1613 communication processor. It is assumed that SIMATIC NET is already installed on your configuration computer. Furthermore, it is assumed that the communication processor was previously installed.

Summary of Configuration Steps

The following is a summary list of all necessary configuration steps for commissioning of the CP 1613 communication processor.

- A: Configuration of communication processor
- B: Assigning of access point
- C: Testing of communication processor

A: Configuration of communication processor

In Program Start ➔ SIMATIC ➔ SIMATIC NET ➔ Settings ➔ "Set PC station", the communication processor may be configured. In the "General" menu, the module operation mode must be set to PG Operation.
A: Configuration of communication processor

2 In the "Address" menu, the MAC and IP addresses of CP 1613 may be changed. This can only be done in PU Operation. For example, the MAC address is specified as 08.00.06.6D.98.78.

The Ethernet address is six bytes long and is structured in Siemens devices as follows:

- 08.00.06/font>: The first six numbers of the hexadecimal value correspond to the number for SIEMENS.
- 6D: The next two numbers specify the area at SIEMENS.
- 9: The next number identifies the SIMATIC system.
- 8.78: The last three numbers correspond to the significant station address of a SIEMENS device.

3 Settings in the Address menu are saved after changes were made by clicking the Apply button.

A dialog is displayed which requests a restart of CP 1613. Confirm this dialog with OK to restart the CP 1613 communication processor.


A: Configuration of communication processor

4 In the General menu, the operation mode of the module is set to Configured Mode. This change leads to a display of the Index and Module Name fields. In the example, the index is set to 1 and the module name to CP 1613. These changes are saved using the Apply button. The displayed note may be confirmed by clicking OK.
B: Assigning of access point

1. In Program Start → SIMATIC → SIMATIC NET → Settings → "Set PC Station", the just installed communication processor must be assigned the access point CP_H1_1:

   The access point CP_H1_1 is the default access point used for TCP/IP communication in WinCC. It was created automatically during installation of SIMATIC NET.

2. In the Access Points folder, the CP-TCP/IPv entry must be selected as follows:

   D. In the upper field, select the CP1613(RFC1006) entry by using the pull-down menu. This concludes the assignment between access point and communication processor.
## C: Testing of communication processor

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Testing the proper installation of the CP 1613 communication processor using the &quot;Setting PC Station&quot; program. This is started by clicking Start → SIMATIC → SIMATIC NET → Settings → Setting PC Station. In order to test the protocols, select the &quot;Protocol&quot; folder of the respective module. In our case it is module CP 1613. On the right side of the window, the CP 1613 Industrial Ethernet dialog is displayed.</td>
</tr>
<tr>
<td>2</td>
<td>Testing of proper installation uses the &quot;Test&quot; button. Upon successfully tested protocols, a dialog is displayed as follows.</td>
</tr>
</tbody>
</table>
C: Testing of communication processor

3 In order to check the Send/Receive function, open the directory SR Test. Again, in order to test, push the buttons.

4 If diagnostics yields a negative result, the cause of the error must be found, and the error must be corrected. Some tools and tips on this subject may be found in chapter "Is the computer communication module operable?". This test may also be performed using the "Setting PG/PC Interface" program, however, the "PG Operation" operation mode is required to do so.
3.2.2 Creating the STEP7 Project S7_IEH

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the STEP7 project S7_IEH.

- A: Installation of hardware
- B: Creating STEP7 project
- C: Configuring hardware
- D: Loading of hardware configuration
- E: Testing of hardware configuration
- F: Creating STEP7 program
- G: Testing of STEP7 program

A: Installation of hardware

<table>
<thead>
<tr>
<th>A: Installation of hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Assemble the used modules on the module racks.</td>
</tr>
<tr>
<td>In the current example, these are a power supply unit PS 407 10A, a central module CPU 416-1, as well as a communication processor CP 443-1.</td>
</tr>
<tr>
<td>Establish the connection between programming device and programming interface of the central module.</td>
</tr>
<tr>
<td>Establish the connection between the computer's communication processor CP 1613 to communication processor CP 443-1 in the PLC.</td>
</tr>
</tbody>
</table>
B: Creating STEP7 project

1. Creating a new STEP7 project in SIMATIC Manager.
   This is started using Start ➔ SIMATIC ➔ SIMATIC Manager.

2. The SIMATIC Manager opens.
   Using menu item File ➔ New, the dialog to specify parameters of a new STEP7 project opens.
   The New dialog opens.
   The User Projects tab register must be selected. Enter the name of the newly created project in the Name field. Names of STEP7 projects created as part of this manual must start with the character sequence S7. Furthermore, they contain a description of the communication type used. The current example has the name S7_IEH.
   By default, projects are saved in directory C:\PROGRAM FILES\SIEMENS\STEP7\S7proj. However, this may be changed at any time by clicking the Browse button.
   The New dialog is closed by clicking the OK button.

![New Dialog Image]
C: Configuring hardware

1 The new project is displayed in SIMATIC Manager. Hardware must be configured for this project. Two components are needed. These are a SIMATIC 400 station, as well as an Industrial Ethernet for its connections.

These components are added in SIMATIC Manager using the name of project S7_IEH and Insert New Object SIMATIC 400 Station as well as Insert New Object Industrial Ethernet.
### C: Configuring hardware

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>The two components just added are displayed in the right window of SIMATIC Manager.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="SIMATIC 400(1)" /> <img src="image" alt="MP(1)" /> <img src="image" alt="Ethernet(1)" /></td>
</tr>
<tr>
<td></td>
<td>Using <img src="image" alt="D" /> on component SIMATIC 400(1) in the right window will display the Hardware item. Using <img src="image" alt="D" /> on the Hardware item or <img src="image" alt="R" /> and Open Object on it will start the HWConfig program.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="HW Konfig" /></td>
</tr>
<tr>
<td>3</td>
<td>The HWConfig program opens. It is used to specify exactly the hardware used in the PLC, and to configure its properties.</td>
</tr>
<tr>
<td>4</td>
<td>Using the subsequently displayed button in the toolbar of HWConfig program, the hardware catalog opens. This is used to select the required hardware components.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Catalog" /></td>
</tr>
</tbody>
</table>
C: Configuring hardware

The hardware catalog opens. The first component to be selected is the module rack used. All additional components are to be installed on it. The module rack used is inserted into the project using D or Drag&Drop. The example uses module racks of type UR1.
C: Configuring hardware

6 The HWConfig program displays the presently still empty module rack. It
has been assigned to rack number 0. In configuring the connection in the
WinCC project, the rack number is one of the parameters to be set.

7 Arrangement of additional hardware components in module racks. This
uses Drag&Drop for the desired components from the hardware catalog in
their respective slots in the module rack.

The example uses a power supply unit PS 407 10A. This is inserted in slot
1. A power supply unit of this type uses two slots.

The example uses a CPU 416-1 as central module. This is inserted in slot
3. In configuring the connection in the WinCC project, the slot number of
the central module is an additional parameter to be set.

Furthermore, a CP 443-1 communication processor is needed. However,
this is available from the hardware catalog only if the NCM S7 Industrial
Ethernet option package has been installed. Once the CP 443-1
communication processor is inserted into the module rack, its properties
dialog opens.
## C: Configuring hardware

8 The property dialog of the Ethernet interface of CP 443-1 is displayed. Use the Parameter tab register in the MAC address field to set the desired Ethernet address of the communication processor. The current example specifies this as 08.00.06.01.00.00. In configuring the connection in the WinCC project, this Ethernet address is an additional parameter to be set. Use the lower selection field Subnet to assign the entry Ethernet(1) to the communication processor. Close the dialog with OK.

![Properties - Ethernet interface CP 443-1 (RO/54)](image)

9 In the following, the fully configured hardware design of the example is shown.

![Configuration](image)

10 Settings made must be saved in the HWConfig program and must be compiled in order to load the data onto the module. This is done using the toolbar button displayed in the following.

![Save and Compile](image)
D: Loading of hardware configuration

1. The hardware configuration created in program HWConfig must be transferred to the PLC. This is done using the toolbar button displayed in the following.

   ![Download to Module](image)

2. A dialog opens which allows selection of components to be loaded. In the current example, all selectable components must be marked. Please make sure that any loading of the central module is possible only in operational switch positions STOP or RUN-P. Close the dialog with OK.

   ![Select Target Module](image)

3. The Select Node Address dialog opens. Here you state which node address is used for communication between STEP7 software and central module. The current example uses communication via the MPI interface. The address of the central module is 2. Close the dialog with OK.

4. Configuration data are now transferred to the PLC. Individual modules may have to be put into the STOP status. The HWConfig program may be terminated. Components newly added are displayed in SIMATIC Manager for SIMATIC 400(1).
E: Testing of hardware configuration

1  Testing of hardware configuration decision
   If the key switch of the central module is put into RUN or RUN-P position, and the operational switch of the communication processor is put into RUN position, only status LEDs indicating the RUN state should be lit.

   If this is not the case, an error has occurred. This error may be determined using the steps described in the following. However, these steps should also be implemented even if no error is indicated by the status LEDs. This will allow recognition of non-critical errors and faulty configurations.
E: Testing of hardware configuration

Testing of configuration in central module.
This uses the Module Information dialog in SIMATIC Manager. This dialog is opened using \( \text{F1} \) on the entry of the central module in the left window and Target System \( \Rightarrow \) Module Information.

The Module Information dialog of the central module is opened.
The General tab register displays various general data of the central module. The Status field will display the current Module Information as well as existing errors, if any.

The Diagnostic Buffer tab register display detailed information on existing errors and their correction.

The dialog is closed by clicking the Close button.

![Module Information - CPU416-1](image)
**E: Testing of hardware configuration**

3 Testing of communication processor configuration.

This uses the Module Information dialog in SIMATIC Manager. This dialog is opened using \( \text{R} \) on the entry of the communication processor in the left window and Target System \( \rightarrow \) Module Information.

The Module Information dialog of the communication processor is opened. The General tab register displays various general data of the module. A dialog for more detailed diagnostics of the communication processor may be opened using the Special Diagnostics button.

![Module Information - CP 443-1](image-url)
4 The NCM S7 Industrial Ethernet Diagnostics dialog opens. The CP Information tab register displays general information on the module. Among others, the set network address may be checked. The dialog is closed by clicking the Close button. The Module Information dialog may also be closed by clicking the Close button.
F: Creating STEP7 program

For the current example project, only one operations block, OB1, and one data block are needed. OB1 is available by default. The needed data block must first be created. This is done in SIMATIC Manager using the Blocks subitem of entry S7 program(1) of the configured central module and Add New Object → Data Block.

The property dialog of the data block opens. Enter DB75 as the name for the block and close the dialog by clicking OK.
F: Creating STEP7 program

2 The newly created data block DB75 is displayed in the right window of the project.

Using the D on it or using the R and Open Object, the contents of the block may be programmed. The program KOP/AWL/FUP is started.

3 The program KOP/AWL/FUP opens.

The New Data Block dialog appears and must be acknowledged by clicking OK.
F: Creating STEP7 program

4 Programming of DB75.
Here, two tags of length 16 bits are created. Their sum is supposed to be
determined in OB1 and written to another tag of length 16 bits.
Furthermore, two tags of length 16 bits are created, whose values are to be
cyclically incremented in OB1.
Tags created in data block DB75 are supposed to be visualized in the
WinCC project. To do so, WinCC tags with corresponding addresses are
created.
The following shows the completely programmed data block DB75.

5 The data block must be saved. Furthermore, it must be loaded onto the
PLC. This is done using the toolbar button displayed in the following.
Please make sure that any loading of the central module is possible only in
operational switch positions STOP or RUN-P.

6 Programming of OB1.
This must be opened beforehand in program KOP/AWL/FUP.
Initially, two values created in DB75 are added and the result is again
saved in DB75.

\textbf{Netzwerk 1: Addition}

Adding two 16-Bit Values
The result is stored in another
16-Bit Value

\begin{verbatim}
  DB 75
  I DBW 0
  I DBW 2
  T DBW 4
\end{verbatim}
## F: Creating STEP7 program

Next, the count of a value created in DB75 is implemented every second.

### Network 2: Second Cycle

**Generation of a second cycle at M 0.0**

<table>
<thead>
<tr>
<th>AN</th>
<th>M</th>
<th>0.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>S7T#1S</td>
<td></td>
</tr>
<tr>
<td>SD</td>
<td>T</td>
<td>1</td>
</tr>
<tr>
<td>A</td>
<td>T</td>
<td>1</td>
</tr>
<tr>
<td>=</td>
<td>M</td>
<td>0.0</td>
</tr>
</tbody>
</table>

### Network 3: Counting in a second cycle

**Counting a value in a second cycle**

At 10000, reset to 0

<table>
<thead>
<tr>
<th>AN</th>
<th>M</th>
<th>0.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>JC</td>
<td>M001</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>DB75</td>
<td>5</td>
</tr>
<tr>
<td>L</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>+I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>DB75</td>
<td>5</td>
</tr>
<tr>
<td>L</td>
<td>10000</td>
<td></td>
</tr>
<tr>
<td>&lt;I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JC</td>
<td>M001</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>DB75</td>
<td>5</td>
</tr>
</tbody>
</table>

M001: NOP 0

Next, the count of a value created in DB75 is implemented for each run of OB1.

### Network 4: Counting in the cycle time

**Counting a value each time the OB is executed**

At 10000, reset to 0

<table>
<thead>
<tr>
<th>L</th>
<th>DB75</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>+I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>DB75</td>
<td>8</td>
</tr>
<tr>
<td>L</td>
<td>10000</td>
<td></td>
</tr>
<tr>
<td>&lt;I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JC</td>
<td>M002</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>DB75</td>
<td>8</td>
</tr>
</tbody>
</table>

M002: NOP 0

7 The OB1 block must be saved and loaded onto the PLC. This is done using the respective toolbar button.

Thus, the STEP7 project is complete and ready to run. The KOP/AWL/FUP program may be terminated.
G: Testing of STEP7 program

1. Testing of program using STEP7 software.
   A tag table is created for this. This is done in SIMATIC Manager using R on the entry of the configured central module and Target System Monitor / Modify Tag.

   ![Image of SIMATIC Manager interface]

2. An editor is displayed to create and use such a tag table.
   In the following, the complete tag table is shown. All tags created in DB75 are entered.

   ![Image of tag table]

<table>
<thead>
<tr>
<th>Address</th>
<th>Symbol</th>
<th>Display format</th>
<th>Status value</th>
<th>Modify value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB75.D9W 0</td>
<td></td>
<td>DEC</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>DB75.D9W 2</td>
<td></td>
<td>DEC</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>DB75.D9W 4</td>
<td></td>
<td>DEC</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>DB75.D9W 6</td>
<td></td>
<td>DEC</td>
<td>10E3</td>
<td>10E3</td>
</tr>
<tr>
<td>DB75.D9W 8</td>
<td></td>
<td>DEC</td>
<td>17E3</td>
<td>17E3</td>
</tr>
</tbody>
</table>
### G: Testing of STEP7 program

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| 3 | Monitoring current tag values.  
   | By clicking the toolbar button shown in the following, the current values of respective tags in the PLC are displayed in the Status Value column.  
   | ![Monitor variable](image)  
   | Controlling of tag values.  
   | In the Control Value column, values may be entered. By clicking the toolbar button displayed in the following, these values are written to the corresponding tags in the PLC.  
   | ![Modify variable](image)  
   | Please make sure that any controlling of tags is possible only in operational switch position RUN-P.  
   | ![VAT1](image)  
| 4 | The so-created tag table may now be saved.  
   | In the current example, it is save under the name VAT1. If the program function in the PLC has now been checked, the tag table may be closed. Thus, configuration of the STEP7 project is complete and SIMATIC Manager may be terminated.  
   | ![VAT1](image)  

3.2.3 Creating WinCC Project WinCC_S7_IEH

The following description shows in detail the necessary configuration steps for creating and commissioning of WinCC project S7_IEH.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the WinCC project S7_IEH.

- A: Creating WinCC project
- B: Establishing connection
- C: Creating WinCC tags
- D: Creating WinCC picture
### A: Creating WinCC project

<table>
<thead>
<tr>
<th></th>
<th>A: Creating WinCC project</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creating a new WinCC project in WinCC Explorer. It is started using Start → SIMATIC → WinCC → Windows Control Center.</td>
</tr>
<tr>
<td>2</td>
<td>WinCC Explorer is displayed. Using menu item File → New, the dialog to specify the properties of a new WinCC project opens. The following example project creates a single-user project. Finish the dialog with OK.</td>
</tr>
</tbody>
</table>

![WinCC Explorer dialog](image)
A: Creating WinCC project

3 The Create a New Project dialog opens.

Enter a project name for the new project. WinCC projects created as part of this manual begin with a character sequence of WinCC, and furthermore contain a description of communication partners, as well as communication type used. The current example has the name WinCC_S7_IEH.

Furthermore, in the Project Path field, the storage location of the new project must be set.

The Create a New Project dialog is closed by clicking the Create button.
### B: Establishing connection

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The new project is displayed in WinCC Explorer. Installing of required communication driver. This is done by clicking on the Tag management item and Add New Driver.</td>
</tr>
<tr>
<td>2</td>
<td>The Add New Driver Dialog opens. It offers a selection of all communication drivers available for installation. For communication with SIMATIC S7, the SIMATIC S7 Protocol Suite driver is required. It must be selected in the dialog. Close the dialog with Open.</td>
</tr>
</tbody>
</table>
B: Establishing connection

3 The newly added driver SIMATIC S7 Protocol Suite opens as a subitem of Tag Management.

The driver contains nine different channel units. In order to operate two CP 1613 communication processors on a computer, two channel units are available for Industrial Ethernet.

The current example uses the Industrial Ethernet channel unit.

A new connection must be created for it. This is done using the New Driver Connection entry on the Industrial Ethernet and New Connection entry.

4 The property dialog of the connection opens.

Enter the name of the new connection on the General tab register. It is S7_IEH_01 in the current example.

Specify connection parameters using the Properties button.
B: Establishing connection

5 The Connection Parameter dialog opens. Enter the address set for the CP 443-1 communication processor in the Ethernet Address field. In the current example, this is Ethernet address 08.00.06.01.00.00.

Furthermore, Rack Number as well as Slot Number of the central module to be addressed must be entered. Please make sure that values for the central module and not those of the communication processor are entered here.

Close the dialog with OK. The Connection Properties dialog is also closed by clicking OK.

![Connection Parameter - Industrial Ethernet](image)
B: Establishing connection

6 Setting of system parameters for Industrial Ethernet channel unit.

This setting uses the System Parameters dialog which opens using the button on the Industrial Ethernet and System Parameters entry.

On the Channel tab register, different settings for communication and communication monitoring may be specified. However, these do not apply to all channel units of the communication driver.

![System Parameter - Industrial Ethernet](image)

- **Cycle management**
  - By PLC
  - Change driven transfer

- **Lifebeat monitoring**
  - Activate
  - Interval 60
  - Timeout interval 30

- **Monitoring of CPU-stop**
  - Activate

The channel uses cyclic read services in the AS.
B: Establishing connection

On the Unit tab register, it must be specified which access point the connection to the PLC should use. Default setting is access point CP_H1_1:. Earlier, access point CP_H1_1:: was assigned to the CP 1613 communication processor in the Setting PG/PC Interface program. If this access point is supposed to be set automatically, it must be checked whether or not the correct one is used, especially when using multiple communication processors.

Close the dialog with OK.

![System Parameter - Industrial Ethernet](image)

- **Select logical device name**
  - CP-Type/Bus Profile: Industrial Ethernet
  - Logical device name: CP_H1_1:

- **Job processing**
  - Write with priority

- Buttons: OK, Cancel, Help
C: Creating WinCC Tags

<table>
<thead>
<tr>
<th></th>
<th>C: Creating WinCC Tags</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creating WinCC tags required for example. This is done by clicking on the entry for the newly created connection S7_IEH_01 and New Tag.</td>
</tr>
</tbody>
</table>

![Screenshot of WinCC interface showing creation of tags.](image-url)
C: Creating WinCC Tags

The property dialog of the tag opens.
The example uses S16x_S7IEH01_01 as the name for the first tag. The tag is of data type Signed 16-Bit Value. Using the Select button, the address of the new tag is set.
C: Creating WinCC Tags

3 The Address Properties dialog opens. Enter DB as data range and the value 75 as DB No. In the Address field, set Word and set the value to 0 in the DBW field. Finish the dialog with OK. The Property dialog of the tag is also closed by clicking OK.

The just created WinCC tag has been addressed to the area of DB75 where the first of the two values to be added is located.

4 Creating the remaining required WinCC tags.

The procedure is analogous to steps 1 to 3 as described. Names, data types, and addresses of tags used in this example may be obtained from the following display.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>S16x_S7IEH01_01</td>
<td>Signed 16-bit value</td>
<td>DB75.DW0</td>
</tr>
<tr>
<td>S16x_S7IEH01_02</td>
<td>Signed 16-bit value</td>
<td>DB75.DW2</td>
</tr>
<tr>
<td>S16x_S7IEH01_03</td>
<td>Signed 16-bit value</td>
<td>DB75.DW4</td>
</tr>
<tr>
<td>S16x_S7IEH01_04</td>
<td>Signed 16-bit value</td>
<td>DB75.DW6</td>
</tr>
<tr>
<td>S16x_S7IEH01_05</td>
<td>Signed 16-bit value</td>
<td>DB75.DW8</td>
</tr>
</tbody>
</table>
**D: Creating WinCC picture**

<table>
<thead>
<tr>
<th></th>
<th>Creating WinCC picture</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creating a WinCC picture to visualize the previously created tags. To do so, open the Graphics Designer editor using the Open command.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Graphics Designer Editor" /></td>
</tr>
<tr>
<td>2</td>
<td>The Graphics Designer editor is displayed. In it, a new WinCC picture is already open. Configuring a Smart object I/O Field to display the first tag. Select the I/O field in the object palette and place it onto the picture using the mouse.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Object Palette" /></td>
</tr>
</tbody>
</table>
After placement of the I/O field on the picture, its configuration dialog opens. In the Tag field, the tag S16x_S7IEH01_01 is set using the button shown in the following.

Tag updates are left at 2 seconds. The additional set options should retain their default values. Finish the dialog with OK.
4 Changes of output format for I/O field.

Open its property dialog. This is done by clicking on the I/O field and Properties.

The Object Properties dialog opens.

On the Properties tab register, select the Output/Input entry in the left window. Using on the set output value will make the display field editable. Enter the new format s99999. Using this format, the I/O field is capable to display signed values with a maximum of 5 digits.

6 Creating an additional four I/O fields to display the remaining tags.

The procedure is analogous to Steps 2 to 5 as described.
The picture must be saved. In the example project, it was saved under the name com_S7IEH_01.pdl. The picture may be switched directly from Graphics Designer into Runtime by using the button displayed in the following.

Once the picture is in Runtime, the PLC has been started, and the network connection has been established, the current tag values of the PLC are displayed. These may also be changed by input of values into the individual I/O fields.

If no connection to the PLC exists, the I/O fields are shown in gray tones. In this case, some error must exist in some part of the communication link.
3.2.4 Diagnostics of Communication Link Using Industrial Ethernet (Hard Net)

The following description shows options available for diagnostics of the communication link between the WinCC project WinCC_S7_IEH and the SIMATIC S7 station.

Diagnostics of an example in accordance with the following description is only meaningful if the following checks listed have successfully been concluded.

- Commissioning of CP 1613 communication processor
- Testing of communication processor
- Generation of STEP7 project S7_IEH
- Testing of hardware configuration
- Testing of STEP7 program
## A: WinCC Explorer

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| 1 | Diagnostics of communication link in WinCC Explorer. Switch the WinCC_S7_IEH project into Runtime. This is done in WinCC Explorer using the toolbar button displayed in the following.  
  
  ![Activate](image)
  
The created WinCC picture com_3_S7IEH_01.pdl may also be switched directly from Graphics Designer into Runtime. |
| 2 | In WinCC Explorer, using the menu Tools ➔ Status of Driver Connections, a dialog may be opened to monitor all configured connections. However, this menu item is only active if the project is in Runtime.  
  
  ![Tools](image)  
  
  **Status of Driver Connections**  
  - Status of Server Connections  
  - Status of Client Connections |
A: WinCC Explorer

3 The Status - Logical Connections dialog is displayed. This dialog lists all configured connections. In the current example, only the connection S7_IEH_01 exists.

The displayed values correspond to the status at the moment the dialog was opened. By selecting the corresponding checkbox, a cyclic display update may also be achieved.

4 Another option to obtain information on the connection status in general but also on the connection status of individual tags is provided by Tag Management.

The status of a configured connection may be obtained as a tooltip by simply moving the mouse over it.

The current process value of a certain tag, as well as its status, may be obtained as a tooltip by simply moving the mouse over it. This procedure allows determination of errors of a single tag only, not of errors concerning the entire connection.
B: Channel Diagnosis

1. Diagnostics of communication link using the WinCC Channel Diagnosis program.
   This is started using Start ➔ SIMATIC ➔ WinCC ➔ Tools ➔ Channel Diagnosis.

2. The WinCC Channel Diagnosis program is displayed.
   The Channels/Connections tab register displays exact information on the status of each configured connection. The default value for display update is one second. The update cycle may be changed in the lower input field.

3. In case a connection problem exists, the right window will display in the Error Code line a value indicating a more specific cause of the problem.
   More detailed information on error codes may be obtained by clicking on the Error Code entry.
   This will display the description of the respective error code contained in the online help of WinCC. Furthermore, possible error causes are displayed.

   **Error 7001 - CEC_STPCHK**

   Communication aborted due to stop check.
   - The connection was aborted by the channel because a VMD state of the CPU - STOP, HOLD or DEFECTIVE - was detected.
3.3 Communication with SIMATIC S7 Using Industrial Ethernet (Soft Net)

Projects and files to be generated in this chapter may also be loaded onto your hard disk directly from the Online Support (link "Info" on http://support.automation.siemens.com/WW/view/en/21320307).

There is the option of copying the following components to hard disk:

- S7IES
  - The STEP7 project to be generated.

- WinCC_S7IES
  - The WinCC project to be generated.

This chapter describes in detail the implementation of a communication link between SIMATIC S7 and WinCC. The communication link is implemented by using the Industrial Ethernet. The CP 1612 communication processor used in the computer does not have its own CPU, processing of communication tasks is performed by the computer's CPU. Such a constellation is typically referred to as a Soft Net.

Summary on Example Design

On the computer side, the network connection (Industrial Ethernet) is established using a CP 1612 communication processor. Its installation in SIMATIC NET is required. Using the installation from SIMATIC NET, all drivers are installed.

In the WinCC project, the SIMATIC S7 Protocol Suite communication driver must be installed. Using its Industrial Ethernet channel unit, the connection to SIMATIC S7 is configured.

The PLC is equipped with a central module CPU 416-1. Connection to the network is established using the CP443-1 communication processor. In order to configure this communication processor with STEP7 software the NCM S7 Industrial Ethernet options package is required.
Summary of Configuration Steps

The following summary lists all configuration segments necessary for establishing the communication link.

- Commissioning of CP 1612 communication processor
- Generation of STEP7 project S7_IES
- Generation of WinCC project WinCC_S7_IES
- Diagnostics of Communication Link

Required software

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC NET</td>
<td>Using installation from the SIMATIC NET CD, all required drivers are installed.</td>
</tr>
<tr>
<td>Windows</td>
<td>Windows installation software for installation of communication processor CP 1612.</td>
</tr>
<tr>
<td>STEP7</td>
<td>STEP7 Software with option package NCM for Industrial Ethernet to generate the STEP7 project.</td>
</tr>
<tr>
<td>WinCC</td>
<td>WinCC with SIMATIC S7 Protocol Suite communication driver to generate the WinCC project.</td>
</tr>
</tbody>
</table>

Required hardware on computer

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Processor</td>
<td>Communication processor CP 1612 to establish connection to communication processor in PLC.</td>
</tr>
</tbody>
</table>

Required hardware in the PLC

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack</td>
<td>Module rack UR1.</td>
</tr>
<tr>
<td>Power supply unit</td>
<td>Power supply unit PS 407 10A in slots 1 and 2.</td>
</tr>
<tr>
<td>Central module</td>
<td>Central module CPU 416-1 in slot 3.</td>
</tr>
<tr>
<td>Communication Processor</td>
<td>Communication processor CP 443-1 in slot 4.</td>
</tr>
</tbody>
</table>
3.3.1 Commissioning of Communication Processor CP 1612

The following description shows detailed configuration steps necessary for successful commissioning of the CP 1612 communication processor. Communication is facilitated using the SIEMENS Industrial Ethernet protocol. It is assumed that the communication processor was previously installed.

Summary of Configuration Steps

The following is a summary list of all necessary configuration steps for commissioning the communication processor CP 1612.

- A: Configuration of communication processor
- B: Assigning of access point
- C: Testing of communication processor
A: Configuration of communication processor

1 In Program Start ➔ SIMATIC ➔ SIMATIC NET ➔ Settings ➔ "Setting PC station", the communication processor may be configured. In the General menu, the operation mode of the module is set to Configured Mode. This change leads to a display of the Index and Module Name fields. In the example, the index is set to 1 and the module name to CP 1612. The changes are saved using the Apply button. The displayed note may be confirmed by clicking OK.

<table>
<thead>
<tr>
<th>Type of module:</th>
<th>Ethernet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode of the module:</td>
<td>Configured mode</td>
</tr>
<tr>
<td>Index:</td>
<td>1</td>
</tr>
<tr>
<td>Name of the module:</td>
<td>CP1612</td>
</tr>
</tbody>
</table>

2 In the program Settings ➔ Control Panel ➔ Network Connections, the TCP/IP protocol was added unless it previously existed. If you now open the Properties and Internet Protocol Properties dialog, the following windows appear.

In the current example, the following settings were made for the TCP/IP protocol.
B: Assigning of access point

1 In Program Start → SIMATIC → SIMATIC NET → Settings → "Setting PC Station", the just installed interface must be assigned the access point CP_H1_1:.

The access point CP_H1_1: is the default access point used for Industrial Ethernet communication in WinCC. It was created automatically during installation of SIMATIC NET.

2 In the Access Point folder, the entry S7_ONLINE must be selected with D. In the upper field, select the entry ISO Industrial Ethernet -> Siemens CP1612 using the pull-down menu. This concludes the assignment between access point and communication processor.
B: Assigning of access point

3 Module CP 1612 should be assigned access points CP-TCPIP:, S7ONLINE and CP_H1_1: as follows.

![Configuration Console](image)

The address configuration may be checked again in the Address folder.

![Configuration Console](image)
### C: Testing of communication processor

<table>
<thead>
<tr>
<th></th>
<th>C: Testing of communication processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Testing the proper installation of the CP 1612 communication processor using the &quot;Setting PC Station&quot; program. This is started by clicking Start → SIMATIC → SIMATIC NET → Settings → Setting PC Station. In order to test the protocols, select the &quot;Protocol&quot; folder of the respective module. In our case it is module CP 1613.</td>
</tr>
<tr>
<td>2</td>
<td>Testing of proper installation uses the &quot;Test&quot; buttons.</td>
</tr>
<tr>
<td>3</td>
<td>In order to check the Send/Receive function, open the directory SR Test. Use the buttons for testing purposes.</td>
</tr>
<tr>
<td>4</td>
<td>If diagnostics yields a negative result, the cause of the error must be found and the error must be corrected. Some tools and tips on this subject are described in chapter &quot;Is the computer's communication module operable?&quot;. This test may also be performed using the &quot;Setting PG/PC Interface&quot; program, however, the &quot;PG Operation&quot; operation mode is required to do so.</td>
</tr>
</tbody>
</table>
3.3.2 Creating STEP7 Project S7_IES

The following description shows in detail the necessary configuration steps for creating and commissioning of STEP7 project S7_IES.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the STEP7 project S7_IES.

- A: Installation of hardware
- B: Creating STEP7 project
- C: Configuring hardware
- D: Loading of hardware configuration
- E: Testing of hardware configuration
- F: Creating STEP7 program
- G: Testing of STEP7 program
A: Installation of hardware

<table>
<thead>
<tr>
<th></th>
<th>A: Installation of hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Assemble the used modules on the module racks.</td>
</tr>
<tr>
<td></td>
<td>In the current example, these are a power supply unit PS 407 10A,</td>
</tr>
<tr>
<td></td>
<td>a central module CPU 416-1, as well as a communication processor</td>
</tr>
<tr>
<td></td>
<td>CP 443-1.</td>
</tr>
<tr>
<td></td>
<td>Establish the connection between computer and programming</td>
</tr>
<tr>
<td></td>
<td>interface of the central module.</td>
</tr>
<tr>
<td></td>
<td>Establish the connection between the computer's communication</td>
</tr>
<tr>
<td></td>
<td>processor CP 1612 to communication processor CP443-1 in the PLC.</td>
</tr>
</tbody>
</table>

B: Creating STEP7 project

1. Creating a new STEP7 project in SIMATIC Manager. This is started using `Start → SIMATIC → SIMATIC Manager`.

2. Using menu item `File → New`, the dialog to specify parameters of a new STEP7 project opens. Names of STEP7 projects created as part of this manual must start with the character sequence S7. Furthermore, they contain a description of the communication type used. The current example has the name S7_IES. By default, projects are saved in directory `C:\PROGRAM FILES\SIEMENS\STEP7\S7proj`. However, this may be changed at any time by clicking the Browse button. The New dialog is closed by clicking the OK button.
### C: Configuring hardware

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The new project is displayed in SIMATIC Manager. Hardware must be configured for it. Two components are needed. These are a SIMATIC 400 station, as well as an Industrial Ethernet for its connections. These components are added in SIMATIC Manager using R on the name of project S7_IES and Add New Object → SIMATIC 400 Station as well as Insert New Object → Industrial Ethernet.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Simatic Manager" /></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Hardware Config" /></td>
</tr>
<tr>
<td>2</td>
<td>The two components just added are displayed in the right window of SIMATIC Manager. Using D on component SIMATIC 400(1) in the right window will display the Hardware item. Using D on the Hardware item or R and Open Object on it will start the HWConfig program.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Hardware" /></td>
</tr>
</tbody>
</table>
### C: Configuring hardware

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>3</strong></td>
<td>The HWConfig program opens. It is used to exactly specify the hardware used in the PLC, and to configure its properties.</td>
</tr>
<tr>
<td><img src="image" alt="HWConfig" /></td>
<td></td>
</tr>
<tr>
<td><strong>4</strong></td>
<td>Using the subsequently displayed button in the toolbar of HWConfig program, the hardware catalog opens. This is used to select the required hardware components.</td>
</tr>
<tr>
<td><img src="image" alt="Catalog" /></td>
<td></td>
</tr>
</tbody>
</table>
C: Configuring hardware

5 The hardware catalog opens.
The first component to be selected is the module rack used. All additional components are to be installed on it. The module rack used is inserted into the project using "D or Drag&Drop. The example uses module racks of type UR1.

![Hardware Catalog](image)
<table>
<thead>
<tr>
<th></th>
<th>C: Configuring hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>The HWConfig program displays the presently still empty module rack. It has been assigned to rack number 0. In configuring the connection in the WinCC project, the rack number is one of the parameters to be set.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Module Rack Diagram" /></td>
</tr>
</tbody>
</table>
| 7 | Arrangement of additional hardware components in module rack. This uses Drag&Drop for the desired components from the hardware catalog in their respective slots in the module rack.  
   | The example uses a power supply unit PS 407 10A. This is inserted in slot 1. A power supply unit of this type uses two slots.  
   | The example uses a CPU 416-1 as central module. This is inserted in slot 3. In configuring the connection in the WinCC project, the slot number of the central module is an additional parameter to be set.  
   | Furthermore, a CP 443-1 communication processor is needed. However, this is available from the hardware catalog only if the NCM S7 Industrial Ethernet option package has been installed. Once the CP 443-1 communication processor is inserted into the module rack, its properties dialog opens. |
C: Configuring hardware

8 The property dialog of the Ethernet interface of CP 443-1 is displayed. Use the Parameter tab register in the MAC address field to set the desired Ethernet address of the communication processor. The current example specifies this as 08.00.06.01.00.00. In configuring the connection in the WinCC project, this Ethernet address is an additional parameter to be set. Use the lower selection field Subnet to assign the entry Ethernet(1) to the communication processor. Close the dialog with OK.

9 In the following, the fully configured hardware design of the example is shown.

10 Settings made now must be saved in program HWConfig and must be compiled. This is done using the toolbar button displayed in the following.
D: Loading of hardware configuration

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The hardware configuration created in program HWConfig must be transferred to the PLC. This is done using the toolbar button displayed in the following.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Download to Module" /></td>
</tr>
<tr>
<td>2</td>
<td>A dialog opens which allows selection of components to be loaded. In the current example, all selectable components must be marked. Please make sure that any loading of the central module is possible only in operational switch positions STOP or RUN-P. Close the dialog with OK.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Select Target Module" /></td>
</tr>
<tr>
<td>3</td>
<td>The Select Node Address dialog is displayed. Here you state which node address is used for communication between STEP7 software and central module. The current example uses communication via the MPI interface. The address of the central module is 2. Close the dialog with OK.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Target Modules" /></td>
</tr>
<tr>
<td>4</td>
<td>Configuration data are now transferred to the PLC. Individual modules may have to be put into the STOP status. The HWConfig program may be terminated. Components newly added are displayed in SIMATIC Manager for SIMATIC 400(1).</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="SIMATIC Manager" /></td>
</tr>
</tbody>
</table>
E: Testing of hardware configuration

<table>
<thead>
<tr>
<th></th>
<th>E: Testing of hardware configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Testing of hardware configuration decision</td>
</tr>
<tr>
<td></td>
<td>If the key switch of the central module is put into RUN or RUN-P position, and the operational switch of the communication processor is put into RUN position, only status LEDs indicating the RUN state should be lit.</td>
</tr>
<tr>
<td></td>
<td>If this is not the case, an error has occurred. This error may be determined using the steps described in the following. However, these step should also be implemented even if no error is indicated by the status LEDs. This will allow recognition of non-critical errors and faulty configurations.</td>
</tr>
</tbody>
</table>

![Diagram of hardware configuration]
E: Testing of hardware configuration

Testing of configuration in central module.
This uses the Module Information dialog in SIMATIC Manager. This dialog is opened using \( \text{@} \) on the entry of the central module in the left window and Target System \( \rightarrow \) Module Information.

The General tab register displays various general data of the central module. The Status field will display the current Module Information as well as existing errors, if any.

The Diagnostic Buffer tab register display detailed information on existing errors and their correction.

The dialog is closed by clicking the Close button.
E: Testing of hardware configuration

3 Testing of communication processor configuration.
This uses the Module Information dialog in SIMATIC Manager. This dialog is opened using → R on the entry of the communication processor in the left window and Target System → Module Information.
The General tab register displays various general data of the module.
A dialog for more detailed diagnostics of the communication processor may be opened using the Special Diagnostics button.
The NCM S7 Industrial Ethernet Diagnostics dialog opens. The CP Information tab register displays general information on the module. Among others, the set network address may be checked.

The dialog is closed by clicking the Close button. The Module Information dialog may also be closed by clicking the Close button.
F: Creating STEP7 program

For the current example project, only one operations block, OB1, and one data block are needed. OB1 is available by default. The needed data block must first be created. This is done in SIMATIC Manager using right-click on the Blocks subitem of entry S7 program(1) of the configured central module and Insert New Object → Data Block.

The property dialog of the data block opens. Enter DB75 as the name for the block and close the dialog by clicking OK.
F: Creating STEP7 program

2 The newly created data block DB75 is displayed in the right window of the project.
Using 

Open Object on it or using 

and Open Object, the contents of the block may be programmed. The program KOP/AWL/FUP is started.

![Open Object](image)

- Cut: Ctrl+X
- Copy: Ctrl+C
- Paste: Ctrl+V
- Delete: Del
- Insert New Object
- PLC
- Compare Blocks...
- Reference Data
- Print
- Rename: F2
- Object Properties...
- Alt+Return
- Special Object Properties

3 The program KOP/AWL/FUP is displayed.
The New Data Block dialog appears and must be acknowledged by clicking OK.

![KOP/AWL/FUP](image)
F: Creating STEP7 program

4 Programming of DB75.
Here, two tags of length 16 bits are created. Their sum is supposed to be
determined in OB1 and written to another tag of length 16 bits.
Furthermore, two tags of length 16 bits are created, whose values are to be
cyclically incremented in OB1.
Tags created in data block DB75 are supposed to be visualized in the
WinCC project. To do so, WinCC tags with corresponding addresses are
created.
The following shows the completely programmed data block DB75.

<table>
<thead>
<tr>
<th>address</th>
<th>Name</th>
<th>Type</th>
<th>Initial value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>Var_01</td>
<td>WORD</td>
<td>#16#0</td>
<td>Value 1</td>
</tr>
<tr>
<td>+0.0</td>
<td>Var_02</td>
<td>WORD</td>
<td>#16#0</td>
<td>Value 2</td>
</tr>
<tr>
<td>+4.0</td>
<td>Var_03</td>
<td>WORD</td>
<td>#16#0</td>
<td>Summ</td>
</tr>
<tr>
<td>+6.0</td>
<td>Var_04</td>
<td>WORD</td>
<td>#16#0</td>
<td>Inc 1</td>
</tr>
<tr>
<td>+8.0</td>
<td>Var_05</td>
<td>WORD</td>
<td>#16#0</td>
<td>Inc 2</td>
</tr>
<tr>
<td>=10.0</td>
<td>END_STRUCT</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5 The data block must be saved. Furthermore, it must be loaded into the
PLC. This is done using the toolbar button displayed in the following.
Please make sure that any loading of the central module is possible only in
operational switch positions STOP or RUN-P.

6 Programming of OB1.
This must be opened beforehand in program KOP/AWL/FUP.
Initially, two values created in DB75 are added and the result is again
saved in DB75.

Netzwerk 1: Addition

Adding two 16-Bit Values
The result is stored in another
16-Bit Value

<table>
<thead>
<tr>
<th>ODW</th>
<th>DB</th>
<th>75</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>DBW</td>
<td>0</td>
</tr>
<tr>
<td>L</td>
<td>DBW</td>
<td>2</td>
</tr>
<tr>
<td>+I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>DBW</td>
<td>4</td>
</tr>
</tbody>
</table>
Next, the count of a value created in DB75 is implemented every second.

**Network 2**: Second Cycle

Generation of a second cycle at M 0.0

<table>
<thead>
<tr>
<th>AN</th>
<th>M</th>
<th>0.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>S5T#13</td>
<td></td>
</tr>
<tr>
<td>SD</td>
<td>T</td>
<td>1</td>
</tr>
<tr>
<td>A</td>
<td>T</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>K</td>
<td>0.0</td>
</tr>
</tbody>
</table>

**Network 3**: Counting in a second cycle

Counting a value in a second cycle
At 10000, reset to 0

<table>
<thead>
<tr>
<th>AN</th>
<th>M</th>
<th>0.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>JC</td>
<td>M001</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>DBW</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>+I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>DBW</td>
<td>6</td>
</tr>
<tr>
<td>L</td>
<td>10000</td>
<td></td>
</tr>
<tr>
<td>&lt;I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JC</td>
<td>M001</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>DBW</td>
<td>6</td>
</tr>
<tr>
<td>M001:</td>
<td>NOP</td>
<td>0</td>
</tr>
</tbody>
</table>

Next, the count of a value created in DB75 is implemented for each run of OB1.

**Network 4**: Counting in the cycle time

Counting a value each time the OB is executed
At 10000, reset to 0

| L  | DBW | 8   |
|    | 1   |     |
| +I |     |     |
| T  | DBW | 8   |
| L  | 10000|    |
| <I |     |     |
| JC | M002|     |
| L  | 0   |     |
| T  | DBW | 8   |
| M002: | NOP | 0   |

The OB1 block must be saved and loaded into the PLC. This is done using the respective toolbar button.

Thus, the STEP7 project is complete and ready to run. The KOP/AWL/FUP program may be terminated.
G: Testing of STEP7 program

1. Testing of program using STEP7 software.
   A tag table is created for this. This is done in SIMATIC Manager using \[ \text{Monitor / Modify Tag} \] on the entry of the configured central module and Target System \[ \rightarrow \] Monitor / Modify Tag.

2. An editor is displayed to create and use such a tag table.
   In the following, the complete tag table is shown. All tags created in DB75 are entered.
### G: Testing of STEP7 program

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 3    | Monitoring current tag values.  
       By clicking the toolbar button shown in the following, the current values of respective tags in the PLC are displayed in the Status Value column.  
       ![Monitor variable](image)  
       **Monitor variable**  
   | Controlling of tag values.  
   In the Control Value column, values may be entered. By clicking the toolbar button displayed in the following, these values are written to the corresponding tags in the PLC.  
   Please make sure that any controlling of tags is possible only in operational switch position RUN-P.  
       ![Modify variable](image)  
       **Modify variable**  
| 4    | The so-created tag table may now be saved.  
In the current example, it is saved under the name VAT1. If the program function in the PLC has now been checked, the tag table may be closed.  
Thus, configuration of the STEP7 project is complete and SIMATIC Manager may be terminated.  
       ![VAT1](image)  
       **VAT1** |
3.3.3 Creating WinCC Project WinCC_S7IES

The following description shows in detail the necessary configuration steps for creating and commissioning of WinCC project S7IES.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the WinCC project S7IES.

- A: Creating WinCC project
- B: Establishing connection
- C: Creating WinCC tags
- D: Creating WinCC picture
### A: Creating WinCC Project

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creating a new WinCC project in WinCC Explorer. It is started using Start ➔ SIMATIC ➔ WinCC ➔ Windows Control Center.</td>
</tr>
<tr>
<td>2</td>
<td>WinCC Explorer is opened. Using menu item File ➔ New, the dialog to specify the properties of a new WinCC project opens. The following example project creates a single-user project. Finish the dialog with OK.</td>
</tr>
</tbody>
</table>

![WinCC Explorer](image-url)
A: Creating WinCC Project

3  The Create a New Project dialog opens.
   Enter a project name for the new project. WinCC projects created as part of
   this manual begin with a character sequence of WinCC, and furthermore
   contain a description of communication partners, as well as communication
   type used. The current example has the name WinCC_S7_IES.
   Furthermore, in the Project Path field, the storage location of the new project
   must be set.
   The Create a New Project dialog is closed by clicking the Create button.
B: Establishing connection

1. The new project is displayed in WinCC Explorer.
   Installing of required communication driver. This is done by clicking R on the Tag Management item and Add New Driver.

2. The Add New Driver Dialog opens.
   It offers a selection of all communication drivers available for installation.
   For communication with SIMATIC S7, the SIMATIC S7 Protocol Suite driver is required. It must be selected in the dialog. Close the dialog with Open.
The newly added driver SIMATIC S7 Protocol Suite displays as a subitem of Tag Management.

The driver contains eight different channel units. In order to operate two CP 443-1 communication processors on a computer, two channel units are available for Industrial Ethernet.

The current example uses the Industrial Ethernet channel unit. A new connection must be created for it. This is done using the R button on the Industrial Ethernet and New Connection entry.
### B: Establishing connection

4. The property dialog of the connection opens. Enter the name of the new connection on the General tab register. It is S7_IES_01 in the current example.

Specify connection parameters using the Properties button.

Enter the address set for the CP 443-1 communication processor in the Ethernet Address field. In the current example, this is Ethernet address 08.00.06.01.00.00.

Furthermore, Rack Number as well as Slot Number of the central module to be addressed must be entered. Please make sure that values for the central module and not those of the communication processor are entered here.

Close the dialog with OK. The Connection Properties dialog is also closed by clicking OK.
B: Establishing connection

Setting of system parameters for Industrial Ethernet channel unit.

This setting uses the System Parameters dialog which opens using $\text{R}$ on the Industrial Ethernet and System Parameters entry.

On the Channel tab register, different settings for communication and communication monitoring may be specified. However, these do not apply to all channel units of the communication driver.

![System Parameter - Industrial Ethernet](image)

- **Cycle management**
  - by PLC
  - Change driven transfer

- **Lifesbeat monitoring**
  - Activate
  - Interval: 50
  - Timeout interval: 30

- **Monitoring of CPU-stop**
  - Activate

The channel uses cyclic read services in the AS.
B: Establishing connection

6 On the Unit tab register, it must be specified which access point the connection to the PLC should use. Default setting is access point CP_H1_1:. Earlier, access point CP_H1_1:: was assigned the CP 1612 communication processor in the Setting PG/PC Interface program. If this access point is supposed to be set automatically, it must be checked whether or not the correct one is used, especially when using multiple communication processors. Close the dialog with OK.

![Image of System Parameter - Industrial Ethernet dialog box]
C: Creating WinCC tags

<table>
<thead>
<tr>
<th>1</th>
<th>Creating WinCC tags required for example.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This is done by clicking <img src="image" alt="RX" /> on the entry for the newly created connection S7_IES_01 and New Tag.</td>
</tr>
</tbody>
</table>

[Diagram showing a tree structure with options: New Group, New Tag, Find, Cut, Copy, Paste, Delete, Properties]
C: Creating WinCC tags

The property dialog of the tag opens. The example uses S16x_S7IES01_01 as the name for the first tag. The tag is of data type Signed 16-Bit Value. Using the Select button, the address of the new tag is set.
3 The Address Properties dialog opens. Enter DB as data range and the value 75 as DB No. In the Address field, set Word and set the value to 0 in the DBW field. Finish the dialog with OK. The Property dialog of the tag is also closed by clicking OK. The just created WinCC tag has been addressed to the area of DB75 where the first of the two values to be added is located.

![Address Properties Dialog]

4 Creating the remaining required WinCC tags. The procedure is analogous to s 1 to 3 as described. Names, data types, and addresses of tags used in this example may be obtained from the following display.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>S16x_S7ES01_01</td>
<td>Signed 16-bit value</td>
<td>DB75,DW0</td>
</tr>
<tr>
<td>S16x_S7ES01_02</td>
<td>Signed 16-bit value</td>
<td>DB75,DW2</td>
</tr>
<tr>
<td>S16x_S7ES01_03</td>
<td>Signed 16-bit value</td>
<td>DB75,DW4</td>
</tr>
<tr>
<td>S16x_S7ES01_04</td>
<td>Signed 16-bit value</td>
<td>DB75,DW6</td>
</tr>
<tr>
<td>S16x_S7ES01_05</td>
<td>Signed 16-bit value</td>
<td>DB75,DW8</td>
</tr>
</tbody>
</table>
## D: Creating WinCC picture

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1 | Creating a WinCC picture to visualize the previously created tags.  
To do so, open the Graphics Designer editor using **File** and **Open**. |
|   | ![Graphics Designer editor](image)  
**Open**  
- New picture  
- Graphic OIL  
- Select ActiveX Control  
- Convert pictures  
- Convert global library  
- Convert project library  
- Properties |
| 2 | The Graphics Designer editor is displayed. In it, a new WinCC picture is already open.  
Configuring a Smart object I/O Field to display the first tag. Select the I/O field in the object palette and place it onto the picture using the mouse. |
|   | ![Object Palette](image)  
- Standard Objects  
- Smart Objects  
  - Application Window  
  - Picture Window  
  - Control  
  - OLE Element  
  - I/O Field  
  - Bar  
  - Graphic Object  
  - Status Display  
  - Text List  
  - 3D-Bar  
  - Group Display  
- Windows Objects |
D: Creating WinCC picture

3. After placement of the I/O field on the picture, its configuration dialog opens. In the Tag field, the tag S16x_S7IES01_01 is set using the button shown in the following.

Tag updates are set to Upon Change. The additional set options should retain their default values. Finish the dialog with OK.
D: Creating WinCC picture

4 Changes of output format for I/O field.
Open its property dialog. This is done by clicking on the I/O field and Properties.

5 The Object Properties dialog opens.
On the Properties tab register, select the Output/Input entry in the left window. Using on the set output value will make the display field editable. Enter the new format 99999. Using this format, the I/O field is capable to display signed values with a maximum of 5 digits.

6 Creating an additional four I/O fields to display the remaining tags.
The procedure is analogous to Steps 2 to 5 as described.
The picture must be saved.

In the example project, it was saved under the name com_3S7IES_01.pdl. The picture may be switched directly from Graphics Designer into Runtime by using the button displayed in the following.

Once the picture is in Runtime, the PLC has been started, and the network connection has been established, the current tag values of the PLC are displayed. These may also be changed by input of values into the individual I/O fields.

If no connection to the PLC exists, the I/O fields are shown in gray tones. In this case, some error must exist in some part of the communication link.
3.3.4 Diagnostics of Communication Link Using Industrial Ethernet (Soft Net)

The following description shows options available for diagnostics of the communication link between the WinCC project WinCC_S7_IES and the SIMATIC S7 station.

Diagnostics of an example in accordance with the following description is only meaningful if the following checks listed have successfully been concluded.

- Commissioning of CP 1612 communication processor
- Testing of communication processor
- Generation of STEP7 project S7_IES
- Testing of hardware configuration
- Testing of STEP7 program
A: WinCC Explorer

1. Diagnostics of communication link in WinCC Explorer.
   Switch the WinCC_S7_IES project into Runtime. This is done in WinCC Explorer using the toolbar button displayed in the following.

   ![Activate](image)

   The created WinCC picture com_3_S7IES_01.pdl may also be switched directly from Graphics Designer into Runtime.

2. In WinCC Explorer, using the menu Tools ➔ Status of Driver Connections, a dialog may be opened to monitor all configured connections. However, this menu item is only active if the project is in Runtime.

   ![Tools](image)

   Status of Driver Connections
   Status of Server Connections
   Status of Client Connections

3. The Status - Logical Connections dialog is opened.
   This dialog lists all configured connections. In the current example, only the connection S7_IES_01 exists.

   The displayed values correspond to the status at the moment the dialog was opened. By selecting the corresponding checkbox, a cyclic display update may also be achieved.

   ![Status - Logical Connections](image)
Another option to obtain information on the connection status in general but also on the connection status of individual tags is provided by Tag Management.

The status of a configured connection may be obtained as a tooltip by simply moving the mouse over it.

<table>
<thead>
<tr>
<th>Name</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7IES_01</td>
<td>H1.00 00 06.01 00 00.03.02</td>
</tr>
<tr>
<td>Status: OK</td>
<td></td>
</tr>
</tbody>
</table>

The current process value of a certain tag, as well as its status, may be obtained as a tooltip by simply moving the mouse over it. This procedure allows determination of errors of a single tag only, not of errors concerning the entire connection.

| Name   | Type             | Parameters |
|--------|-----------------|
| S16S_S7IES_01 | Signed 16-bit value | DB75.DW0 |
|         | Process value: 34 |
|         | Quality: c0      |
|         | Last Change: 1/31/2005 10:23:35 AM |
B: Channel Diagnosis

1. Diagnostics of communication link using the WinCC Channel Diagnosis program.
   This is started using Start → SIMATIC → WinCC → Tools → Channel Diagnosis.

2. The WinCC Channel Diagnosis program is opened.
   The Channels/Connections tab register displays exact information on the status of each configured connection. The default value for display update is one second. The update cycle may be changed in the lower input field.

3. In case a connection problem exists, the right window will display in the Error Code line a value indicating a more specific cause of the problem. More detailed information on this error code may be obtained by clicking R on the Error Code and Help entry.
   This will display information on the respective error code. Furthermore, possible error causes are displayed.

   **Error 7001 - CEC_STPCHK**
   Communication aborted due to stop check.
   - The connection was aborted by the channel because a VMD state of the CPU - STOP, HOLD or DEFECTIVE - was detected.
3.4 Communication with SIMATIC S7 Using TCP/IP

Projects and files to be generated in this chapter may also be loaded onto your hard disk directly from the Online Support (link "Info" on http://support.automation.siemens.com/WW/view/en/21320307).

There is the option of copying the following components to hard disk:

- **S7_IETCP**
  The STEP7 project to be generated.

- **WinCC_S7_IETCP**
  The WinCC project to be generated.

This chapter describes in detail the implementation of a communication link between SIMATIC S7 and WinCC. The communication link is implemented by using the Industrial Ethernet. The TCP/IP protocol is used as the transport protocol.

Summary on Example Design

On the computer side, the network connection (Industrial Ethernet) is established using a CP 1612 communication processor. For its installation on the computer, the IE SOFTNET-S7 BASIC driver from the SIMATIC NET CD is required.

In the WinCC project, the SIMATIC S7 Protocol Suite communication driver must be installed. Using its TCP/IP channel unit, the connection to SIMATIC S7 is configured.

The PLC is equipped with a central module CPU 416-1. Connection to the network is established using the CP443-1 communication processor. In order to configure this communication processor with STEP7 software, the NCM S7 Industrial Ethernet options package is required.
Summary of Configuration Steps

The following summary lists all configuration segments necessary for establishing the communication link.

- Commissioning of CP 1612 communication processor
- Generation of STEP7 project S7_IETCP
- Generation of WinCC project WinCC_S7_IETCP
- Diagnostics of communication links

Required software

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC NET</td>
<td>Driver IE SOFTNET-S7 BASIC for installation of communication processor CP 1612 from the SIMATIC NET CD.</td>
</tr>
<tr>
<td>Windows</td>
<td>Windows installation software for installation of communication processor CP 1612 as well as TCP/IP protocol.</td>
</tr>
<tr>
<td>STEP7</td>
<td>STEP7 Software with option package NCM for Industrial Ethernet to generate the STEP7 project.</td>
</tr>
<tr>
<td>WinCC</td>
<td>WinCC with SIMATIC S7 Protocol Suite communication driver to generate the WinCC project.</td>
</tr>
</tbody>
</table>

Required hardware on computer

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Processor</td>
<td>Communication processor CP 1612 to establish connection to communication processor in PLC.</td>
</tr>
</tbody>
</table>

Required hardware in the PLC

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack</td>
<td>Module rack UR1.</td>
</tr>
<tr>
<td>Power supply unit</td>
<td>Power supply unit PS 407 10A in slots 1 and 2.</td>
</tr>
<tr>
<td>Central module</td>
<td>Central module CPU 416-1 in slot 3.</td>
</tr>
<tr>
<td>Communication Processor</td>
<td>Communication processor CP 443-1 TCP in slot 4.</td>
</tr>
</tbody>
</table>
3.4.1 Commissioning of CP 1612 Communication Processor

The following description shows detailed configuration steps necessary for successful commissioning of the CP 1612 communication processor. Communication is facilitated using the SIEMENS Industrial Ethernet protocol. It is assumed that the communication processor was previously installed.

Summary of Configuration Steps

The following is a summary list of all necessary configuration steps for commissioning the communication processor CP 1612.

- A: Configuration of communication processor
- B: Assigning of access point
- C: Testing of communication processor
A: Configuration of communication processor

1. In Program Start → SIMATIC → SIMATIC NET → Settings → "Setting PC station", the communication processor may be configured. In the General menu, the operation mode of the module is set to Configured Mode. This change leads to a display of the Index and Module Name fields. In the example, the index is set to 1 and the module name to CP 1612. The changes are saved using the Apply button. The displayed note may be confirmed by clicking OK.

   | Type of module: | Ethernet          |
   | Mode of the module: | Configured mode |
   | Index: | 1          |
   | Name of the module: | CP1612          |

2. In the program Settings → Control Panel → Network Connections, the TCP/IP protocol was added unless it previously existed. If you now open the Properties and Internet Protocol Properties dialog, the following windows appear.

   In the current example, the following settings were made for the TCP/IP protocol.
B: Assigning of access point

1. In Program Start → SIMATIC → SIMATIC NET → Settings → “Setting PC Station”, the just installed interface must be assigned to the access point CP_H1_1:

   The access point CP_H1_1: is the default access point used for Industrial Ethernet communication in WinCC. It was created automatically during installation of SIMATIC NET.

   ![Configuration Console](image)

2. In the Access Point folder, the entry S7_ONLINE must be selected with D. In the upper field, select the entry ISO Industrial Ethernet → Siemens CP1612 using the pull-down menu. This concludes the assignment between access point and communication processor.

   ![S7ONLINE Properties](image)

   If you change an access point of a PROFIBUS module to another interface parameter assignment of the same module, all other access points that point to the old interface parameter assignment will be resmopped to the new interface parameter assignment.
B: Assigning of access point

3 Module CP 1612 should be assigned access points CP-TCPIP:, S7ONLINE, and CP_H1_1: as follows.

4 The address configuration may be checked again in the Address folder.
C: Testing of communication processor

<table>
<thead>
<tr>
<th></th>
<th>C: Testing of communication processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Testing the proper installation of the CP 1612 communication processor using the &quot;Setting PC Station&quot; program. This is started by clicking Start → SIMATIC → SIMATIC NET → Settings → Setting PC Station. In order to test the protocols, select the &quot;Protocol&quot; folder of the respective module. In our case it is module CP 1613.</td>
</tr>
<tr>
<td>2</td>
<td>Testing of proper installation uses the &quot;Test&quot; buttons.</td>
</tr>
<tr>
<td>3</td>
<td>In order to check the Send/Receive function, open the directory SR Test. Use the buttons for testing purposes.</td>
</tr>
<tr>
<td>4</td>
<td>If diagnostics yields a negative result, the cause of the error must be found and the error must be corrected. Some tools and tips on this subject are described in chapter &quot;Is the computer's communication module operable?&quot;. This test may also be performed using the &quot;Setting PG/PC Interface&quot; program, however, the &quot;PG Operation&quot; operation mode is required to do so.</td>
</tr>
</tbody>
</table>
3.4.2 Creating STEP7 Project S7_IETCP

The following description shows in detail the necessary configuration steps for creating and commissioning of STEP7 project S7_IETCP.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the STEP7 project S7_IETCP.

- A: Installation of hardware
- B: Creating STEP7 project
- C: Configuring hardware
- D: Loading of hardware configuration
- E: Testing of hardware configuration
- F: Creating STEP7 program
- G: Testing of STEP7 program
## A: Installation of hardware

<table>
<thead>
<tr>
<th></th>
<th><strong>A: Installation of hardware</strong></th>
</tr>
</thead>
</table>
| 1 | Assemble the used modules on the module racks.  
In the current example, these are a power supply unit PS 407 10A, a central module CPU 416-1, as well as a communication processor CP 443-1 TCP.  
Establish the connection between computer and programming interface of the central module.  
Establish the connection between the computer’s communication processor CP 1612 to communication processor CP 443-1 TCP in the PLC. |
B: Creating STEP7 project

1. Creating a new STEP7 project in SIMATIC Manager.
   This is started using Start ➔ SIMATIC ➔ SIMATIC Manager.

2. The SIMATIC Manager opens.
   Using menu item File ➔ New, the dialog to specify parameters of a new
   STEP7 project opens.
   Enter the name of the newly created project in the Name field. Names of
   STEP7 projects created as part of this manual must start with the character
   sequence S7. Furthermore, they contain a description of the
   communication type used. The current example has the name S7_IETCP.
   By default, projects are saved in directory C:\PROGRAM
   FILES\SIEMENS\STEP7\S7proj. However, this may be changed at any
   time by clicking the Browse button.
   The New dialog is closed by clicking the OK button.
C: Configuring hardware

1 The new project is displayed in SIMATIC Manager. Hardware must be configured for it. Two components are needed. These are a SIMATIC 400 station, as well as an Industrial Ethernet for its connections.

These components are added in SIMATIC Manager using $R$ on the name of project S7_IETCP and Insert New Object $\rightarrow$ SIMATIC 400 Station as well as Insert New Object $\rightarrow$ Industrial Ethernet.

2 The two components just added are displayed in the right window of SIMATIC Manager.

Using $D$ on component SIMATIC 400(1) in the right window will display the Hardware item. Using $D$ on the Hardware item or $R$ and Open Object on it will start the HWConfig program.
### C: Configuring hardware

3 The HWConfig program opens. It is used to exactly specify the hardware used in the PLC, and to configure its properties.

![HWConfig](image)

4 Using the subsequently displayed button in the toolbar of HWConfig program, the hardware catalog opens. This is used to select the required hardware components.

![Catalog](image)
### C: Configuring hardware

The hardware catalog opens. The first component to be selected is the module rack used. All additional components are to be installed on it. The module rack used is inserted into the project using Drag&Drop. The example uses module racks of type UR1.

![Hardware Catalog](image)

<table>
<thead>
<tr>
<th>Profile</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROFINET</td>
<td>DP</td>
</tr>
<tr>
<td>SIMATIC 300</td>
<td></td>
</tr>
<tr>
<td>SIMATIC 400</td>
<td></td>
</tr>
<tr>
<td>CP 400</td>
<td></td>
</tr>
<tr>
<td>CPU 400</td>
<td></td>
</tr>
<tr>
<td>PM 400</td>
<td></td>
</tr>
<tr>
<td>IM 400</td>
<td></td>
</tr>
<tr>
<td>M7 EXTENSION</td>
<td></td>
</tr>
<tr>
<td>PS 400</td>
<td></td>
</tr>
<tr>
<td>PAC 400</td>
<td></td>
</tr>
<tr>
<td>CR 2</td>
<td></td>
</tr>
<tr>
<td>CR 1</td>
<td></td>
</tr>
<tr>
<td>ER 1</td>
<td></td>
</tr>
<tr>
<td>ER 1</td>
<td></td>
</tr>
<tr>
<td>ER 2</td>
<td></td>
</tr>
<tr>
<td>ER 2</td>
<td></td>
</tr>
<tr>
<td>UR 1</td>
<td></td>
</tr>
<tr>
<td>UR 1</td>
<td></td>
</tr>
<tr>
<td>UR 2</td>
<td></td>
</tr>
<tr>
<td>UR 2</td>
<td></td>
</tr>
<tr>
<td>SM 400</td>
<td></td>
</tr>
<tr>
<td>SIMATIC PC Based Control 300/400</td>
<td></td>
</tr>
<tr>
<td>SIMATIC PC Station</td>
<td></td>
</tr>
</tbody>
</table>

**Universal rack, 18 slots, not suitable for redundant power supply modules**
C: Configuring hardware

6 The HWConfig program displays the presently still empty module rack. It has been assigned to rack number 0. In configuring the connection in the WinCC project, the rack number is one of the parameters to be set.

![Module Rack Diagram](image)

7 Arrangement of additional hardware components in module rack. This uses Drag&Drop for the desired components from the hardware catalog in their respective slots in the module rack.

The example uses a power supply unit PS 407 10A. This is inserted in slot 1. A power supply unit of this type uses two slots.

The example uses a CPU 416-1 as central module. This is inserted in slot 3. In configuring the connection in the WinCC project, the slot number of the central module is an additional parameter to be set.

Furthermore, a CP 443-1 TCP communication processor is needed. However, this is available from the hardware catalog only if the NCM S7 Industrial Ethernet option package has been installed. Once the CP 443-1 TCP communication processor is inserted into the module rack, its properties dialog opens.
C: Configuring hardware

8 The property dialog of communication processor CP 443-1 TCP is displayed. Use the Parameter tab register in the MAC address field to set the desired Ethernet address of the communication processor. Settings relevant for communication using the TCP/IP protocol are the TCP/IP address and the subnet mask.

In configuring the connection in the WinCC project, the IP Address of communication processor CP 443-1 TCP is an additional parameter to be set. Set the same value as the subnet mask which was used as subnet mask during installation of communication processor CP 1612 for same.

Use the lower selection field Subnet to assign the entry Ethernet(1) to the communication processor. Close the dialog with OK.
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>C: Configuring hardware</strong></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>In the following, the fully configured hardware design of the example is shown.</td>
</tr>
<tr>
<td><img src="image" alt="Hardware Configuration" /></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Settings made now must be saved in program HWConfig and must be compiled. This is done using the toolbar button displayed in the following.</td>
</tr>
<tr>
<td><img src="image" alt="Toolbar Button" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Save and Compile</td>
</tr>
</tbody>
</table>
D: Loading of hardware configuration

1. The hardware configuration created in program HWConfig must be transferred to the PLC.
   This is done using the toolbar button displayed in the following.

2. A dialog opens which allows selection of components to be loaded.
   In the current example, all selectable components must be marked. Please make sure that any loading of the central module is possible only in operational switch positions STOP or RUN-P. Close the dialog with OK.

3. The Select Node Address dialog opens.
   Here you state which node address is used for communication between STEP7 software and central module. The current example uses communication via the MPI interface. The address of the central module is 2. Close the dialog with OK.

4. Configuration data are now transferred to the PLC. Individual modules may have to be put into the STOP status.
   The HWConfig program may be terminated. Components newly added are displayed in SIMATIC Manager for SIMATIC 400(1).
E: Testing of hardware configuration

1 Testing of hardware configuration decision

If the key switch of the central module is put into RUN or RUN-P position, and the operational switch of the communication processor is put into RUN position, only status LEDs indicating the RUN state should be lit.

If this is not the case, an error has occurred. This error may be determined using the steps described in the following. However, these step should also be implemented even if no error is indicated by the status LEDs. This will allow recognition of non-critical errors and faulty configurations.
**E: Testing of hardware configuration**

2 Testing of configuration in central module.

This uses the Module Information dialog in SIMATIC Manager. This dialog is opened using on the entry of the central module in the left window and Target System ➔ Module Information.

The Module Information dialog of the central module is displayed. The General tab register displays various general data of the central module. The Status field will display the current Module Information as well as existing errors, if any.

The Diagnostic Buffer tab register display detailed information on existing errors and their correction.

The dialog is closed by clicking the Close button.
E: Testing of hardware configuration

3 Testing of communication processor configuration.

This uses the Module Information dialog in SIMATIC Manager. This dialog is opened using <R on the entry of the communication processor in the left window and Target System → Module Information.

The General tab register displays various general data of the module. A dialog for more detailed diagnostics of the communication processor may be opened using the Special Diagnostics button.
4 The NCM S7 Industrial Ethernet Diagnostics dialog opens. 
The CP Information tab register displays general information on the module. 
The dialog is closed by clicking the Close button. The Module Information dialog may also be closed by clicking the Close button.
### F: Creating STEP7 program

<table>
<thead>
<tr>
<th>F: Creating STEP7 program</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating STEP7 program</td>
</tr>
<tr>
<td>For the current example project, only one operations block, OB1, and one data block are needed. OB1 is available by default. The needed data block must first be created. This is done in SIMATIC Manager using the Blocks subitem of entry S7 program(1) of the configured central module and Add New Object → Data Block. The property dialog of the data block opens. Enter DB75 as the name for the block and close the dialog by clicking OK.</td>
</tr>
</tbody>
</table>

![Screenshot of SIMATIC Manager window](image)

- **CPU 416-1**
  - **S7 Program(1)**
  - **Sources**
  - **Blocks**
    - Cut
    - Copy
    - Paste
  - **Delete**
  - **Insert New Object**
    - Organization Block
    - Function Block
    - Function
    - Data Block
    - Data Type
    - Variable Table
  - **PLC**
  - **Rewiring...**
  - **Compare Blocks...**
  - **Reference Data**
  - **Check Block Consistency...**
  - **Print**
  - **Rename**
    - F2
  - **Object Properties...**
    - Alt+Return
  - **Special Object Properties**
F: Creating STEP7 program

2 The newly created data block DB75 is displayed in the right window of the project.

Using [D on it or using [R and Open Object, the contents of the block may be programmed. The program KOP/AWL/FUP is started.

<table>
<thead>
<tr>
<th>Open Object</th>
<th>Ctrl+Alt+O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
</tr>
</tbody>
</table>

Insert New Object
PLC

Compare Blocks...
Reference Data

Print

Rename F2
Object Properties... Alt+Return
Special Object Properties

3 The program KOP/AWL/FUP opens.
The New Data Block dialog appears and must be acknowledged by clicking OK.

KOP/AWL/FUP
F: Creating STEP7 program

4 Programming of DB75.
Here, two tags of length 16 bits are created. Their sum is supposed to be
determined in OB1 and written to another tag of length 16 bits.
Furthermore, two tags of length 16 bits are created, whose values are to be
cyclically incremented in OB1.
Tags created in data block DB75 are supposed to be visualized in the
WinCC project. To do so, WinCC tags with corresponding addresses are
created.
The following shows the completely programmed data block DB75.

<table>
<thead>
<tr>
<th>address</th>
<th>Name</th>
<th>Type</th>
<th>Initial value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>Var_01</td>
<td>WORD</td>
<td>#16#0</td>
<td>Value 1</td>
</tr>
<tr>
<td>+4.0</td>
<td>Var_02</td>
<td>WORD</td>
<td>#16#0</td>
<td>Value 2</td>
</tr>
<tr>
<td>+8.0</td>
<td>Var_03</td>
<td>WORD</td>
<td>#16#0</td>
<td>Summ</td>
</tr>
<tr>
<td>+12.0</td>
<td>Var_04</td>
<td>WORD</td>
<td>#16#0</td>
<td>Inc 1</td>
</tr>
<tr>
<td>+16.0</td>
<td>Var_05</td>
<td>WORD</td>
<td>#16#0</td>
<td>Inc 2</td>
</tr>
<tr>
<td>+20.0</td>
<td>END_STRUCT</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5 The data block must be saved. Furthermore, it must be loaded into the
PLC. This is done using the toolbar button displayed in the following.
Please make sure that any loading of the central module is possible only in
operational switch positions STOP or RUN-P.

6 Programming of OB1.
This must be opened beforehand in program KOP/AWL/FUP.
Initially, two values created in DB75 are added and the result is again
saved in DB75.

Netzwerk 1: Addition

Adding two 16-Bit Values
The result is stored in another
16-Bit Value

<table>
<thead>
<tr>
<th>DB75 DB 75</th>
</tr>
</thead>
<tbody>
<tr>
<td>L DB32 0</td>
</tr>
<tr>
<td>L DB32 2</td>
</tr>
<tr>
<td>T DB32 4</td>
</tr>
</tbody>
</table>
F: Creating STEP7 program

Next, the count of a value created in DB75 is implemented every second.

**Network 2**: Second Cycle

Generation of a second cycle at M 0.0

<table>
<thead>
<tr>
<th>AN</th>
<th>M 0.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>S5T#1S</td>
</tr>
<tr>
<td>SD</td>
<td>T 1</td>
</tr>
<tr>
<td>A</td>
<td>T 1</td>
</tr>
<tr>
<td></td>
<td>M 0.0</td>
</tr>
</tbody>
</table>

**Network 3**: Counting in a second cycle

Counting a value in a second cycle
At 10000, reset to 0

<table>
<thead>
<tr>
<th>AN</th>
<th>M 0.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>JC</td>
<td>M001</td>
</tr>
<tr>
<td>L</td>
<td>DBW 6</td>
</tr>
<tr>
<td>L</td>
<td>1</td>
</tr>
<tr>
<td>+I</td>
<td>T</td>
</tr>
<tr>
<td></td>
<td>DBW 6</td>
</tr>
<tr>
<td>L</td>
<td>10000</td>
</tr>
<tr>
<td>&lt;I</td>
<td>JC</td>
</tr>
<tr>
<td></td>
<td>M001</td>
</tr>
<tr>
<td>L</td>
<td>0</td>
</tr>
<tr>
<td>T</td>
<td>DBW 6</td>
</tr>
<tr>
<td>M001: NOP</td>
<td>0</td>
</tr>
</tbody>
</table>

Next, the count of a value created in DB75 is implemented for each run of OB1.

**Network 4**: Counting in the cycle time

Counting a value each time the OB is executed
At 10000, reset to 0

| L  | DBW 8 |
|    | 1    |
| +I | T    |
|    | DBW 8 |
| L  | 10000 |
| <I | JC |
|    | M002 |
| L  | 0    |
| T  | DBW 3 |
| M002: NOP | 0 |

The OB1 block must be saved and loaded into the PLC. This is done using the respective toolbar button.

Thus, the STEP7 project is complete and ready to run. The KOP/AWL/FUP program may be terminated.
G: Testing of STEP7 program

1. Testing of program using STEP7 software.

A tag table is created for this. This is done in SIMATIC Manager using \( \text{Monitor / Modify Tag} \) on the entry of the configured central module and Target System \( \text{Monitor / Modify Tag} \).

2. An editor is displayed to create and use such a tag table.

In the following, the complete tag table is shown. All tags created in DB75 are entered.
### G: Testing of STEP7 program

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 3 | Monitoring current tag values. By clicking the toolbar button shown in the following, the current values of respective tags in the PLC are displayed in the Status Value column.
|   | ![Monitor variable](image) |
|   | **Monitor variable** |
|   | Controlling of tag values. In the Control Value column, values may be entered. By clicking the toolbar button displayed in the following, these values are written to the corresponding tags in the PLC.  
|   | ![Modify variable](image) |
|   | **Modify variable** |
| 4 | The so-created tag table may now be saved. In the current example, it is saved under the name VAT1. If the program function in the PLC has now been checked, the tag table may be closed. Thus, configuration of the STEP7 project is complete and SIMATIC Manager may be terminated.  
|   | ![VAT1](image) |
3.4.3 Creating WinCC Project WinCC_S7_IETCP

The following description shows in detail the necessary configuration steps for creating and commissioning of WinCC project S7_IETCP.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the WinCC project S7_IETCP.

- A: Creating WinCC project
- B: Establishing connection
- C: Creating WinCC tags
- D: Creating WinCC picture
## A: Creating WinCC project

<table>
<thead>
<tr>
<th></th>
<th>A: Creating WinCC project</th>
</tr>
</thead>
</table>
| 1 | Creating a new WinCC project in WinCC Explorer.  
   | It is started using Start → SIMATIC → WinCC → Windows Control Center. |
|   | ![WinCC Explorer](image) |
| 2 | WinCC Explorer is opened.  
   | Using menu item File → New, the dialog to specify the properties of a new WinCC project opens.  
   | The following example project creates a single-user project.  
   | Finish the dialog with OK. |

![WinCC Explorer](image)
A: Creating WinCC project

3 The Create a New Project dialog opens.

Enter a project name for the new project. WinCC projects created as part of this manual begin with a character sequence of WinCC, and furthermore contain a description of communication partners, as well as communication type used. The current example has the name WinCC_S7_IETCP.

Furthermore, in the Project Path field, the storage location of the new project must be set.

The Create a New Project dialog is closed by clicking the Create button.
B: Establishing connection

1 The new project is displayed in WinCC Explorer.

Installing of required communication driver. This is done by clicking on the Tag Management item and Add New Driver.

2 The Add New Driver Dialog opens.

It offers a selection of all communication drivers available for installation. For communication with SIMATIC S7, the SIMATIC S7 Protocol Suite driver is required. It must be selected in the dialog. Close the dialog with Open.
B: Establishing connection

3. The newly added driver SIMATIC S7 Protocol Suite displays as a subitem of Tag Management.

   The driver contains eight different channel units. The current example uses the TCP/IP channel unit. A new connection must be created for it. This is done using the TCP/IP and New Connection entry.
B: Establishing connection

The property dialog of the connection opens. Enter the name of the new connection on the General tab register. It is S7_IETCP_01 in the current example. Specify connection parameters using the Properties button.
The Connection Parameter dialog opens. Enter the address set for the CP 443-1 TCP communication processor in the Ethernet Address field. In the current example, this is the address 140.80.0.2.

Furthermore, Rack Number as well as Slot Number of the central module to be addressed must be entered. Please make sure that values for the central module and not those of the communication processor are entered here. Close the dialog with OK. The Connection Properties dialog is also closed by clicking OK.
B: Establishing connection

Setting of system parameters for TCP/IP channel unit.
This setting is made in the System Parameter dialog. This is opened using 
on the TCP/IP and System Parameter entry.

On the SIMATIC S7 tab register, different settings for communication and
communication monitoring may be specified. However, these do not apply
to all channel units of the communication driver.

System Parameter - TCP/IP

Cycle management
- by PLC
- Change driven transfer

Heartbeat monitoring
- Activate
  Interval: 60
  Timeout: 30

Monitoring of CPU-stop
- Activate

The channel uses cyclic read services in the A3.
On the Unit tab register, it must be specified which access point the connection to the PLC should use. The default setting is access point CP-TCPIP. Earlier, the access point CP-TCPIP was assigned to communication processor CP 1612 in the Setting PG/PC Interface program. If this access point is supposed to be set automatically, it must be checked whether or not the correct one is used, especially when using multiple communication processors. Close the dialog with OK.
C: Creating WinCC tags

1 Creating WinCC tags required for example.

This is done by clicking on the entry for the newly created connection S7_IETCP_01 and New Tag.
The property dialog of the tag opens. The example uses S16x_S7IETCP01_01 as the name for the first tag. The tag is of data type Signed 16-Bit Value. Using the Select button, the address of the new tag is set.
C: Creating WinCC tags

3 The Address Properties dialog opens.

Enter DB as data range and the value 75 as DB No. In the Address field, set Word and set the value to 0 in the DBW field. Finish the dialog with OK. The Property dialog of the tag is also closed by clicking OK.

The just created WinCC tag has been addressed to the area of DB75 where the first of the two values to be added is located.

4 Creating the remaining required WinCC tags.

The procedure is analogous to Steps 1 to 3 as described. Names, data types, and addresses of tags used in this example may be obtained from the following display.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>S16x_S7ETCP01_01</td>
<td>Signed 16-bit value</td>
<td>DB75,DW0</td>
</tr>
<tr>
<td>S16x_S7ETCP01_02</td>
<td>Signed 16-bit value</td>
<td>DB75,DW2</td>
</tr>
<tr>
<td>S16x_S7ETCP01_03</td>
<td>Signed 16-bit value</td>
<td>DB75,DW4</td>
</tr>
<tr>
<td>S16x_S7ETCP01_04</td>
<td>Signed 16-bit value</td>
<td>DB75,DW6</td>
</tr>
<tr>
<td>S16x_S7ETCP01_05</td>
<td>Signed 16-bit value</td>
<td>DB75,DW8</td>
</tr>
</tbody>
</table>
D: Creating WinCC picture

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creating a WinCC picture to visualize the previously created tags. To do so, open the Graphics Designer editor using <strong>R and Open.</strong></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Graphics Designer editor" /></td>
</tr>
<tr>
<td>2</td>
<td>The Graphics Designer editor is displayed. In it, a new WinCC picture is already open. Configuring a Smart object <strong>I/O Field</strong> to display the first tag. Select the I/O field in the object palette and place it onto the picture using the mouse.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Object palette" /></td>
</tr>
</tbody>
</table>
D: Creating WinCC picture

3 After placement of the I/O field on the picture, its configuration dialog opens.
In the Tag field, the tag S16x_S7ETCP01_01 is set using the button shown in the following.

Tag updates are left at 2s. The additional set options should retain their default values. Finish the dialog with OK.
D: Creating WinCC picture

4 Changes of output format for I/O field.
Open its property dialog. This is done by clicking right on the I/O field and Properties.

D: Creating WinCC picture

5 The Object Properties dialog opens.
On the Properties tab register, select the Output/Input entry in the left window. Using right on the set output value will make the display field editable. Enter the new format s99999. Using this format, the I/O field is capable to display signed values with a maximum of 5 digits.

5 The Object Properties dialog opens.
On the Properties tab register, select the Output/Input entry in the left window. Using right on the set output value will make the display field editable. Enter the new format s99999. Using this format, the I/O field is capable to display signed values with a maximum of 5 digits.

6 Creating an additional four I/O fields to display the remaining tags.
The procedure is analogous to Steps 2 to 5 as described.
The picture must be saved.
In the example project, it was saved under the name com_3S71ETCP_01.pdl. The picture may be switched directly from Graphics Designer into Runtime by using the button displayed in the following.

Once the picture is in Runtime, the PLC has been started, and the network connection has been established, the current tag values of the PLC are displayed. These may also be changed by input of values into the individual I/O fields.

If no connection to the PLC exists, the I/O fields are shown in gray tones. In this case, some error must exist in some part of the communication link.
3.4.4 Diagnostics of Communication Links Using TCP/IP

The following description shows options available for diagnostics of the communication link between the WinCC project WinCC_S7_IETCP and the SIMATIC S7 station.

Diagnostics of an example in accordance with the following description is only meaningful if the following checks listed have successfully been concluded.

- Commissioning of CP 1612 communication processor
- Generation of STEP7 project S7_IETCP
- Testing of hardware configuration
- Testing of STEP7 program
A: WinCC Explorer

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td>Diagnostics of communication link in WinCC Explorer. Switch the WinCC_S7_IETCP project into Runtime. This is done in WinCC Explorer using the toolbar button displayed in the following. The created WinCC picture com_3_S7IETCP_01.pdl may also be switched directly from Graphics Designer into Runtime.</td>
</tr>
<tr>
<td><strong>2</strong></td>
<td>In WinCC Explorer, using the menu Tools ➔ Status of Driver Connections, a dialog may be opened to monitor all configured connections. However, this menu item is only active if the project is in Runtime. The Status - Logical Connections dialog is opened. This dialog lists all configured connections. In the current example, only the connection S7_IETCP_01 exists. The displayed values correspond to the status at the moment the dialog was opened. By selecting the corresponding checkbox, a cyclic display update may also be achieved.</td>
</tr>
<tr>
<td><strong>3</strong></td>
<td>The displayed values correspond to the status at the moment the dialog was opened. By selecting the corresponding checkbox, a cyclic display update may also be achieved.</td>
</tr>
</tbody>
</table>
Another option to obtain information on the connection status in general but also on the connection status of individual tags is provided by Tag Management.

The status of a configured connection may be obtained as a tooltip by simply moving the mouse over it.

The current process value of a certain tag, as well as its status, may be obtained as a tooltip by simply moving the mouse over it. This procedure allows determination of errors of a single tag only, not of errors concerning the entire connection.
B: Channel Diagnosis

1. Diagnostics of communication link using the WinCC Channel Diagnosis program.
   This is started using Start ➔ SIMATIC ➔ WinCC ➔ Channel Diagnosis.

2. The WinCC Channel Diagnosis program is opened.
   The Channels/Connections tab register displays exact information on the status of each configured connection. The default value for display update is one second. The update cycle may be changed in the lower input field.

3. In case a connection problem exists, the right window will display in the Error Code line a value indicating a more specific cause of the problem.
   More detailed information on error codes may be obtained by clicking on the Error Code entry.
   This will display a description of the respective error code. Furthermore, possible error causes are displayed.

   **Error 7001 - CEC_STPCHK**

   Communication aborted due to stop check.
   - The connection was aborted by the channel because a VMD state of the CPU - STOP, HOLD or DEFECTIVE - was detected.
3.5 Communication with SIMATIC S7 Using OPC

Projects and files to be generated in this chapter may also be loaded onto your hard disk directly from the Online Support (link "Info" on http://support.automation.siemens.com/WW/view/en/21320307).

There is the option of copying the following components to hard disk:

- **S7_OPC**
  The STEP7 project to be generated.

- **WinCC_S7_OPC**
  The WinCC project to be generated.

This chapter describes in detail the implementation of a communication link between SIMATIC S7 and WinCC. The example uses Profibus to implement the communication link. Minor adjustments also enable communication using the Industrial Ethernet.

The S7-OPC server running inside the computer enables provision of data from the PLC to other computer applications as well as the entire network environment. The S7-OPC server communicates with the PLC using the CP 5611 communication processor.

**Summary on Example Design**

On the computer side, the network connection (Profibus) is established using a CP 5611 communication processor. Its installation on the computer requires installed SIMATIC NET software with the S7-OPC Server option package. Using the installation from SIMATIC NET, all necessary drivers are installed.

The OPC communication driver must be installed in the WinCC project. The connection to the S7-OPC server is configured using this OPC client.

The PLC is equipped with a central module CPU 414-2.
Summary of Configuration Steps

The following summary lists all configuration segments necessary for establishing the communication link.

- Commissioning of CP 5611 communication processor
- Generation of STEP7 project S7.OPC
- Configuring the S7.OPC server
- Generation of WinCC project WinCC_S7.OPC
- Diagnostics of communication link

Required software

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC NET</td>
<td>Installed SIMATIC NET software. Using the software, all required drivers are installed. S7.OPC server for communication with OPC client of WinCC.</td>
</tr>
<tr>
<td>STEP7</td>
<td>STEP7 software to create STEP7 project.</td>
</tr>
<tr>
<td>WinCC</td>
<td>WinCC with OPC communication driver to create WinCC project.</td>
</tr>
</tbody>
</table>

Required hardware on computer

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Processor</td>
<td>Communication processor CP 5611 to establish connection to communication processor in PLC</td>
</tr>
</tbody>
</table>

Required hardware in the PLC

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack</td>
<td>Module rack UR1.</td>
</tr>
<tr>
<td>Power supply unit</td>
<td>Power supply unit PS 407 10A in slots 1 and 2.</td>
</tr>
<tr>
<td>Central module</td>
<td>Central module CPU 414-2 in slot 3.</td>
</tr>
</tbody>
</table>
3.5.1 Configuring WinCC Stations

The following description contains notes to be taken into consideration during configuration of WinCC stations.

During access to an OPC server from a WinCC client station, three constellations are possible in general. These differ on where these two components are located.

- Server and client are on the same computer
- Server and client are on different computers but within the same work group
- Server and client are on different computers in the same domain, or in different domains in trust positions

The first of the above constellations is not goal-oriented for communication between a WinCC OPC server and a WinCC OPC client. This constellation, however, may very well be used in many cases, such as communication with the S7-OPC server.

In the following steps described, the local circumstances must be taken into consideration.

- A: Installing software components
- B: Organization of network
- C: Organization of user structure
- D: Setting DCOM configuration
A: Installing software components

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td>OPC server and OPC client of WinCC are required. The OPC servers are located on the WinCC Installation CD. The OPC client is automatically installed with WinCC. The OPC server must be installed on the computer which will serve as server. This may have happened during installation of WinCC. However, it may also be installed after the fact without any problems. Following installation of components on the respective computers, these computers must be rebooted.</td>
</tr>
</tbody>
</table>

### Select Components

Activate or deactivate the components which should be installed or deinstalled, respectively.

<table>
<thead>
<tr>
<th>Component</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC</td>
<td>299 MB</td>
</tr>
<tr>
<td>Help</td>
<td>49 MB</td>
</tr>
<tr>
<td>Communication</td>
<td>4 MB</td>
</tr>
<tr>
<td>OPC Server</td>
<td>11 MB</td>
</tr>
<tr>
<td>Options</td>
<td>45 MB</td>
</tr>
</tbody>
</table>

- **Data Access**: 4 MB
- **Alarm & Events**: 2 MB
- **Historical Data Access**: 2 MB
- **HDA Write Access**: 2 MB
- **XML Data Access**: 3 MB

---

Available: 7400 MB
B: Organization of network

1 Organization of network

Settings required for the respective computers for organizing the network are implemented in the Network program. This is started using Start → Settings → Control Panel → System.

On the Identification tab register, the computer assignment may be made either to a work group or to a domain by using the Change button.

![Computer Name Changes](image)

You can change the name and the membership of this computer. Changes may affect access to network resources.

**Computer name:**

CPC_Client

**Full computer name:**

CPC_Client.zip.at

**Member of:**

- Domain:
  - zip.at
- Workgroup:

[OK] [Cancel]
C: Organization of user structure

<table>
<thead>
<tr>
<th></th>
<th>C: Organization of user structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Defining the user on both computers.</td>
</tr>
<tr>
<td></td>
<td>This is facilitated on each computer using the User Manager program. This is started using Start ➔ Programs ➔ Administrative Tools ➔ Computer Management.</td>
</tr>
<tr>
<td></td>
<td>If a work group is used, it must be ascertained that the user of the client station is known at the server station. Furthermore, the user of the server station must be known at the client station in order to use full functionality of OPC.</td>
</tr>
<tr>
<td></td>
<td>If the domain concept is used, no attention needs to be paid to this since all users in the entire domain are known. For cross-domain access to a server station, however, a reciprocal trust position of both domains is required.</td>
</tr>
</tbody>
</table>
## D: Setting DCOM configuration

<table>
<thead>
<tr>
<th>1</th>
<th>Following installation of WinCC, the DCOM settings of the OPC server of WinCC are configured properly. These settings must be changed if the registered user of the OPC client or server computer does not have administrator authorization if the OPC server is registered under a different user account that the OPC client.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Setting of DCOM configuration for WinCC-OPC server. The settings for DCOM configuration are implemented using the DCOM Configuration Properties program. This can be started via Start → Run and entering the program name dcomcnfg.exe.</td>
</tr>
<tr>
<td>3</td>
<td>The Component Services application opens. Select under Component Services → Station → DCOM Configuration the OPCServer.WinCC entry. For the WinCC-OPC-HDA server, the OPCHDAServers.WinCC entry must be used. For the WinCC-OPC A&amp;E server, the OPCServerAE.WinCC entry must be used. In the pop-up menu of OPCServer.WinCC, select the Properties entry.</td>
</tr>
</tbody>
</table>
4 Click on the Security tab register. In the Access Permissions area, mark the Customize option. Click the Edit button. The Properties of OPCServer.WinCC dialog is displayed.
D: Setting DCOM configuration

5 The Access Permission dialog opens. Add users Administrators, Interactive, Everyone, Network and System with Allow authorization. Close the dialog by clicking OK.

For the configuration phase, it may be useful to grant everyone access permissions to avoid problems beforehand due to insufficient access rights. After successful commissioning of communication, any desired restrictions on access authorizations for certain users may be easily configured.
D: Setting DCOM configuration

6 In the Launch Permission area, mark the Customize option. Click the Edit button. The Launch Permission dialog opens.
Add users Everyone and Network with Allow Authorization. Close the dialog by clicking OK.

7 Close the dialog by clicking OK.
3.5.2 Commissioning of Communication Processor CP 5611

The following description shows detailed configuration steps necessary for successful commissioning of the CP 5611 communication processor. It is assumed that the communication processor was previously installed.

Summary of Configuration Steps

The following is a summary list of all necessary configuration steps for implementing the communication processor CP 5611.

- A: Configuration of communication processor
- B: Assigning communication processor
- C: Testing of communication processor
A: Configuration of communication processor

1. In Program Start → SIMATIC → SIMATIC NET → Settings → "Setting PC station", the communication processor may be configured. In menu "General", the module operation mode must be set to PG Operation.

![Configuration Console](image)

2. The Profibus address as well as network parameters may only be changed in PG operation. In the current example, the address was set to 3. The transmission rate is set to 1.5 Mbit/s. Changes are saved by pushing the Apply button.

![Configuration Console](image)
A: Configuration of communication processor

3 In the General menu, the operation mode of the module is set to Configured Mode. This change leads to a display of the Index and Module Name fields. In the example, the index is set to 1 and the module name to CP 5611. The changes are saved using the Apply button. The displayed note may be confirmed by clicking OK.
B: Assigning communication processor

1. In Program Start → SIMATIC → SIMATIC NET → Settings
   Setting PC Station, the access point COMPUTING has been created automatically. The CP5611 was assigned to this access point.

2. The Profibus address as well as network parameters may only be changed in PG operation.
C: Testing of communication processor

Testing the proper installation of the CP 5611 communication processor using the "Setting PC Station" program.

In order to perform network diagnostics, the Network Diagnostics folder must be selected in the respective module. In our case it is module CP 5611.

On the right side, the Network Diagnostics PROFIBUS Parameter window is displayed. Here you may check station address and bus parameters.

![Configuration Console](image)
C: Testing of communication processor

2 In order to check if all bus participants are connected using the Profibus, the Bus Participant menu item must be selected.
If no SIMATIC has yet been connected to the bus, only the CP 5611 communication processor is recognized.

3 If diagnostics yields a negative result, the cause of the error must be found and the error must be corrected. Some tools and tips on this subject are described in chapter "Is the computer's communication module operable?". This test may also be performed using the "Setting PG/PC Interface" program, however, the "PG Operation" operation mode is required to do so.
3.5.3 Creating STEP7 Project S7_OPC

The following description shows in detail the necessary configuration steps for creating and commissioning of STEP7 project S7_OPC.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the STEP7 project S7_OPC.

- A: Installation of hardware
- B: Creating STEP7 project
- C: Configuring hardware for SIMATIC PC station
- D: Loading hardware configuration for SIMATIC PC station
- E: Configuring hardware for SIMATIC 400
- F: Loading hardware configuration for SIMATIC 400
- G: Testing of hardware configuration
- H: Creating STEP7 program
- I: Testing of STEP7 program

A: Installation of hardware

<table>
<thead>
<tr>
<th></th>
<th>A: Installation of hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Assemble the used modules on the module racks.</td>
</tr>
<tr>
<td></td>
<td>In the current example, these are one power supply unit PS 407 10A and one central module CPU 414-2.</td>
</tr>
<tr>
<td></td>
<td>Establish the connection between programming device and programming interface of the central module.</td>
</tr>
<tr>
<td></td>
<td>Establish the connection between the computer's communication processor CP 5611 to CP443-2 in the PLC.</td>
</tr>
</tbody>
</table>
## B: Creating STEP7 project

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| 1 | Creating a new STEP7 project in SIMATIC Manager.  
This is started using Start → SIMATIC → SIMATIC Manager. |

The SIMATIC Manager opens.  
Using menu item File → New, the dialog to specify parameters of a new STEP7 project opens.  
Enter the name of the newly created project in the Name field. Names of STEP7 projects created as part of this manual must start with the character sequence S7. Furthermore, they contain a description of the communication type used. The current example has the name S7_OPC.  
By default, projects are saved in directory C:\PROGRAM FILES\SIEMENS\STEP7\S7proj. However, this may be changed at any time by clicking the Browse button.  
The New dialog is closed by clicking the OK button.

![New Project dialog](image)
C: Configuring hardware for SIMATIC PC station

1. The new project is displayed in SIMATIC Manager. Hardware must be configured for it. Three components are needed. These are one SIMATIC 400 station as well as one SIMATIC PC station. Furthermore, for their network links, one Profibus is required.

These components are obtained in SIMATIC Manager using \( \text{R} \) on the name of project S7_OPC and Insert New Project \( \rightarrow \) SIMATIC 400 station, Insert New Object \( \rightarrow \) SIMATIC PC station as well as Insert New Object \( \rightarrow \) Industrial Ethernet.

2. The two components just added are displayed in the right window of SIMATIC Manager. Using \( \text{D} \) on component SIMATIC PC Station(1) in the right window will display the Hardware item. Using \( \text{D} \) on the Hardware item or \( \text{R} \) and Open Object on it will start the HWConfig program.
3 In order to enable a connection to the configured PC station later on, the name of the PC station must agree with the name in Station Configuration Editor.

The Station Configuration Editor is started using Start → Station Configuration Editor.

In the example, the PC station is named SIMATIC PC Station(1).

4 The HWConfig program opens.

It is used to exactly specify the hardware used in the PLC, and to configure its properties.

5 Using the subsequently displayed button in the toolbar of HWConfig program, the hardware catalog opens. This is used to select the required hardware components.
C: Configuring hardware for SIMATIC PC station

The hardware catalog and the presently still vacant PC module rack are displayed.

All components to be used must be installed on the module rack. The first components to be selected is the communication processor. This uses Drag&Drop for the component from the hardware catalog into its slot 1 in the module rack.
7 After inserting CP 5611, the property dialog of the Profibus interface for CP 5611 opens.

Use the Parameter tab register in the address field to set the desired Profibus address of the communication processor.

Use the lower selection field Subnet to assign the entry PROFIBUS(1) to the communication processor. Close the dialog with OK.
C: Configuring hardware for SIMATIC PC station

8 Assembly of OPC server at module rack. This uses Drag&Drop for the desired component from the hardware catalog in their respective slots in the module rack. For STEP7 V5.2, it is imperative to select an OPC server with a version higher than V6.0.

The example therefore uses OPC Server V6.1. It is inserted in slot 2.

9 In the following, the fully configured hardware design of the example is shown.

10 Settings made now must be saved in program HWConfig and must be compiled. This is done using the toolbar button displayed in the following.
D: Loading hardware configuration for SIMATIC PC station

1. The hardware configuration created in the HWConfig program must be transferred to the PC station. Loading of the hardware configuration uses the toolbar button of the HWConfig program shown in the following.

2. A dialog opens which allows selection of components to be loaded. In the current example, all selectable components must be marked. Close the dialog with OK.
D: Loading hardware configuration for SIMATIC PC station

3 The Select Node Address dialog opens.
On the configuration side (STEP7), the station manager represents the configuration of the entire SIMATIC PC station.
Close the dialog with OK.

![Select node address dialog](image)
D: Loading hardware configuration for SIMATIC PC station

4 Configuration data are now transferred to the PLC. Individual modules may have to be put into the STOP status. The HWConfig program may be terminated. Components newly added are displayed in SIMATIC Manager for SIMATIC 400(1).
### E: Configuring hardware for SIMATIC 400

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Using ( \text{Ctrl+D} ) on component SIMATIC 400(1) in the right window will display the Hardware item. Using ( \text{Ctrl+R} ) on the Hardware item or ( \text{Ctrl+O} ) and Open Object on it will start the HWConfig program.</td>
</tr>
<tr>
<td>2</td>
<td>The HWConfig program opens. It is used to exactly specify the hardware used in the PLC, and to configure its properties.</td>
</tr>
<tr>
<td>3</td>
<td>Using the subsequently displayed button in the toolbar of HWConfig program, the hardware catalog opens. This is used to select the required hardware components.</td>
</tr>
</tbody>
</table>
4 The hardware catalog opens. The first component to be selected is the module rack used. All additional components are to be installed on it. The module rack used is inserted into the project using Drag&Drop. The example uses module racks of type UR1.

5 The HWConfig program displays the presently still empty module rack.
E: Configuring hardware for SIMATIC 400

6 Arrangement of additional hardware components in module rack. This uses Drag&Drop for the desired components from the hardware catalog in their respective slots in the module rack.

The example uses a power supply unit PS 407 10A. This is inserted in slot 1. A power supply unit of this type uses two slots.

The example uses a CPU 414-2 as central module. This is inserted in slot 3. If the module is inserted into the module rack, its Property dialog opens.

7 The Property dialog of the Profibus interface of CPU 414-2 opens.

Use the Parameter tab register in the address field to set the desired Profibus address of the central module. In creating the data base file for communication processor CP 1413 in the computer, this address is one of the parameters to be set.

Use the lower selection field Subnet to assign the entry PROFIBUS(1) to the central module. Using the Properties button, the Properties dialog of Profibus is called. Both dialogs are closed with OK.
In the following, the fully configured hardware design of the example is shown.

Settings made in the HWConfig program must be saved. This is done using the toolbar button displayed in the following.
**F: Loading hardware configuration for SIMATIC 400**

1. Loading of the hardware configuration uses the toolbar button of the HWConfig program shown in the following.

   ![Download to Module]

2. A dialog opens which allows selection of components to be loaded. In the current example, all selectable components must be marked. Close the dialog with OK.
3 F: Loading hardware configuration for SIMATIC 400

The Select Node Address dialog opens. Close the dialog with OK.

Configuration data are now transferred to the PLC. Individual modules may have to be put into the STOP status. The HWConfig program may be terminated.

Components newly added are displayed in SIMATIC Manager for SIMATIC 400(1).
### G: Testing of hardware configuration

<table>
<thead>
<tr>
<th>1</th>
<th>Testing of hardware configuration decision</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If the key switch of the central module is put into RUN or RUN-P position, and the operational switch of the communication processor is put into RUN position, only status LEDs indicating the RUN state should be lit. If this is not the case, an error has occurred. This error may be determined using the steps described in the following. However, these step should also be implemented even if no error is indicated by the status LEDs. This will allow recognition of non-critical errors and faulty configurations.</td>
</tr>
</tbody>
</table>

![Diagram of hardware configuration testing]
G: Testing of hardware configuration

Testing of configuration in central module.

This uses the Module Information dialog in SIMATIC Manager. This dialog is opened using R on the entry of the central module in the left window and Target System → Module Information.

The General tab register displays various general data of the central module. The Status field will display the current Module Information as well as existing errors, if any.

The Diagnostic Buffer tab register display detailed information on existing errors and their correction.

The dialog is closed by clicking the Close button.
3 Testing of communication processor configuration.

This uses the Module Information dialog in SIMATIC Manager. This dialog is opened using the entry of the communication processor in the left window and Target System Module Information.

The General tab register displays various general data of the module.
**H: Creating STEP7 program**

1. Creating STEP7 program

For the current example project, only one operations block, OB1, and one data block are needed. OB1 is available by default. The needed data block must first be created. This is done in SIMATIC Manager using R on the Blocks subitem of entry S7 program(1) of the configured central module and Insert New Object → Data Block.

The property dialog of the data block opens. Enter DB75 as the name for the block and close the dialog by clicking OK.

![Property dialog of data block](image)

<table>
<thead>
<tr>
<th>Insert New Object</th>
<th>Organization Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC</td>
<td>Function Block</td>
</tr>
<tr>
<td>Rewiring...</td>
<td>Function</td>
</tr>
<tr>
<td>Compare Blocks...</td>
<td>Data Block</td>
</tr>
<tr>
<td>Reference Data</td>
<td>Data Type</td>
</tr>
<tr>
<td>Check block Consistency...</td>
<td>Variable Table</td>
</tr>
<tr>
<td>Print</td>
<td></td>
</tr>
<tr>
<td>Rename</td>
<td>F2</td>
</tr>
<tr>
<td>Object Properties...</td>
<td>Alt+Return</td>
</tr>
<tr>
<td>Special Object Properties</td>
<td></td>
</tr>
</tbody>
</table>
## H: Creating STEP7 program

### 2

The newly created data block DB75 is displayed in the right window of the project.

Using the D on it or using R and Open Object, the contents of the block may be programmed. The program KOP/AWL/FUP is started.

<table>
<thead>
<tr>
<th>Open Object</th>
<th>Ctrl+Alt+O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
</tr>
</tbody>
</table>

Insert New Object

PLC

Compare Blocks...

Reference Data

Print

Rename F2

Object Properties... Alt+Return

Special Object Properties

### 3

The program KOP/AWL/FUP opens.

The New Data Block dialog appears and must be acknowledged by clicking OK.
H: Creating STEP7 program

4 Programming of DB75.

Here, two tags of length 16 bits are created. Their sum is supposed to be determined in OB1 and written to another tag of length 16 bits.

Furthermore, two tags of length 16 bits are created, whose values are to be cyclically incremented in OB1.

The following shows the completely programmed data block DB75.

<table>
<thead>
<tr>
<th>address</th>
<th>Name</th>
<th>Type</th>
<th>Initial value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>Var_01</td>
<td>WORD</td>
<td>&amp;H16#0</td>
<td>Value 1</td>
</tr>
<tr>
<td>+2.0</td>
<td>Var_02</td>
<td>WORD</td>
<td>&amp;H16#0</td>
<td>Value 2</td>
</tr>
<tr>
<td>+4.0</td>
<td>Var_03</td>
<td>WORD</td>
<td>&amp;H16#0</td>
<td>Summ</td>
</tr>
<tr>
<td>+6.0</td>
<td>Var_04</td>
<td>WORD</td>
<td>&amp;H16#0</td>
<td>Inc: 1</td>
</tr>
<tr>
<td>+8.0</td>
<td>Var_05</td>
<td>WORD</td>
<td>&amp;H16#0</td>
<td>Inc: 2</td>
</tr>
</tbody>
</table>

-10.0 END STRUCT

5 In order to effectively configure the data block in connection with the OPC server, a symbolic name must be issued. This is done in SIMATIC Manager using the R on the data block and selection of the Object Properties menu item.
**H: Creating STEP7 program**

6. The Properties - Data Block dialog opens. A symbolic name must be issued here, and the dialog must be closed thereafter by clicking OK.

![Properties - Data Block dialog](image)

- **Name:** DB75
- **Symbolic Name:** DB75
- **Created in Language:** DB
- **Project Path:** S7_0DP\SIMATIC 400[1]:CPU 414-2 DP\S7
- **Storage location of project:** C:\Program Files\Siemens\SIMATIC\NCM\s7\proj\S7_0DP

7. The data block must be saved. Furthermore, it must be loaded into the PLC. This is done using the toolbar button displayed in the following. Please make sure that any loading of the central module is possible only in operational switch positions STOP or RUN-P.

![Download button](image)


   This must be opened beforehand in program KOP/AWL/FUP.

   Initially, two values created in DB75 are added and the result is again saved in DB75.

   **Netzwerk 1: Addition**

   Adding two 16-Bit Values
   The result is stored in another 16-Bit Value

<table>
<thead>
<tr>
<th>OPN</th>
<th>DB</th>
<th>75</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>DBW</td>
<td>0</td>
</tr>
<tr>
<td>L</td>
<td>DBW</td>
<td>2</td>
</tr>
<tr>
<td>+I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>DBW</td>
<td>4</td>
</tr>
</tbody>
</table>
### H: Creating STEP7 program

Next, the count of a value created in DB75 is implemented every second.

**Network 2: second cycle**

**Generation of a second cycle at M 0.0**

<table>
<thead>
<tr>
<th>AN</th>
<th>M</th>
<th>0.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>S511S</td>
<td></td>
</tr>
<tr>
<td>SD</td>
<td>T</td>
<td>1</td>
</tr>
<tr>
<td>A</td>
<td>T</td>
<td>1</td>
</tr>
<tr>
<td>=</td>
<td>M</td>
<td>0.0</td>
</tr>
</tbody>
</table>

**Network 3: Counting in a second cycle**

**Counting a value in a second cycle**

At 10000, reset to 0

<table>
<thead>
<tr>
<th>AN</th>
<th>M</th>
<th>0.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>JC</td>
<td>M001</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>DBW</td>
<td>6</td>
</tr>
<tr>
<td>L</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>+I</td>
<td>T</td>
<td>DBW</td>
</tr>
<tr>
<td>L</td>
<td>10000</td>
<td></td>
</tr>
<tr>
<td>&lt;I</td>
<td>JC</td>
<td>M001</td>
</tr>
<tr>
<td>L</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>DBW</td>
<td>6</td>
</tr>
<tr>
<td>M001:</td>
<td>NOP</td>
<td>0</td>
</tr>
</tbody>
</table>

Next, the count of a value created in DB75 is implemented for each run of OB1.

**Network 4: Counting in the cycle time**

**Counting a value each time the OB is executed**

At 10000, reset to 0

| L   | DBW   | 6   |
| L   | 1     |     |
| +I  | T     | DBW | 6 |
| L   | 10000 |     |
| <I  | JC    | M002|
| L   | 0     |     |
| T   | DBW   | 6   |
| M002: | NOP   | 0   |

The OB1 block must be saved and loaded into the PLC. This is done using the respective toolbar button.

Thus, the STEP7 project is complete and ready to run. The KOP/AWL/FUP program may be terminated.
### Project Examples

#### I: Testing of STEP7 program

1. Testing of program using STEP7 software.
   
   A tag table is created for this. This is done in SIMATIC Manager using the entry of the configured central module and Target System Monitor / Modify Tag.

   ![SIMATIC Manager screenshot](image)

2. An editor is displayed to create and use such a tag table.
   
   In the following, the complete tag table is shown. All tags created in DB75 are entered.

   ![Tag table screenshot](image)

<table>
<thead>
<tr>
<th>Address</th>
<th>Symbol</th>
<th>Display Format</th>
<th>Status Value</th>
<th>Modify Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB75.D8W</td>
<td>0</td>
<td>DEC</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>DB75.D8W</td>
<td>2</td>
<td>DEC</td>
<td>1.2</td>
<td>1.2</td>
</tr>
<tr>
<td>DB75.D8W</td>
<td>4</td>
<td>DEC</td>
<td>2.1</td>
<td></td>
</tr>
<tr>
<td>DB75.D8W</td>
<td>6</td>
<td>DEC</td>
<td>1.0E3</td>
<td>1.0E3</td>
</tr>
<tr>
<td>DB75.D8W</td>
<td>8</td>
<td>DEC</td>
<td>1.7E3</td>
<td></td>
</tr>
</tbody>
</table>
### I: Testing of STEP7 program

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| 3 | Monitoring current tag values.  
By clicking the toolbar button shown in the following, the current values of respective tags in the PLC are displayed in the Status Value column.  

![Monitor variable](image)

Controlling of tag values.  
In the Control Value column, values may be entered. By clicking the toolbar button displayed in the following, these values are written to the corresponding tags in the PLC.  

Please make sure that any controlling of tags is possible only in operational switch position RUN-P.  

![Modify variable](image)

| 4 | The so-created tag table may now be saved.  
In the current example, it is saved under the name VAT1. If the program function in the PLC has now been checked, the tag table may be closed. Thus, configuration of the STEP7 project is complete and SIMATIC Manager may be terminated.  

![VAT1](image)
3.5.4 Configuring S7-OPC Server

The following description shows in detail the necessary configuration steps for configuring the S7-OPC server.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the STEP7 project S7OPC.
- A: Establishing a connection
- B: Testing the S7-OPC server
### A: Establishing a connection

<table>
<thead>
<tr>
<th></th>
<th>Establishing a connection in the NetPro program.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>This is started in SIMATIC Manager in the right window using Connections.</td>
</tr>
</tbody>
</table>

1. Establishing a connection in the NetPro program. This is started in SIMATIC Manager in the right window using Connections.

   ![SIMATIC Manager](image1)

The NetPro program opens. If you select the OPC server, a connection table opens in the lower window. In order to configure a connection, a line must be selected with "R" and "Insert New Connection".

2. The NetPro program opens. If you select the OPC server, a connection table opens in the lower window. In order to configure a connection, a line must be selected with "R" and "Insert New Connection".

   ![NetPro Program](image2)
A: Establishing a connection

3 The Insert New Connection Dialog opens.
This dialog displays all configured Profibus participants. The CPU is selected in our example. In the Connection - Type field, select S7 Connection. Close the dialog with OK.
A: Establishing a connection

4 The Properties - S7 Connection dialog opens. It must be checked if the proper partners have been entered and if an active connection is established on the part of the OPC server.

Close the dialog with OK.

5 In order to check the correct connection configuration, select the OPC server in the NetPro program using \( R \). In the appearing menu, the connection partner is selected by Highlight \( \rightarrow \) Connection Partner.
A: Establishing a connection

6 Thereafter, the connection partners are displayed in the NetPro program as follows.
### B: Testing the S7-OPC server

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| 1 | Testing the S7-OPC server using the OPC Scout program.  
   | This is started using Start → SIMATIC → SIMATIC NET → PROFIBUS → SOFTNET PROFIBUS → OPC Scout.  
   | OPC Scout |
| 2 | The OPC Scout program opens.  
   | In the left window all available OPC servers are listed. Among others, the list of local servers contains the entry for the S7-OPC server. This is the entry OPC.SimaticNET. Using D on the OPC.SimaticNET entry, a connection to the S7-OPC server is established. |
| 3 | The Add Group dialog is displayed.  
   | Using it, a new group may be created in the S7-OPC server. Such a group facilitates the data exchange between OPC server and OPC client. The newly created group must be given a name. The update cycle of the group is set to 2000 ms. The group is created by clicking OK.  
   | ![Add Group](image1)  
   | Group Properties:  
   | Enter a 'Group Name':  
   | S7.OPC.Test-group  
   | Create new group active  
   | Requested update rate in ms  
   | 2000  
   | OK  
   | Cancel  
   | Apply |
| 4 | The new group is displayed as a subitem of the S7-OPC server in the left window. However, it is empty at this point. For this group, the data must now be specified which are to be requested from the OPC server. The data made available by the OPC server are referred to as items.  
   | Using D on the Group entry in the left window, the required items are now specified.  
   | ![Group](image2)
B: Testing the S7-OPC server

5 The OPC Navigator dialog opens.

Using it, all items offered by the server are accessible. Using \( \text{Diagram} \) on the entry for connection S7_Connection_01 and \( \text{Diagram} \) on the subsequently displayed Objects entry will list all object types available at the PLC. Among others, data blocks are among these object types. Using \( \text{Diagram} \) on the DB entry will display all accessible data blocks. In the current example, this is only DB75.

Using \( \text{Diagram} \) on the (New Definition) entry, the required items may be defined.
B: Testing the S7-OPC server

6 The Define New Item dialog opens.
Using it, a new item may be created. In the current example, the first item to be created corresponds to the first of five tags created during the creation of the STEP7 program in DB75.

In the Data Type field, the type of this item must be set to INT. This corresponds to a signed 16-bit value. In the Address field, the byte number 0 is entered. This corresponds to the tag's byte number in the data block. In the Number of Values field, a 1 is entered. Close the dialog with OK.

7 The middle column will now display the newly defined item.
For the remaining four tags of DB75, analog to the previously described procedure, items must be defined. However, the respective byte number of these tags must be used.
In order to insert the just defined items into the group, these must be selected and moved to the right list by using the arrow keys. They are inserted into the group by clicking OK.

8 The just inserted items are listed in the right window of the OPC Scout program.
In the Value column, the current tag values are displayed.
The OPC Scout program may now be terminated. However, there is also the option of saving the just created project.
3.5.5 Creating WinCC Project WinCC_S7_OPC

The following description shows in detail the necessary configuration steps for creating and commissioning of WinCC project S7_OPC.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the WinCC project S7_OPC.

- A: Installing OPC server
- B: Creating WinCC project
- C: Establishing connection
- D: Conventional configuration
- E: Creating WinCC picture
### A: Installing OPC server

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>During the installation of WinCC, the OPC server may be installed at the same time as an option. If the OPC server has not been installed at the same time, it can be installed after the fact without any problems.</td>
</tr>
</tbody>
</table>

#### Select Components

Activate or deactivate the components which should be installed or deinstalled, respectively.

**Components**

<table>
<thead>
<tr>
<th>Component</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC</td>
<td>290 MB</td>
</tr>
<tr>
<td>Help</td>
<td>49 MB</td>
</tr>
<tr>
<td>Communication</td>
<td>4 MB</td>
</tr>
<tr>
<td>OPC Server</td>
<td>10 MB</td>
</tr>
<tr>
<td>Options</td>
<td>45 MB</td>
</tr>
<tr>
<td>Data Access</td>
<td>1 MB</td>
</tr>
<tr>
<td>Alarm &amp; Events</td>
<td>2 MB</td>
</tr>
<tr>
<td>Historical Data Access</td>
<td>2 MB</td>
</tr>
<tr>
<td>WinDA Write Access</td>
<td>2 MB</td>
</tr>
<tr>
<td>XML Data Access</td>
<td>0 MB</td>
</tr>
</tbody>
</table>

**Description**

- Worldwide standardized and common manufacturer software interface for process connections

**Available:** 7408 MB
### B: Creating WinCC project

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| **1** | Creating a new WinCC project in WinCC Explorer.  
This is started using Start → SIMATIC → WinCC → Windows Control Center 6.0. |

![WinCC Explorer](image)

| **2** | WinCC Explorer is opened.  
Using menu item File → New, the dialog to specify the properties of a new WinCC project opens.  
The following example project creates a single-user project.  
Finish the dialog with OK. |

![Create a New Project](image)
B: Creating WinCC project

3 The Create a New Project dialog opens. Enter a project name for the new project. WinCC projects created as part of this manual begin with a character sequence of WinCC, and furthermore contain a description of communication partners, as well as communication type used. The current example has the name WinCC_S7_OPC. Furthermore, in the Project Path field, the storage location of the new project must be set. The Create a New Project dialog is closed by clicking the Create button.
C: Establishing connection

1. The new project is displayed in WinCC Explorer.

   Installing of required communication driver. This is done using \(\text{R}\) on the Tag Management item and Add New Driver.

   ![Tag Management and Add New Driver](image)

2. The Add New Driver Dialog opens.

   It offers a selection of all communication drivers available for installation. In the current example, the OPC communication driver is required. It must be selected in the dialog. Close the dialog with Open.

   ![Add New Driver](image)

3. The newly added OPC communication driver is displayed as a subitem of tag management.

   The OPC communication driver receives a channel unit.

   Establishing a connection to a certain OPC server, as well as selection of items required from this server, may be facilitated using the OPC Item Manager. This is started using \(\text{R}\) over the entry for OPC Groups (OPCHN Unit #1) channel unit and System Parameters.

   ![OPC Groups and System Parameters](image)
C: Establishing connection

4 The OPC Item Manager opens. Here the desired OPC server may be selected. It may be located on the local computer or on another computer accessible through a network connection. In the current example, the desired OPC server is located on the local computer.

Using \( \mathbf{\text{D}} \) at the LOCAL item, all OPC servers available on the local computer are listed. Select the entry for OPC.SIMATICNET of the S7-OPC server. Using the Browse Server button, you reach a selection dialog for items made available by the S7-OPC server.

5 The Filter Criteria dialog opens. This allows you more detailed specification of the type of desired items. If you wish a display of available items, no settings need to be made here. The dialog may be concluded with Continue.
A dialog for the selection of desired items is displayed. In the current example, only DB75 is available as subitem of Group DB. Group DB75 contains the five items defined in the previous section using OPC Scout. These represent the five tags created in the PLC. The five items of DB75 may be selected in the right window. Using the Add Items button, these may be inserted into the WinCC project.

However, a new connection must be established beforehand where these items can be inserted as WinCC tags. This connection can be generated automatically by the OPC Item Manager. The New Connection dialog opens. Only the name of the new connection needs to be specified. The current example uses the name S7_OPC_01 for it. Close the dialog with OK.
**C: Establishing connection**

8 The Add Tag dialog is displayed. Here you specify which connection the tags should be added to. In the current example, they are supposed to be added to the previously created connection S7_OPC_01. This must be selected in the lower Add Here field.

The tag names used by OPC Item Manager may have optionally added a prefix and a suffix. In the current example, the tag name should be preceded by the prefix S16x_S7OPC01_.

The WinCC tags are created using the Finish button.

The dialog to select the desired items may be concluded using the Finish button. The OPC Item Manager is closed using the Finish button.

9 The following display lists WinCC tags generated by the OPC Item Manager.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>S16x_S7OPC01_DB76_INT0_1</td>
<td>5g</td>
<td>&quot;S7:S7_Connection_01\FD1CF\H1\DB76\INT0_1&quot;, &quot;&quot;</td>
</tr>
<tr>
<td>S16x_S7OPC01_DB76_INT2_1</td>
<td>5g</td>
<td>&quot;S7:S7_Connection_01\FD1CF\H1\DB76\INT2_1&quot;, &quot;&quot;</td>
</tr>
<tr>
<td>S16x_S7OPC01_DB76_INT4_1</td>
<td>5g</td>
<td>&quot;S7:S7_Connection_01\FD1CF\H1\DB76\INT4_1&quot;, &quot;&quot;</td>
</tr>
<tr>
<td>S16x_S7OPC01_DB76_INT6_1</td>
<td>5g</td>
<td>&quot;S7:S7_Connection_01\FD1CF\H1\DB76\INT6_1&quot;, &quot;&quot;</td>
</tr>
<tr>
<td>S16x_S7OPC01_DB76_INT8_1</td>
<td>5g</td>
<td>&quot;S7:S7_Connection_01\FD1CF\H1\DB76\INT8_1&quot;, &quot;&quot;</td>
</tr>
</tbody>
</table>
Aside from the procedure described in the above table for automatically creating a connection for the OPC communication driver, there is also the option of establishing this in the conventional way. The required actions are described in this step.

Creating a new connection is facilitated using \( \mathcal{R} \) over the entry for the OPC communication driver channel unit and New Connection. The Properties Connection dialog opens. Enter the name of the new connection on the General tab register. Using the Properties button, the dialog for Properties of New Connection opens.

Please make certain that the connection name does not include any national special characters or the characters $, ' or ".
In the Properties of New Connection dialog, the OPC server to be used must be specified. In the OPC Server Name field, the name of the OPC server to be used must be entered. In the field below, enter the name of the computer where the OPC server to be used is located.

Using the Test Server button, you may check whether or not a connection can be established to the desired OPC server.

Using the OK button, the new connection is created.
### Conventional configuration

3. Aside from the procedure described in the above table for automatically creating the tags, there is also the option of establishing this in the conventional way. The required actions are described in this step.

Creating a new tag is facilitated using on the entry for the respective connection, in the current example the connection S7_OPC_01 and New Tag.

The Tag Properties dialog is displayed.

Here the name of the tag and its data type must be specified. Using the Select button, its address must be specified.
D: Conventional configuration

4 The Address Properties dialog opens.
In the Item Name field, the name of the desired item in the OPC server must be specified. This name contains the address information. The syntax of this address information is explained using the first tag to be created as part of this example. Its Item Name is [S7:S7_Connection_01|VFD1|CP_H1_1:]DB75,INT0,1.
S7 specifies the used OPC server type (FMS or DP are additional available OPC servers by SIMATIC NET, for example).
S7_Connection_01 is the name of the S7 connection.
VFD1 is the VFD name (Virtual Field Device).
CP_H1_1: is the used access point.
DB75 indicates the data block number.
INT0 states whether or not this is a signed 16-bit value with a starting address of 0.
1 states that this is a single tag, as opposed to an array consisting of several tags.
Exact adherence to the required syntax is important.
### E: Creating WinCC picture

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| 1 | Creating a WinCC picture to visualize the previously created tags.
   
   To do so, open the Graphics Designer editor using \( \text{Open} \) and \( \text{Open} \).

![Graphics Designer editor](image)

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| 2 | The Graphics Designer editor is displayed. In it, a new WinCC picture is already open.
   
   Configuring a Smart object [I/O Field] to display the first tag. Select the I/O field in the object palette and place it onto the picture using the mouse.

![Object palette](image)
### E: Creating WinCC picture

3. After placement of the I/O field on the picture, its configuration dialog opens. In the Tag field, the tag S16x_S7OPC01_DB75_INT0_1 is set using the button shown in the following.

![I/O Field Configuration](image)

Tag updates are left at 2 seconds. The additional set options should retain their default values. Finish the dialog with OK.
### Project Examples

#### E: Creating WinCC picture

4. Changes of output format for I/O field.

Open its property dialog. This is done by clicking **R** on the I/O field and Properties.

5. The Object Properties dialog opens.

On the Properties tab register, select the Output/Input entry in the left window. Using **D** on the set output value will make the display field editable. Enter the new format s99999. Using this format, the I/O field is capable to display signed values with a maximum of 5 digits.

6. Creating an additional four I/O fields to display the remaining tags.

The procedure is analogous to Steps 2 to 5 as described.
### E: Creating WinCC picture

The picture must be saved. In the example project, it was saved under the name `com_3_S7OPC_01.pdl`. The picture may be switched directly from Graphics Designer into Runtime by using the button displayed in the following.

![Runtime button](image)

Once the picture is in Runtime, the PLC has been started, and the network connection has been established, the current tag values of the PLC are displayed. These may also be changed by input of values into the individual I/O fields.

![WinCC Runtime S7-OPC-Server](image)

If no connection to the PLC exists, the I/O fields are shown in gray tones. In this case, some error must exist in some part of the communication link.
3.5.6 Diagnostics of Communication Link Using OPC

The following description shows options available for diagnostics of the communication link between the WinCC project WinCC_S7_OPC and the SIMATIC S7 station.

A: WinCC Explorer

<table>
<thead>
<tr>
<th>A: WinCC Explorer</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>Diagnostics of communication link in WinCC Explorer.</td>
</tr>
<tr>
<td>Switch the WinCC_S7_OPC project into Runtime. This is done in WinCC Explorer using the toolbar button displayed in the following.</td>
</tr>
<tr>
<td><img src="activate.png" alt="Activate" /></td>
</tr>
<tr>
<td>The created WinCC picture com_3_S7OPC_01.pdl may also be switched directly from Graphics Designer into Runtime.</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>In WinCC Explorer, using the menu Tools ➔ Connection Status, a dialog may be opened to monitor all configured connections. However, this menu item is only active if the project is in Runtime.</td>
</tr>
<tr>
<td><img src="tools.png" alt="Tools" /></td>
</tr>
<tr>
<td><img src="status.png" alt="Status of Driver Connectors" /></td>
</tr>
<tr>
<td><img src="status_server.png" alt="Status of Server Connections" /></td>
</tr>
<tr>
<td><img src="status_client.png" alt="Status of Client Connections" /></td>
</tr>
</tbody>
</table>
3 The Status - Logical Connections dialog is opened. This dialog lists all configured connections. In the current example, only the connection S7_OPC_01 exists.

The displayed values correspond to the status at the moment the dialog was opened. By selecting the corresponding checkbox, a cyclic display update may also be achieved.

4 Another option to obtain information on the connection status in general but also on the connection status of individual tags is provided by Tag Management.

The status of a configured connection may be obtained as a tooltip by simply moving the mouse over it.

The current process value of a certain tag, as well as its status, may be obtained as a tooltip by simply moving the mouse over it. This procedure allows determination of errors of a single tag only, not of errors concerning the entire connection.
B: Channel Diagnosis

1 Diagnostics of communication link using the WinCC Channel Diagnosis program.
   This is started using Start → SIMATIC → WinCC → Tools → Channel Diagnosis.

2 The WinCC Channel Diagnosis program is opened.
   The Channels/Connections tab register displays exact information on the status of each configured connection. The default value for display update is one second. The update cycle may be changed in the lower input field.
3.6 Communication with SIMATIC S7 Using PROFIBUS

Projects and files to be generated in this chapter may also be loaded onto your hard disk directly from the Online Support (link "Info" on http://support.automation.siemens.com/WW/view/en/21320307).

There is the option of copying the following components to hard disk:

- **S7_PB**
  - The STEP7 project to be generated.

- **WinCC_S7_PB**
  - The WinCC project to be generated.

This chapter describes in detail the implementation of a communication link between SIMATIC S7 and WinCC. Profibus is used to implement the communication link. The CP 5613 communication processor used on the computer has its own CPU. This removes communication loads from the computer's CPU load.

**Summary on Example Design**

On the computer side, the network connection (PROFIBUS) is established using a CP 5613 communication processor.

In the WinCC project, the SIMATIC S7 Protocol Suite communication driver must be installed. Using its PROFIBUS channel unit, the connection to SIMATIC S7 is configured.

The PLC is equipped with a central module CPU 417-4. Connection to the network is established using the CP443-5 BASIC communication processor. In order to configure this communication processor with STEP7 software, the NCM S7 PROFIBUS options package is required.
Summary of Configuration Steps

The following summary lists all configuration segments necessary for establishing the communication link.

- Commissioning of CP 5613 communication processor
- Generation of STEP7 project S7_PB
- Generation of WinCC project WinCC_S7_PB
- Diagnostics of communication link

Required software

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC NET</td>
<td>Using installation from SIMATIC NET, all necessary drivers are installed.</td>
</tr>
<tr>
<td>STEP7</td>
<td>STEP7 Software with option package NCM for PROFIBUS to generate the STEP7 project.</td>
</tr>
<tr>
<td>WinCC</td>
<td>WinCC with SIMATIC S7 Protocol Suite communication driver to generate the WinCC project.</td>
</tr>
</tbody>
</table>

Required hardware on computer

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Processor</td>
<td>Communication processor CP 5613 to establish connection to communication processor in PLC.</td>
</tr>
</tbody>
</table>

Required hardware in the PLC

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack</td>
<td>Module support UR1.</td>
</tr>
<tr>
<td>Power supply unit</td>
<td>Power supply unit PS 407 20A in slots 1 to 3.</td>
</tr>
<tr>
<td>Central module</td>
<td>Central module CPU 417-4 in slot 4.</td>
</tr>
<tr>
<td>Communication Processor</td>
<td>Communication processor CP 443-5 BASIC in slot 7.</td>
</tr>
</tbody>
</table>
3.6.1 Commissioning of CP 5613 Communication Processor

The following description shows detailed configuration steps necessary for successful commissioning of the CP 5613 communication processor. It is assumed that the communication processor was previously installed.

Summary of Configuration Steps

The following is a summary list of all necessary configuration steps for implementing the communication processor CP 5613.

- A: Assembly of communication processor in computer
- B: Assigning communication processor
- C: Testing of communication processor

A: Configuration of communication processor

1. In Program Start ➔ SIMATIC ➔ SIMATIC NET ➔ Settings ➔ "Setting PC station", the communication processor may be configured. In menu "General", the module operation mode must be set to PG Operation.
A: Configuration of communication processor

2 The Profibus address as well as network parameters may only be changed in PG operation. In the current example, the address was set to 3. The transmission rate is set to 1.5 Mbit/s. Changes are saved by pushing the Apply button.

3 In the General menu, the operation mode of the module is set to Configured Mode. This change leads to a display of the Index and Module Name fields. In the example, the index is set to 1 and the module name to CP 5613. The changes are saved using the Apply button. The displayed note may be confirmed by clicking OK.
B: Assigning communication processor

1. In Program Start, SIMATIC, SIMATIC NET, Settings, "Setting PC Station", the just installed interface must be assigned to the access point CP_L2_1:

   The access point CP_L2_1: is the default access point used for PROFIBUS communication in WinCC. It was created automatically during installation of SIMATIC NET.

   ![Configuration Console](image)

   - In the upper field, select the CP5613 (PROFIBUS) entry by using the pull-down menu. This concludes the assignment between access point and communication processor.

2. In the Access Point folder, the entry CP_L2_1: must be selected as follows. In the upper field, select the CP5613 (PROFIBUS) entry by using the pull-down menu. This concludes the assignment between access point and communication processor.

   ![CP_L2_1 Properties](image)

   - If you change an access point of a PROFIBUS module to another interface parameter assignment of the same module, all other access points that point to the old interface parameter assignment will be remapped to the new interface parameter assignment.
C: Testing of communication processor

1 Testing the proper installation of the CP 5613 communication processor using the "Setting PC Station" program.

In order to perform network diagnostics, the Network Diagnostics folder must be selected in the respective module. In our case it is module CP 5613.

On the right side, the Network Diagnostics PROFIBUS Parameter window is displayed. Here you may check station address and bus parameters.
C: Testing of communication processor

In order to check if all bus participants are connected using the Profibus, the Bus Participant menu item must be selected. If no SIMATIC has been connected to the Bus yet, only the CP 5613 communication processor is recognized.

If diagnostics yields a negative result, the cause of the error must be found and the error must be corrected. Some tools and tips on this subject are described in chapter "Is the computer's communication module operable?". This test may also be performed using the "Setting PG/PC Interface" program, however, the "PG Operation" operation mode is required to do so.
3.6.2 Creating STEP7 Project S7_PB

The following description shows in detail the necessary configuration steps for creating and commissioning of STEP7 project S7_PB.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the STEP7 project S7_PB.

- A: Installation of hardware
- B: Creating STEP7 project
- C: Configuring hardware for SIMATIC PC station
- D: Loading hardware configuration for SIMATIC PC station
- E: Configuring hardware for SIMATIC 400
- F: Loading hardware configuration for SIMATIC 400
- G: Testing of hardware configuration
- H: Creating STEP7 program
- I: Testing of STEP7 program

A: Installation of hardware

<table>
<thead>
<tr>
<th></th>
<th>A: Installation of hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Assemble the used modules on the module supports.</td>
</tr>
<tr>
<td></td>
<td>In the current example, these are a power supply unit PS 407 20A,</td>
</tr>
<tr>
<td></td>
<td>a central module CPU 417-4, as well as a communication processor</td>
</tr>
<tr>
<td></td>
<td>CP 443-5 BASIC.</td>
</tr>
<tr>
<td></td>
<td>Establish the connection between programming device and programming</td>
</tr>
<tr>
<td></td>
<td>interface of the central module.</td>
</tr>
<tr>
<td></td>
<td>Establish the connection between the computer's communication</td>
</tr>
<tr>
<td></td>
<td>processor CP 5613 to communication processor CP 443-5 BASIC</td>
</tr>
<tr>
<td></td>
<td>in the PLC.</td>
</tr>
</tbody>
</table>
### B: Creating STEP7 project

<table>
<thead>
<tr>
<th></th>
<th>Creating a new STEP7 project in SIMATIC Manager.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>This is started using Start → SIMATIC → SIMATIC Manager.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="SIMATIC Manager" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>The SIMATIC Manager opens.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Using menu item File → New, the dialog to specify parameters of a new STEP7 project opens.</td>
</tr>
<tr>
<td></td>
<td>Enter the name of the newly created project in the Name field. Names of STEP7 projects created as part of this manual must start with the character sequence S7. Furthermore, they contain a description of the communication type used. The current example has the name S7_PB.</td>
</tr>
<tr>
<td></td>
<td>By default, projects are saved in directory C:\PROGRAM FILES\SIEMENS\STEP7\S7proj. However, this may be changed at any time by clicking the Browse button.</td>
</tr>
<tr>
<td></td>
<td>The New dialog is closed by clicking the OK button</td>
</tr>
</tbody>
</table>

![New Project dialog](image)
### C: Configuring hardware for SIMATIC PC station

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td>The new project is displayed in SIMATIC Manager. Hardware must be configured for it. Three components are needed. These are one SIMATIC 400 station as well as one SIMATIC PC station. Furthermore, for their network links, one Profibus is required. These components are obtained in SIMATIC Manager using <strong>Insert New Project</strong> on the name of project S7_PB and <strong>Insert New Object</strong> → SIMATIC 400 station, <strong>Insert New Object</strong> → SIMATIC PC station as well as <strong>Insert New Object</strong> → Profibus.</td>
</tr>
<tr>
<td></td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
</tbody>
</table>

**Insert New Object**
- Cut: Ctrl+X
- Copy: Ctrl+C
- Paste: Ctrl+V
- Delete: Del

**SIMATIC 400 Station**
- SIMATIC 300 Station
- SIMATIC H Station
- SIMATIC PC Station
- Other station
- SIMATIC 55
- PG/PC
- MPI
- PROFIBUS
- Industrial Ethernet
- PTP
- S7 Program
- M7 Program

| **2** | The two components just added are displayed in the right window of SIMATIC Manager. Using **Insert New Object** on component SIMATIC PC Station(1) in the right window will display the Hardware item. Using **Open Object** on the Hardware item or **Ctrl+Alt+O** and Open Object on it will start the HWConfig program. |
|   | ![Image](image2.png) |

**Hardware**
- Cut: Ctrl+X
- Copy: Ctrl+C
- Paste: Ctrl+V
- Delete: Del
- Rename: F2

---

*WinCC Communication Manual V6*
Edition 12/2004, 6AV6392-1CA06-0AB0
C: Configuring hardware for SIMATIC PC station

3 In order to enable a connection to the configured PC station later on, the name of the PC station must agree with the name in Station Configuration Editor.

The Station Configuration Editor is started using Start → Station Configuration Editor.

In the example, the PC station is named SIMATIC PC Station(1).

4 The HWConfig program opens.

It is used to exactly specify the hardware used in the PLC, and to configure its properties.

5 Using the subsequently displayed button in the toolbar of HWConfig program, the hardware catalog opens. This is used to select the required hardware components.
C: Configuring hardware for SIMATIC PC station

6

The hardware catalog and the presently still vacant PC module rack are displayed.

All components to be used must be installed on the module rack. The first component to be selected is the communication processor. This uses Drag&Drop for the component from the hardware catalog into its slot 1 in the module rack.
C: Configuring hardware for SIMATIC PC station

7 After inserting CP 5613, the property dialog of the Profibus interface for CP 5613 opens.

Use the Parameter tab register in the address field to set the desired Profibus address of the communication processor.

Use the lower selection field Subnet to assign the entry PROFIBUS(1) to the communication processor. Close the dialog with OK.

8 Furthermore, insert an application into slot 2 of the module rack using Drag&Drop. In the following, the fully configured hardware design of the example is shown.

9 Settings now made must be saved in program HWConfig and must be compiled. This is done using the toolbar button displayed in the following.
D: Loading hardware configuration for SIMATIC PC station

1. Loading of the hardware configuration uses the toolbar button of the HWConfig program shown in the following.

   ![Download to Module]

2. A dialog opens which allows selection of components to be loaded. In the current example, all selectable components must be marked. Close the dialog with OK.
3  The Select Node Address dialog is displayed. On the configuration side (STEP7), the station manager represents the configuration of the entire SIMATIC PC station. Close the dialog with OK.

[Image of the Select node address dialog]

- **Rack:** 0
- **Slot:** 125
- **Local Target Station:**
- **Can be reached by means of gateway:**
- **Enter connection to target station:**
  - **Index:** 125
  - **Module type:**
  - **Station name:**
  - **CPU name:**
  - **Plant designation:**
- **Accessible Nodes:**

[Buttons: OK, Cancel, Help]
Configuration data are now transferred to the PLC. Individual modules may have to be put into the STOP status. The HWConfig program may be terminated. Components newly added are displayed in SIMATIC Manager for SIMATIC 400(1).
E: Configuring hardware for SIMATIC 4001

1. Using (D on component SIMATIC 400(1) in the right window will display the Hardware item. Using (D on the Hardware item or (R and Open Object on it will start the HWConfig program.

   ![Hardware](image)

   **Open Object**: Ctrl+Alt+O
   - Cut: Ctrl+X
   - Copy: Ctrl+C
   - Paste: Ctrl+V
   - Delete: Del
   - Rename: F2

2. The HWConfig program opens.
   It is used to exactly specify the hardware used in the PLC, and to configure its properties.

3. Using the subsequently displayed button in the toolbar of HWConfig program, the hardware catalog opens. This is used to select the required hardware components.

   ![Catalog](image)
The hardware catalog opens.

The first component to be selected is the module support used. All additional components are to be installed on it. The module support used is inserted into the project using Drag & Drop. The example uses module support of type UR1.
### E: Configuring hardware for SIMATIC 4001

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>The HWConfig program displays the presently still empty module support. It has been assigned to rack number 0. In configuring the connection in the WinCC project, the rack number is one of the parameters to be set.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Module Support" /></td>
</tr>
</tbody>
</table>
| 6 | Arrangement of additional hardware components in module support. This uses Drag&Drop for the desired components from the hardware catalog in their respective slots in the module support.  
   The example uses a power supply unit PS 407 20A. This is inserted in slot 1. A power supply unit of this type uses two slots.  
   The example uses a CPU 417-4 as central module. This is inserted in slot 4. In configuring the connection in the WinCC project, the slot number of the central module is an additional parameter to be set.  
   Furthermore, a CP 443-5 BASIC communication processor is needed. However, this is available from the hardware catalog only if the NCM S7 PROFIBUS option package has been installed. Once the CP 443-5 BASIC communication processor is inserted into the module support, its properties dialog opens. |
E: Configuring hardware for SIMATIC 4001

The property dialog of the PROFIBUS interface of CP 443-5 BASIC is displayed.
Use the Parameter tab register in the address field to set the desired address of the communication processor. The current example specifies this as 14. In configuring the connection in the WinCC project, this station address is an additional parameter to be set.
Use the lower selection field Subnet to assign the entry PROFIBUS(1) to the communication processor.
Specify properties of PROFIBUS(1). Its Properties dialog opens by clicking the Properties button.
8 The Properties - PROFIBUS dialog opens.
Specify properties of the PROFIBUS network using the Network Settings tab register. Use the same network settings as during installation of communication processor CP 5613.

The example uses a transmission rate of 1.5 Mbit/s for the PROFIBUS network. The highest PROFIBUS address is left on 126, the maximum value to be set. Use Universal (DP/FMS) as the profile.

Close the dialog by clicking OK. The Properties dialog of the PROFIBUS interface of CP 443-5 BASIC is also closed by clicking OK.

9 In the following, the fully configured hardware design of the example is shown.
## E: Configuring hardware for SIMATIC 4001

<table>
<thead>
<tr>
<th>10</th>
<th>Settings made now must be saved in program HWConfig and must be compiled. This is done using the toolbar button displayed in the following.</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button Image]</td>
<td>![Button Image] Save and Compile</td>
</tr>
</tbody>
</table>
F: Loading of hardware configuration

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The hardware configuration created in program HWConfig must be transferred to the PLC. This is done using the toolbar button displayed in the following.</td>
</tr>
</tbody>
</table>
|   | ![Download to Module](image)
| 2 | A dialog opens which allows selection of components to be loaded. In the current example, all selectable components must be marked. Please make sure that any loading of the central module is possible only in operational switch positions STOP or RUN-P. Close the dialog with OK. |

![Select Target Module](image)
3 The Select Node Address dialog opens. Here you state which node address is used for communication between STEP7 software and central module. The address of the central module is 4.

Close the dialog with OK.
F: Loading of hardware configuration

4 Configuration data are now transferred to the PLC. Individual modules may have to be put into the STOP status. The HWConfig program may be terminated. Components newly added are displayed in SIMATIC Manager for SIMATIC 400(1).
G: Testing of hardware configuration

<table>
<thead>
<tr>
<th></th>
<th>G: Testing of hardware configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Testing of hardware configuration decision</td>
</tr>
<tr>
<td></td>
<td>If the key switch of the central module is put into RUN or RUN-P position, and the operational switch of the communication processor is put into RUN position, only status LEDs indicating the RUN state should be lit.</td>
</tr>
<tr>
<td></td>
<td>If this is not the case, an error has occurred. This error may be determined using the steps described in the following. However, these step should also be implemented even if no error is indicated by the status LEDs. This will allow to recognize non-critical errors and faulty configurations.</td>
</tr>
</tbody>
</table>
G: Testing of hardware configuration

Testing of configuration in central module.
This uses the Module Information dialog in SIMATIC Manager. This dialog is opened using "R on the entry of the central module in the left window and Target System → Diagnostics/Settings → Module Information.
The General tab register displays various general data of the central module. The Status field will display the current Module Information as well as existing errors, if any.
The Diagnostic Buffer tab register display detailed information on existing errors and their correction.
The dialog is closed by clicking the Close button.
G: Testing of hardware configuration

Testing of communication processor configuration. This uses the Module Information dialog in SIMATIC Manager. This dialog is opened using on the entry of the central module in the left window and Target System ➔ Diagnostics/Settings ➔ Module Information. The General tab register displays various general data of the module.

A dialog for more detailed diagnostics of the communication processor may be opened using the Special Diagnostics button.
1 Creating STEP7 program

For the current example project, only one operations block, OB1, and one data block are needed. OB1 is available by default. The needed data block must first be created. This is done in SIMATIC Manager using Add New Object -> Data Block.

The property dialog of the data block opens. Enter DB75 as the name for the block and close the dialog by clicking OK.
### H: Creating STEP7 program

2 The newly created data block DB75 is displayed in the right window of the project.

Using \( \text{Ctrl} + \text{D} \) or using \( \text{Ctrl} + \text{R} \) and Open Object, the contents of the block may be programmed. The program KOP/AWL/FUP is started.

<table>
<thead>
<tr>
<th>Open Object</th>
<th>Ctrl+Alt+O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
</tr>
<tr>
<td>Insert New Object</td>
<td></td>
</tr>
<tr>
<td>PLC</td>
<td></td>
</tr>
<tr>
<td>Compare Blocks...</td>
<td>Reference Data</td>
</tr>
<tr>
<td>Print</td>
<td></td>
</tr>
<tr>
<td>Rename</td>
<td>F2</td>
</tr>
<tr>
<td>Object Properties...</td>
<td>Alt+Return</td>
</tr>
<tr>
<td>Special Object Properties</td>
<td></td>
</tr>
</tbody>
</table>

3 The program KOP/AWL/FUP opens.

The New Data Block dialog appears and must be acknowledged by clicking OK.
**H: Creating STEP7 program**

4 Programming of DB75.

Here, two tags of length 16 bits are created. Their sum is supposed to be determined in OB1 and written to another tag of length 16 bits.

Furthermore, two tags of length 16 bits are created, whose values are to be cyclically incremented in OB1.

The following shows the completely programmed data block DB75.

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Type</th>
<th>Initial value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>Var_01</td>
<td>WORD</td>
<td>U#1S#0</td>
<td>Value 1</td>
</tr>
<tr>
<td>+2.0</td>
<td>Var_02</td>
<td>WORD</td>
<td>U#1S#0</td>
<td>Value 2</td>
</tr>
<tr>
<td>+4.0</td>
<td>Var_03</td>
<td>WORD</td>
<td>U#1S#0</td>
<td>Suma</td>
</tr>
<tr>
<td>+6.0</td>
<td>Var_04</td>
<td>WORD</td>
<td>U#1S#0</td>
<td>Inc 1</td>
</tr>
<tr>
<td>+8.0</td>
<td>Var_05</td>
<td>WORD</td>
<td>U#1S#0</td>
<td>Inc 2</td>
</tr>
</tbody>
</table>

5 The data block must be saved. Furthermore, it must be loaded onto the PLC. This is done using the toolbar button displayed in the following. Please make sure that any loading of the central module is possible only in operational switch positions STOP or RUN-P.

6 Programming of OB1.

This must be opened beforehand in program KOP/AWL/FUP.

Initially, two values created in DB75 are added and the result is again saved in DB75.

**Netzwerk 1: Addition**

Adding two 16-Bit Values

The result is stored in another 16-Bit Value

<table>
<thead>
<tr>
<th>OPN</th>
<th>DB</th>
<th>DBW</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>DBW</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>DBW</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>+I</td>
<td>DBW</td>
<td>4</td>
<td></td>
</tr>
</tbody>
</table>
### H: Creating STEP7 program

Next, the count of a value created in DB75 is implemented every second.

#### Network 2: Second Cycle

**Generation of a second cycle at M 0.0**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AN</strong></td>
<td><strong>M</strong></td>
<td><strong>0.0</strong></td>
</tr>
<tr>
<td><strong>L</strong></td>
<td><strong>%T#18</strong></td>
<td><strong>1</strong></td>
</tr>
<tr>
<td><strong>SD</strong></td>
<td><strong>T</strong></td>
<td><strong>1</strong></td>
</tr>
<tr>
<td><strong>A</strong></td>
<td><strong>T</strong></td>
<td><strong>0.0</strong></td>
</tr>
</tbody>
</table>

#### Network 3: Counting in a second cycle

**Counting a value in a second cycle**

**At 10000, reset to 0**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AN</strong></td>
<td><strong>M</strong></td>
<td><strong>0.0</strong></td>
</tr>
<tr>
<td><strong>JC</strong></td>
<td><strong>M001</strong></td>
<td></td>
</tr>
<tr>
<td><strong>L</strong></td>
<td><strong>DBW</strong></td>
<td><strong>6</strong></td>
</tr>
<tr>
<td><strong>L</strong></td>
<td><strong>1</strong></td>
<td></td>
</tr>
<tr>
<td><strong>+I</strong></td>
<td><strong>T</strong></td>
<td><strong>DBW</strong></td>
</tr>
<tr>
<td><strong>L</strong></td>
<td><strong>10000</strong></td>
<td></td>
</tr>
<tr>
<td><strong>&lt;I</strong></td>
<td><strong>JC</strong></td>
<td><strong>M001</strong></td>
</tr>
<tr>
<td><strong>L</strong></td>
<td><strong>0</strong></td>
<td></td>
</tr>
<tr>
<td><strong>T</strong></td>
<td><strong>DBW</strong></td>
<td><strong>6</strong></td>
</tr>
</tbody>
</table>

**M001: NOP 0**

Next, the count of a value created in DB75 is implemented for each run of OB1.

#### Network 4: Counting in the cycle time

**Counting a value each time the OB is executed**

**At 10000, reset to 0**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>L</strong></td>
<td><strong>DBW</strong></td>
<td><strong>8</strong></td>
</tr>
<tr>
<td><strong>L</strong></td>
<td><strong>1</strong></td>
<td></td>
</tr>
<tr>
<td><strong>+I</strong></td>
<td><strong>T</strong></td>
<td><strong>DBW</strong></td>
</tr>
<tr>
<td><strong>L</strong></td>
<td><strong>10000</strong></td>
<td></td>
</tr>
<tr>
<td><strong>&lt;I</strong></td>
<td><strong>JC</strong></td>
<td><strong>M002</strong></td>
</tr>
<tr>
<td><strong>L</strong></td>
<td><strong>0</strong></td>
<td></td>
</tr>
<tr>
<td><strong>T</strong></td>
<td><strong>DBW</strong></td>
<td><strong>8</strong></td>
</tr>
</tbody>
</table>

**M002: NOP 0**

7 The OB1 block must be saved and loaded onto the PLC. This is done using the respective toolbar button.

Thus, the STEP7 project is complete and ready to run. The KOP/AWL/FUP program may be terminated.
I: Testing of STEP7 program

1 Testing of program using STEP7 software.

A tag table is created for this. This is done in SIMATIC Manager using the entry of the configured central module and Target System Monitor / Modify Tag.

2 An editor is displayed to create and use such a tag table.

In the following, the complete tag table is shown. All tags created in DB75 are entered.
### I: Testing of STEP7 program

3. Monitoring current tag values.
   By clicking the toolbar button shown in the following, the current values of respective tags in the PLC are displayed in the Status Value column.

   ![Monitor variable](image)

   Controlling of tag values.
   In the Control Value column, values may be entered. By clicking the toolbar button displayed in the following, these values are written to the corresponding tags in the PLC.

   ![Modify variable](image)

   Please make sure that any controlling of tags is possible only in operational switch position RUN-P.

4. The so-created tag table may now be saved.
   In the current example, it is saved under the name VAT1. If the program function in the PLC has now been checked, the tag table may be closed.
   Thus, configuration of the STEP7 project is complete and SIMATIC Manager may be terminated.

   ![VAT1](image)
3.6.3 Creating WinCC Project WinCC_S7_PB

The following description shows in detail the necessary configuration steps for creating and commissioning of WinCC project S7_PB.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the WinCC project S7_PB.

- A: Creating WinCC project
- B: Establishing connection
- C: Creating WinCC tags
- D: Creating WinCC picture
## A: Creating WinCC project

<table>
<thead>
<tr>
<th></th>
<th>A: Creating WinCC project</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creating a new WinCC project in WinCC Explorer.</td>
</tr>
<tr>
<td></td>
<td>This is started using Start → SIMATIC → WinCC → Windows</td>
</tr>
<tr>
<td></td>
<td>Control Center.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="WinCC Explorer" /></td>
</tr>
<tr>
<td>2</td>
<td>WinCC Explorer is opened.</td>
</tr>
<tr>
<td></td>
<td>Using menu item File → New, the dialog to specify the properties of a new WinCC project opens.</td>
</tr>
<tr>
<td></td>
<td>The following example project creates a single-user project.</td>
</tr>
<tr>
<td></td>
<td>Finish the dialog with OK.</td>
</tr>
</tbody>
</table>
A: Creating WinCC project

3 The Create a New Project dialog opens. Enter a project name for the new project. WinCC projects created as part of this manual begin with a character sequence of WinCC, and furthermore contain a description of communication partners, as well as communication type used. The current example has the name WinCC_S7_PB.

Furthermore, in the Project Path field, the storage location of the new project must be set.

The Create a New Project dialog is closed by clicking the Create button.
### B: Establishing connection

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td>The new project is displayed in WinCC Explorer. Installing of required communication driver. This is done by clicking on the Tag management item and Add New Driver.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>2</strong></td>
<td>The Add New Driver Dialog opens. It offers a selection of all communication drivers available for installation. For communication with SIMATIC S7, the SIMATIC S7 Protocol Suite driver is required. It must be selected in the dialog. Close the dialog with Open.</td>
</tr>
</tbody>
</table>

---

#### Add new driver

- **Look in:** bin
- **File name:** SIMATIC S7 Protocol Suite.chn
- **Files of type:** WinCC Communication Driver (*.chn)
- **Open** button
- **Cancel** button
The newly added driver SIMATIC S7 Protocol Suite displays as a subitem of Tag Management.

The driver contains nine different channel units. In order to operate two CP 5613 communication processors on a computer, two channel units are available for PROFIBUS.

The current example uses the PROFIBUS channel unit. A new connection must be created for it. This is done using \( \text{New Driver Connection...} \) on the PROFIBUS and New Connection entry.
B: Establishing connection

4 The property dialog of the connection opens. Enter the name of the new connection on the General tab register. It is S7_PB_01 in the current example. Specify connection parameters using the Properties button.
B: Establishing connection

5 The Connection Parameter dialog opens. Enter the address set for the CP 443-5 BASIC communication processor in the address field. In the current example, this is the address 14.

Furthermore, Rack Number as well as Slot Number of the central module to be addressed must be entered. Please make sure that values for the central module and not those of the communication processor are entered here.

Close the dialog with OK.
B: Establishing connection

6 Setting of system parameters for PROFIBUS channel unit.

This setting uses the System Parameters dialog which opens using \( \mathcal{F} \) on the PROFIBUS and System Parameters entry.

On the Channel tab register, different settings for communication and communication monitoring may be specified. However, these do not apply to all channel units of the communication driver.

![System Parameter - PROFIBUS dialog box](image)
### B: Establishing connection

7 On the Unit tab register, it must be specified which access point the connection to the PLC should use. Default setting is access point CP_L2_1: . The access point CP_L2_1: was assigned the CP 5613 communication processor in the Setting PG/PC Interface program. If this access point is supposed to be set automatically, it must be checked whether or not the correct one is used, especially when using multiple communication processors. Close the dialog with OK.

![System Parameter - PROFIBUS](image)

- **CP-Type/Bus Profile**: PROFIBUS
- **Logical device name**: CP_L2_1
- **Set automatically**: 

Enter a new device name or select the requested device from the list.
C: Creating WinCC tags

Creating WinCC tags required for example.

This is done by clicking on the entry for the newly created connection S7_PB_01 and New Tag.
C: Creating WinCC tags

2 The property dialog of the tag is displayed.
The example uses S16x_S7PB01_01 as the name for the first tag. The tag
is of data type Signed 16-Bit Value. Using the Select button, the address
of the new tag is set.
C: Creating WinCC tags

3 The Address Properties dialog is displayed. Enter DB as data range and the value 75 as DB No. In the Address field, set Word and set the value to 0 in the DBW field. Finish the dialog with OK. The Property dialog of the tag is also closed by clicking OK. The just created tag has been addressed to the area of the PLC where the first of the two values to be added is located.

4 Creating the remaining required WinCC tags.

The procedure is analogous to Steps 1 to 3 as described. Names, data types, and addresses of tags used in this example may be obtained from the following display.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>S16x_S7PB01_01</td>
<td>Signed 16-bit value</td>
<td>D875,DW0</td>
</tr>
<tr>
<td>S16x_S7PB01_02</td>
<td>Signed 16-bit value</td>
<td>D875,DW2</td>
</tr>
<tr>
<td>S16x_S7PB01_03</td>
<td>Signed 16-bit value</td>
<td>D875,DW4</td>
</tr>
<tr>
<td>S16x_S7PB01_04</td>
<td>Signed 16-bit value</td>
<td>D875,DW6</td>
</tr>
<tr>
<td>S16x_S7PB01_05</td>
<td>Signed 16-bit value</td>
<td>D875,DW8</td>
</tr>
</tbody>
</table>
Project Examples

D: Creating WinCC picture

<table>
<thead>
<tr>
<th></th>
<th>Creating WinCC picture</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creating a WinCC picture to visualize the previously created tags. To do so, open the Graphics Designer editor using <img src="image" alt="Open" /> and Open.</td>
</tr>
<tr>
<td>2</td>
<td>The Graphics Designer editor is displayed. In it, a new WinCC picture is already open. Configuring a Smart object <img src="image" alt="Object Palette" /> I/O Field to display the first tag. Select the I/O field in the object palette and place it onto the picture using the mouse.</td>
</tr>
</tbody>
</table>
D: Creating WinCC picture

3 After placement of the I/O field on the picture, its configuration dialog opens. In the Tag field, the tag S16x_S7PB01_01 is set using the button shown in the following.

Tag updates are left at 2 seconds. The additional set options should retain their default values. Finish the dialog with OK.
D: Creating WinCC picture

4 Changes of output format for I/O field.

Open its property dialog. This is done by clicking on the I/O field and Properties.

5 The Object Properties dialog is displayed. On the Properties tab register, select the Output/Input entry in the left window. Using on the set output value will make the display field editable. Enter the new format $99999$. Using this format, the I/O field is capable to display signed values with a maximum of 5 digits.

6 Creating an additional four I/O fields to display the remaining tags. The procedure is analogous to Steps 2 to 5 as described.
D: Creating WinCC picture

The picture must be saved.

In the example project, it was saved under the name com_S7PB_01.pdl. The picture may be switched directly from Graphics Designer into Runtime by using the button displayed in the following.

Once the picture is in Runtime, the PLC has been started, and the network connection has been established, the current tag values of the PLC are displayed. These may also be changed by input of values into the individual I/O fields.

If no connection to the PLC exists, the I/O fields are shown in gray tones. In this case, some error must exist in some part of the communication link.
3.6.4 Diagnostics of Communication Link Using PROFIBUS

The following description shows options available for diagnostics of the communication link between the WinCC project WinCC_S7_PB and the SIMATIC S7 station.

Diagnostics of an example in accordance with the following description is only meaningful if the following checks listed have successfully been concluded.

- Testing of communication processor
- Testing of hardware configuration
- Testing of STEP7 program
### A: WinCC Explorer

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| 1 | Diagnostics of communication link in WinCC Explorer.  
Switch the WinCC_S7_PB project into Runtime. This is done in WinCC Explorer using the toolbar button displayed in the following.  
The created WinCC picture com_S7PB_01.pdl may also be switched directly from Graphics Designer into Runtime. |
| 2 | In WinCC Explorer, using the menu Tools ➔ Status of Driver Connections, a dialog may be opened to monitor all configured connections. However, this menu item is only active if the project is in Runtime.  
Tools  
Language...  
Status of Driver Connections  
Status of Server Connections  
Status of Client Connections |
| 3 | The Status - Logical Connections dialog is opened.  
This dialog lists all configured connections. In the current example, only the connection S7_PB_01 exists.  
The displayed values correspond to the status at the moment the dialog was opened. By selecting the corresponding checkbox, a cyclic display update may also be achieved.  
Status - Logical Connections  
<table>
<thead>
<tr>
<th>Tag ID</th>
<th>Name</th>
<th>Status</th>
<th>Tag Read</th>
<th>Read req</th>
<th>Tag Write</th>
<th>Write req</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>S7_PB_01</td>
<td>OK</td>
<td>3555</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
A: WinCC Explorer

Another option to obtain information on the connection status in general but also on the connection status of individual tags is provided by Tag Management.

The status of a configured connection may be obtained as a tooltip by simply moving the mouse over it.

<table>
<thead>
<tr>
<th>Name</th>
<th>Parameters</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7_P8_01</td>
<td>L2,14 0,0,0,02</td>
<td>20</td>
</tr>
</tbody>
</table>

Status: OK

The current process value of a certain tag, as well as its status, may be obtained as a tooltip by simply moving the mouse over it. This procedure allows determination of errors of a single tag only, not of errors concerning the entire connection.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Parameters</th>
<th>Last Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>S16x_S7P801_01</td>
<td>Signed 16-bit value</td>
<td>DB75,0W0</td>
<td>2/2/2005...</td>
</tr>
</tbody>
</table>

Process value: 0
Quality: c3
Last Change: 2/2/2005 2:38:15 PM
B: Channel Diagnosis

1. Diagnostics of communication link using the WinCC Channel Diagnosis program.
   This is started using Start ➔ SIMATIC ➔ WinCC ➔ Tools ➔ Channel Diagnosis.

2. The WinCC Channel Diagnosis program is opened.
   The Channels/Connections tab register displays exact information on the status of each configured connection. The default value for display update is one second. The update cycle may be changed in the lower input field.

3. In case a connection problem exists, the right window will display in the Error Code line a value indicating a more specific cause of the problem. More detailed information on error codes may be obtained by clicking R on the Error Code entry.
   This will display a description of the respective error code. Furthermore, possible error causes are displayed.

**Error 7001 - CEC_STPCHK**

Communication aborted due to stop check.
- The connection was aborted by the channel because a VMD state of the CPU - STOP, HOLD or DEFECTIVE - was detected.
3.7 Redundant Communication with SIMATIC Highly Available Through CP 1613

Projects and files to be generated in this chapter may also be loaded onto your hard disk directly from the Online Support (link "Info" on http://support.automation.siemens.com/WW/view/en/21320307).

There is the option of copying the following components to hard disk:

- **S7_Redundancy**
  The STEP7 project to be generated.

- **WinCC_Redundancy**
  The WinCC project to be generated.

This chapter describes in detail commissioning of an H Station and commissioning of the communication link to a WinCC Station. The communication link is implemented by using the redundant Industrial Ethernet.

**Summary on Example Design**

On the computer side, the Ethernet network connection is established using a CP 1613 communication processor.

Both PLCs SIMATIC S7 are equipped with a central module CPU 417-4 H.
Connection to the network is established using two CP443-1 communication processors. SIMATIC NET software must be installed to configure these communication processors.
Summary of Configuration Steps

The following summary lists all configuration segments necessary for establishing the communication link.

- Commissioning of CP 1613 communication processor
- Generation of STEP7 project S7_Redundancy
- Generation of WinCC project WinCC_S7_Redundancy
- Diagnostics of communication link

Required software

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC NET</td>
<td>Using the installation from SIMATIC NET, all drivers are installed.</td>
</tr>
<tr>
<td>STEP7</td>
<td>STEP7 Software with option package NCM for Industrial Ethernet to generate the STEP7 project.</td>
</tr>
<tr>
<td>WinCC</td>
<td>WinCC with SIMATIC S7 Protocol Suite communication driver to generate the WinCC project.</td>
</tr>
</tbody>
</table>

Required hardware on computer

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Processor</td>
<td>Two communication processors CP 1613 to establish connection to communication processor in PLC.</td>
</tr>
</tbody>
</table>

Required hardware in the PLC

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack</td>
<td>Module rack UR-H.</td>
</tr>
<tr>
<td>Power supply unit</td>
<td>Power supply unit PS 407-4.</td>
</tr>
<tr>
<td>Central module</td>
<td>Central module CPU 417-4.</td>
</tr>
<tr>
<td>Communication Processor</td>
<td>Communication processor CP 443-1.</td>
</tr>
</tbody>
</table>
3.7.1 Commissioning of CP 1613 Communication Processor

The following description shows detailed configuration steps necessary for successful installation of the CP 1613 communication processor. It is assumed that SIMATIC NET is already installed on your configuration computer. Furthermore, it is assumed that the communication processor was previously installed.

Summary of Configuration Steps

The following is a summary list of all necessary configuration steps for commissioning of the CP 1613 communication processor.

- A: Configuration of communication processor
- B: Assigning of access point
- C: Testing of communication processor
A: Configuration of communication processor

1 In Program Start ➔ SIMATIC ➔ SIMATIC NET ➔ Settings ➔ “Setting PC station”, the communication processor may be configured. In menu "General", the module operation mode must be set to PG Operation.
A: Configuration of communication processor

2 In the "Address" menu, the MAC and IP addresses of CP 1613 may be changed. This can only be done in PG Operation. For example, the MAC address is specified as 08.00.06.D.98.78.

The Ethernet address is six bytes long and is structured in Siemens devices as follows:
08.00.06: The first six numbers of the hexadecimal value correspond to the number for SIEMENS.
6D: The next two numbers specify the area at SIEMENS.
9: The next number identifies the SIMATIC system.
8.78: The last three numbers correspond to the significant station address of a SIEMENS device.

3 Settings in the Address menu are saved after changes were made by clicking the Apply button.

A dialog is displayed which requests a restart of CP 1613. Confirm this dialog with OK to restart the CP 1613 communication processor.
A: Configuration of communication processor

4 In the General menu, the operation mode of the module is set to Configured Mode. This change leads to a display of the Index and Module Name fields. In the example, the index is set to 1 and the module name to CP 1613. The changes are saved using the Apply button. The displayed note may be confirmed by clicking OK.
B: Assigning of access point

1. In Program Start ➔ SIMATIC ➔ SIMATIC NET ➔ Settings ➔ “Setting PC Station”, the just installed communication processor must be assigned the access point CP_H1_1:.

The access point CP_H1_1: is the default access point used for TCP/IP communication in WinCC. It was created automatically during installation of SIMATIC NET.

2. In the Access Points folder, the CP-TCPIP entry: must be selected as .

In the upper field, select the CP1613(RFC1006) entry by using the pull-down menu. This concludes the assignment between access point and communication processor.
C: Testing of communication processor

1. Testing the proper installation of the CP 1613 communication processor using the "Setting PC Station" program.

This is started by clicking Start → SIMATIC → SIMATIC NET → Settings → Setting PC Station.

In order to test the protocols, select the "Protocol" folder of the respective module. In our case it is module CP 1613.

On the right side of the window, the CP 1613 Industrial Ethernet dialog is displayed.

2. Testing of proper installation used the "Test" buttons.

Upon successfully tested protocols, a dialog is displayed as follows.
3 In order to check the Send/Receive function, open the directory SR Test. Again, in order to test, operate the buttons.

4 If diagnostics yields a negative result, the cause of the error must be found, and the error must be corrected. Some tools and tips on this subject may be found in chapter "Is the computer communication module operable?". This test may also be performed using the "Setting PG/PC Interface" program, however, the "PG Operation" operation mode is required to do so.
3.7.2 Creating STEP7 Project S7_Redundancy

The following description shows in detail the necessary configuration steps for creating and commissioning of STEP7 project S7_Redundancy.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the WinCC project S7_7 Redundancy.

- A: Installation of hardware
- B: Creating STEP7 project
- C: Configuring hardware
- D: Loading hardware configuration for SIMATIC
- E: Configuring PC station
- F: Loading hardware configuration into CP1613
- G: Creating connection to WinCC application
- H: Testing of hardware configuration
- I: Creating STEP7 program
- J: Testing of STEP7 program
**A: Installation of hardware**

<table>
<thead>
<tr>
<th></th>
<th>A: Installation of hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Assemble the used modules on the module supports.</td>
</tr>
<tr>
<td></td>
<td>In the current example, these are two power supply units PS 407 10A, two central modules</td>
</tr>
<tr>
<td></td>
<td>CPU 417-4 with two H-Sync modules each, as well as two communication processors CP 1613.</td>
</tr>
<tr>
<td></td>
<td>Establish the connection between programming device and programming interface of the central module.</td>
</tr>
<tr>
<td></td>
<td>Establish the connection between the computer's communication processor CP 1613 to communication processor CP 443-1 in the PLC.</td>
</tr>
</tbody>
</table>
B: Creating STEP7 project

1. Creating a new STEP7 project in SIMATIC Manager.
   This is started using Start  \rightarrow SIMATIC  \rightarrow SIMATIC Manager.

2. The SIMATIC Manager opens.
   Using menu item File  \rightarrow New, the dialog to specify parameters of a new
   STEP7 project opens.
   Enter the name of the newly created project in the Name field. Names of
   STEP7 projects created as part of this manual must start with the
   character sequence S7. Furthermore, they contain a description of the
   communication type used. The current example has the name
   S7_Redundancy.
   By default, projects are saved in directory C:\PROGRAM
   FILES\SIEMENS\STEP7\S7proj. However, this may be changed at any
   time by clicking the Browse button.
   The New dialog is closed by clicking the OK button.
**C: Configuring hardware**

1. The new project is displayed in SIMATIC Manager. Hardware must be configured for it. Three components are needed. These are a SIMATIC H station, the Industrial Ethernet for network access, and a SIMATIC PC station.

These components are obtained in SIMATIC Manager using ⌘R on the name of project S7_Redundancy and Insert New Project → SIMATIC station, Insert New Object → SIMATIC PC station as well as Insert New Object → Industrial Ethernet.

<table>
<thead>
<tr>
<th>Cut</th>
<th>Ctrl+X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
</tr>
</tbody>
</table>

| Insert New Object | → |
| SIMATIC 300 Station |
| SIMATIC 400 Station |
| SIMATIC S7 |
| PG/PC |
| MPI |
| PROFIBUS |
| Industrial Ethernet |
| PTP |
| S7 Program |
| M7 Program |

2. The two components just added are displayed in the right window of SIMATIC Manager. Using ⌘ on component SIMATIC H Station(1) in the right window will display the Hardware item. Using ⌘R and Open Object on it will start the HWConfig program.
### Configuring hardware

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>The HWConfig program opens. It is used to exactly specify the hardware used in the PLC, and to configure its properties.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="HW Konfig" /></td>
</tr>
<tr>
<td>4</td>
<td>Using the subsequently displayed button in the toolbar of HWConfig program, the hardware catalog opens. This is used to select the required hardware components.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Catalog" /></td>
</tr>
</tbody>
</table>
The hardware catalog opens.
The first component to be selected is the module support used. All additional components are to be installed on it. The module rack used is inserted into the project using Drag&Drop. The example uses module support of type UR2-H.
C: Configuring hardware

6 The HWConfig program displays the presently still empty module rack. These have been assigned rack numbers 0 and 1.

7 Arrangement of additional hardware components in module support. This uses Drag&Drop for the desired components from the hardware catalog in their respective slots in the module support.

   The example uses a power supply unit PS 407 10A. This is inserted in slot 1. A power supply unit of this type uses two slots.

   The example uses a CPU 417-4 H as central module. This is inserted in slot 3. H-Sync modules are used at the interfaces. In configuring the connection in the WinCC project, the slot number of the central module is an additional parameter to be set.

   Furthermore, a CP 443-1 communication processor is needed. However, this is available from the hardware catalog only if the NCM S7 Industrial Ethernet option package has been installed. If the CP 443-1 communication processor is inserted into the module support, its properties dialog opens.
The property dialog of the Ethernet interface of CP 443-1 is displayed. Use the Parameter tab register in the MAC address field to set the desired Ethernet address of the communication processor. The current example specifies this as 08.00.06.01.00.00.

Use the lower selection field Subnet to assign the entry Ethernet(1) to the communication processor. Close the dialog with OK.
In the following, the fully configured hardware design of the example is shown.

Settings made must be saved in the HWConfig program and must be compiled in order to load the data onto the module. This is done using the toolbar button displayed in the following.
### D: Loading hardware configuration into SIMATIC

<table>
<thead>
<tr>
<th></th>
<th>D: Loading hardware configuration into SIMATIC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Hardware configuration for the SIMATIC H station created in the HWConfig program must be transferred to the PLC. This is done using the toolbar button displayed in the following.</td>
</tr>
<tr>
<td>2</td>
<td>A dialog opens which allows selection of components to be loaded. Only one CPU may be loaded at any time. Please make sure that any loading of the central module is possible only in operational switch positions STOP or RUN-P. Close the dialog with OK.</td>
</tr>
<tr>
<td>3</td>
<td>The Select Node Address dialog is displayed. Here you state which node address is used for communication between STEP7 software and central module. Close the dialog with OK.</td>
</tr>
<tr>
<td>4</td>
<td>Configuration data are now transferred to the PLC. Individual modules may have to be put into the STOP status. Steps 1 to 3 must be repeated in order to load the other CPU named CPU 417-1 H(1), including configuration data. The HWConfig program may be terminated. Components newly added are displayed in SIMATIC Manager for SIMATIC H-Station(1).</td>
</tr>
</tbody>
</table>

---

![Select Target Module](image-url)
### E: Configuring PC Station

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td>Using <strong>D</strong> on component PC Station in the right window will display the Hardware item. Using <strong>D</strong> on the Hardware item or <strong>R</strong> and Open Object on it will start the HWConfig program.</td>
</tr>
<tr>
<td><img src="image" alt="Hardware" /></td>
<td><img src="image" alt="Open Object" /></td>
</tr>
<tr>
<td></td>
<td>Cut Ctrl+X</td>
</tr>
<tr>
<td></td>
<td>Copy Ctrl+C</td>
</tr>
<tr>
<td></td>
<td>Paste Ctrl+V</td>
</tr>
<tr>
<td></td>
<td>Delete Del</td>
</tr>
<tr>
<td></td>
<td>Rename F2</td>
</tr>
<tr>
<td><strong>2</strong></td>
<td>The HWConfig program opens. It is used to exactly specify the hardware used in the PLC, and to configure its properties.</td>
</tr>
<tr>
<td><img src="image" alt="HW Konig" /></td>
<td>The module rack is automatically inserted into the program.</td>
</tr>
<tr>
<td><strong>3</strong></td>
<td>Using the subsequently displayed button in the toolbar of HWConfig program, the hardware catalog opens. This is used to select the required hardware components.</td>
</tr>
<tr>
<td><img src="image" alt="Catalog" /></td>
<td></td>
</tr>
</tbody>
</table>
E: Configuring PC Station

4 The hardware catalog opens. All components to be used must be installed on the module rack. The first components to be selected is the communication processor. This uses Drag&Drop for the component from the hardware catalog into its slot 1 in the module rack.

5 Arrangement of additional hardware components in module support. This uses Drag&Drop for the desired components from the hardware catalog in their respective slots in the module support.

Two communication processors CP 1613 and one WinCC application are configured in this example. The WinCC application is available only if the AS-OS Engineering option was installed under Communication at the same time as WinCC was installed. The AS-OS Engineering option may also be installed after the fact.

Upon inserting of communication processor CP 1613, its properties dialog opens.
## E: Configuring PC Station

6 The property dialog of the Ethernet interface of CP 1613 is displayed. Use the Parameter tab register in the MAC address field to set the desired Ethernet address of the communication processor. In the current example, this is set as 08.00.06.6D.98.78 for the first CP 1613, and set as 08.00.06.6D.98.79 for the second CP 1613. In configuring the connection in the WinCC project, this Ethernet address is an additional parameter to be set.

Use the lower selection field Subnet to assign the entry Ethernet(1) to the communication processor. Close the dialog with OK.

![Properties: Ethernet Interface CP 1613 (R0/S1)](image)

7 In the following, the fully configured hardware design of the example is shown.

![Hardware Design](image)

8 Settings made must be saved in the HWConfig program and must be compiled in order to load the data onto the module. This is done using the toolbar button displayed in the following.

![Save and Compile](image)
The hardware configuration created in the HWConfig program must be transferred to the PC station. In order to implement this, the name of the PC station in SIMATIC Manager must be identical with the name in Station Configuration Editor. The example uses the name PC Station. Equally, the sequence of components in HWConfig must be identical with the indices.

The Station Configuration Editor is started using Start → Station Configuration Editor.

Loading into the PC station is facilitated using the toolbar button of the HWConfig program described in the following.
3 A dialog opens which allows selection of components to be loaded. Everything must be selected in the current example. Close the dialog with OK.

4 The Select Node Address dialog opens. Here you state which node address is used for communication between STEP7 software and central module. Close the dialog with OK.

5 Configuration data are now transferred to the PLC. Individual modules may have to be put into the STOP status. The HWConfig program may be terminated. Components newly added are displayed in SIMATIC Manager for SIMATIC H-Station(1).
G: Creating connection to WinCC application

1. The connection must be created in order to configure the data exchange with the SIMATIC H station using WinCC. The connection is established using the NetPro program. This is done using SIMATIC Manager using PCStation → WinCC application and using \( \text{Ctrl}+D \) or using \( \text{Ctrl}+R \) and Open Object on the symbol.

2. The NetPro program opens. In order to configure the connection, select the WinCC application with \( \text{Ctrl}+R \) at the PC station. The lower half of the window displays the connection table. In order to create a new connection, a line in the table is selected with \( \text{Ctrl}+R \) and Insert New Connection.
G: Creating connection to WinCC application

3 The Insert New Connection dialog is displayed. In the upper window, select the entry for both CPUs of the SIMATIC H station. In the Connection - Type field, select the Highly Available S7 Connection entry using the pull-down menu. Close the dialog with OK.
4 **The Properties - Highly Available S7 Connection dialog opens. Here you must check again if the connection was configured properly. Close the dialog by clicking the OK button.**

![Properties - Fault tolerant S7 connection dialog]

5 **The connection has now been established and is displayed in the connection table of the NetPro program. The current configuration must now be saved and compiled in order to be loaded into the module. This uses the toolbar button of the NetPro program as displayed in the following.**

![Save and Compile toolbar button]

6 **Using the displayed toolbar buttons, the changes must be loaded into the module.**

![Download to Module toolbar button]
<table>
<thead>
<tr>
<th></th>
<th>G: Creating connection to WinCC application</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>The Select Target Module dialog is displayed. Select one of the CPUs from it. Close the dialog with OK.</td>
</tr>
</tbody>
</table>

![Image of the Select Target Module dialog]

| 8 | The configuration must also be loaded onto the PC station. |
H: Testing of hardware configuration

<table>
<thead>
<tr>
<th>1</th>
<th>Testing of hardware configuration decision</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>In a SIMATIC H station, both CPUs run redundantly. This means if both CPUs are turned into operational status RUN or RUN-P using the key switch, there is constant synchronization between data from both CPUs. If one CPU is brought into the STOP status, for whatever reason, the other CPU will assume the task of the failed CPU. The CPU which first reaches the RUN status will assume the Master function. If the Master CPU fails, the Slave turns into Master. This ascertains a highly available operation. If the CPUs are switches into the RUN position using the operational switches, only the status LEDs indicating the RUN status, and the module LEDs are supposed to be lit.</td>
</tr>
<tr>
<td></td>
<td>If this is not the case, an error has occurred. This error may be determined using the steps described in the following. However, these step should also be implemented even if no error is indicated by the status LEDs. This will allow to recognize non-critical errors and faulty configurations.</td>
</tr>
</tbody>
</table>
H: Testing of hardware configuration

Testing of configuration in central module.

This uses the Module Information dialog in SIMATIC Manager. This dialog is opened using "R" on the entry of the central module in the left window and Target System → Module Information.

The Module Information dialog of the central module is displayed. The General tab register displays various general data of the central module. The Status field will display the current Module Information as well as existing errors, if any.

The Diagnostic Buffer tab register display detailed information on existing errors and their correction.

The dialog is closed by clicking the Close button.
H: Testing of hardware configuration

3 Testing of communication processor configuration.
This uses the Module Information dialog in SIMATIC Manager. This dialog is opened using \( \text{R} \) on the entry of the communication processor in the left window and Target System \( \rightarrow \) Module Information.
The Module Information dialog of the communication processor is displayed.
The General tab register displays various general data of the module.
A dialog for more detailed diagnostics of the communication processor may be opened using the Special Diagnostics button.
H: Testing of hardware configuration

4 The NCM S7 Industrial Ethernet Diagnostics dialog is displayed. The CP Information tab register displays general information on the module. Among others, the set network address may be checked. The dialog is closed by clicking the Close button. The Module Information dialog may also be closed by clicking the Close button.
I: Creating STEP7 program

For the current example project, only one operations block, OB1, and one data block are needed. OB1 is available by default. The needed data block must first be created. This is done in SIMATIC Manager using the Blocks subitem of entry S7 program(1) of the configured central module and Insert New Object → Data Block.

The property dialog of the data block opens. Enter DB75 as the name for the block and close the dialog by clicking OK.
I: Creating STEP7 program

2 The newly created data block DB75 is displayed in the right window of the project.

Using $\text{Ctrl}+\text{D}$ on it or using $\text{Ctrl}+\text{R}$ and Open Object, the contents of the block may be programmed. The program KOP/AWL/FUP is started.

<table>
<thead>
<tr>
<th>Open Object</th>
<th>Ctrl+Alt+O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
</tr>
<tr>
<td>Insert New Object</td>
<td></td>
</tr>
<tr>
<td>PLC</td>
<td></td>
</tr>
<tr>
<td>Compare Blocks...</td>
<td></td>
</tr>
<tr>
<td>Reference Data</td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td></td>
</tr>
<tr>
<td>Rename</td>
<td>F2</td>
</tr>
<tr>
<td>Object Properties...</td>
<td>Alt+Return</td>
</tr>
<tr>
<td>Special Object Properties</td>
<td></td>
</tr>
</tbody>
</table>
I: Creating STEP7 program

3 The program KOP/AWL/FUP is displayed.
   The New Data Block dialog appears and must be acknowledged by clicking OK.

4 Programming of DB75.
   Here, two tags of length 16 bits are created. Their sum is supposed to be determined in OB1 and written to another tag of length 16 bits.
   Furthermore, two tags of length 16 bits are created, whose values are to be cyclically incremented in OB1.
   Tags created in data block DB75 are supposed to be visualized in the WinCC project. To do so, WinCC tags with corresponding addresses are created.
   The following shows the completely programmed data block DB75.

5 The data block must be saved. Furthermore, it must be loaded into the PLC.
   This is done using the toolbar button displayed in the following. Please make sure that any loading of the central module is possible only in operational switch positions STOP or RUN-P.
I: Creating STEP7 program

6 Programming of OB1.

This must be opened beforehand in program KOP/AWL/FUP.

Initially, two values created in DB75 are added and the result is again saved in DB75.

Netzwerk 1: Addition

Adding two 16-Bit Values
The result is stored in another 16-Bit Value

```
DBN   DB    75
L      DBW   0
L      DBW   2
+I
T      DBW   4
```

Next, the count of a value created in DB75 is implemented every second.

Netzwerk 2: Second Cycle

Generation of a second cycle at M 0.0

```
AN    M      0.0
L      S5T#18
SD    T      1
A      T      1
=      M      0.0
```

Netzwerk 3: Counting in a second cycle

Counting a value in a second cycle
At 10000, reset to 0

```
AN    M      0.0
JC    M001
L      DBW   6
L      1
+I
T      DBW   6
L      10000
<1
JC    M001
L      0
T      DBW   6
M001:  NOF  0
```
Next, the count of a value created in DB75 is implemented for each run of OB1.

**Network 4: Counting in the cycle time**

Counting a value each time the OB is executed
At 10000, reset to 0

| L  | DBW  | 8 |
| L  | I    |   |
| +I | DBW  | 8 |
| L  | 10000|   |
| <I |       |   |
| J C| M002 |   |
| L  | 0    |   |
| T  | DBW  | 8 |
| M002: NOE | 0 |

7 The OB1 block must be saved and loaded into the PLC. This is done using the respective toolbar button.

Thus, the STEP7 project is complete and ready to run. The KOP/AWL/FUP program may be terminated.
### J: Testing of STEP7 program

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td>Testing of program using STEP7 software.</td>
</tr>
<tr>
<td></td>
<td>A tag table is created for this. This is done in SIMATIC Manager using ( \text{R} ) on the entry of the configured central module and Target System ( \rightarrow ) Monitor / Modify Tag.</td>
</tr>
<tr>
<td><img src="image" alt="Image of SIMATIC Manager" /></td>
<td><img src="image" alt="Image of SIMATIC Manager" /></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Image of SIMATIC Manager" /></td>
</tr>
<tr>
<td><strong>2</strong></td>
<td>An editor is displayed to create and use such a tag table.</td>
</tr>
<tr>
<td></td>
<td>In the following, the complete tag table is shown. All tags created in DB75 are entered.</td>
</tr>
</tbody>
</table>

**Tag Table**

<table>
<thead>
<tr>
<th>Address</th>
<th>Symbol</th>
<th>Display Format</th>
<th>Status Value</th>
<th>Modify Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB75.DBW 0</td>
<td>---</td>
<td>DEC</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>DB75.DBW 2</td>
<td>---</td>
<td>DEC</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>DB75.DBW 4</td>
<td>---</td>
<td>DEC</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>DB75.DBW 6</td>
<td>---</td>
<td>DEC</td>
<td>1083</td>
<td></td>
</tr>
<tr>
<td>DB75.DBW 8</td>
<td>---</td>
<td>DEC</td>
<td>1703</td>
<td></td>
</tr>
</tbody>
</table>
### J: Testing of STEP7 program

| 3 | Monitoring current tag values.  
By clicking the toolbar button shown in the following, the current values of respective tags in the PLC are displayed in the Status Value column.  

![Monitor variable](image)

Controlling of tag values.  
In the Control Value column, values may be entered. By clicking the toolbar button displayed in the following, these values are written to the corresponding tags in the PLC.  

Please make sure that any controlling of tags is possible only in operational switch position RUN-P.  

![Modify variable](image) |
|---|---|
| 4 | The so-created tag table may now be saved.  
In the current example, it is save under the name VAT1. If the program function in the PLC has now been checked, the tag table may be closed. Thus, configuration of the STEP7 project is complete and SIMATIC Manager may be terminated.  

![VAT1](image) |
3.7.3 Creating WinCC Project WinCC_Redundancy

The following description shows in detail the necessary configuration steps for creating and commissioning of WinCC project WinCC_Redundancy.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the WinCC project WinCC_Redundancy.

- A: Creating WinCC project
- B: Establishing connection
- C: Creating WinCC tags
- D: Creating WinCC picture
### A: Creating WinCC project

<table>
<thead>
<tr>
<th></th>
<th>A: Creating WinCC project</th>
</tr>
</thead>
</table>
| 1 | Creating a new WinCC project in WinCC Explorer.  
   | This is started using Start → SIMATIC → WinCC → Windows Control Center. |
| 2 | WinCC Explorer is opened.  
   | Using menu item File → New, the dialog to specify the properties of a new WinCC project opens.  
   | The following example project creates a single-user project.  
   | Finish the dialog with OK. |

![WinCC Explorer](image)
A: Creating WinCC project

The Create a New Project dialog opens.

Enter a project name for the new project. WinCC projects created as part of this manual begin with a character sequence of WinCC, and furthermore contain a description of communication partners, as well as communication type used. The current example has the name WinCC_Redundancy.

Furthermore, in the Project Path field, the storage location of the new project must be set.

The Create a New Project dialog is closed by clicking the Create button.
B: Establishing connection

1. The new project is displayed in WinCC Explorer.
   Installing of required communication driver. This is done by clicking the Add New Driver.

2. The Add New Driver Dialog opens.
   It offers a selection of all communication drivers available for installation. For communication with SIMATIC S7-H using Industrial Ethernet, the SIMATIC S7 Protocol Suite.chn driver is required. It must be selected in the dialog. Close the dialog with Open.
3 The newly added driver SIMATIC S7 Protocol Suite displays as a subitem of Tag Management. The driver contains a channel unit with the name Named Connections. A new connection must be created for it. This is done using \( \text{CTR} \) on the Named Connections and New Connection entry.

4 The property dialog of the connection opens. Enter the name of the new connection on the General tab register. The current example uses Redundancy.
B: Establishing connection

Under Properties, in the Application Name field, WinCC Application must be specified using the pull-down menu. The WinCC application is available only after error-free loading of the PC station. A name must be entered in the Connection Name field.

Close this dialog by clicking OK, and close the Connections Properties dialog as well.
C: Creating WinCC tags

1 Creating WinCC tags required for example.

This is done by clicking on the entry for the newly created connection Redundancy and New Tag.
C: Creating WinCC tags

The property dialog of the tag is displayed. The example uses S16x_S7_Redundancy_01 as the name for the first tag. The tag is of data type Signed 16-Bit Value. Using the Select button, the address of the new tag is set. Both dialogs are closed with OK.
### C: Creating WinCC tags

3 Creating the remaining required WinCC tags.

The procedure is analogous to Steps 1 to 2 as described. Names, data types, and addresses of tags used in this example may be obtained from the following display.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>S16x_S7_Redundancy_01</td>
<td>Signed 16-bit value</td>
<td>D875, DW0</td>
</tr>
<tr>
<td>S16x_S7_Redundancy_02</td>
<td>Signed 16-bit value</td>
<td>D875, DW2</td>
</tr>
<tr>
<td>S16x_S7_Redundancy_03</td>
<td>Signed 16-bit value</td>
<td>D875, DW4</td>
</tr>
<tr>
<td>S16x_S7_Redundancy_04</td>
<td>Signed 16-bit value</td>
<td>D875, DW6</td>
</tr>
<tr>
<td>S16x_S7_Redundancy_05</td>
<td>Signed 16-bit value</td>
<td>D875, DW8</td>
</tr>
</tbody>
</table>
### D: Creating WinCC picture

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td>Creating a WinCC picture to visualize the previously created tags. To do so, open the Graphics Designer editor using <code>Open</code> and <code>Open</code>.</td>
</tr>
<tr>
<td><img src="image" alt="Graphics Designer" /></td>
<td><img src="image" alt="Object Palette" /></td>
</tr>
<tr>
<td><strong>2</strong></td>
<td>The Graphics Designer editor is displayed. In it, a new WinCC picture is already open. Configuring a Smart object <code>I/O Field</code> to display the first tag. Select the I/O field in the object palette and place it onto the picture using the mouse.</td>
</tr>
</tbody>
</table>
D: Creating WinCC picture

3 After placement of the I/O field on the picture, its configuration dialog opens. In the Tag field, the tag S16x_S7_Reundancy_01 is set using the button shown in the following.

Tag updates are left at 2s. The additional set options should retain their default values as well. Finish the dialog with OK.
<table>
<thead>
<tr>
<th></th>
<th>Creating WinCC picture</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Changes of output format for I/O field.</td>
</tr>
<tr>
<td></td>
<td>Open its property dialog. This is done by clicking <code>R</code> on the I/O field and Properties.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Property Dialog" /></td>
</tr>
<tr>
<td></td>
<td>The Object Properties dialog is displayed.</td>
</tr>
<tr>
<td></td>
<td>On the Properties tab register, select the Output/Input entry in the left window.</td>
</tr>
<tr>
<td></td>
<td>Using <code>D</code> on the set output value will make the display field editable. Enter the</td>
</tr>
<tr>
<td></td>
<td>new format s99999. Using this format, the I/O field is capable to display signed</td>
</tr>
<tr>
<td></td>
<td>values with a maximum of 5 digits.</td>
</tr>
<tr>
<td></td>
<td>Close the dialog with OK.</td>
</tr>
<tr>
<td>5</td>
<td>Creating an additional three I/O fields to display the remaining tags.</td>
</tr>
<tr>
<td></td>
<td>The procedure is analogous to Steps 2 to 5 as described.</td>
</tr>
</tbody>
</table>
D: Creating WinCC picture

The picture must be saved.

In the example project, it was saved under the name graph_Redundancy_01.pdl. The picture may be switched directly from Graphics Designer into Runtime by using the button displayed in the following.

Once the picture is in Runtime, the PLC has been started, and the network connection has been established, the current tag values of the PLC are displayed. These may also be changed by input of values into the individual I/O fields.

If no connection to the PLC exists, the I/O fields are shown in gray tones. In this case, some error must exist in some part of the communication link.
3.7.4 **Diagnostics of Redundant Communication Connection Using Industrial Ethernet**

The following description shows options available for diagnostics of the communication link between the WinCC project WinCC_Redundancy and the SIMATIC S7 station.

Diagnostics of an example in accordance with the following description is only meaningful if the following checks listed have successfully been concluded.

- Commissioning of CP 1613 communication processor
- Testing of communication processor
- Generation of STEP7 project S7_Redundancy
- Testing of S7 program
## A: Channel Diagnosis

1. Diagnostics of communication link using the WinCC Channel Diagnosis program.
   This is started using Start \(\rightarrow\) SIMATIC \(\rightarrow\) WinCC \(\rightarrow\) Tools \(\rightarrow\) Channel Diagnosis.

2. The WinCC Channel Diagnosis program is opened.
   The Channels/Connections tab register displays exact information on the status of each configured connection. The default value for display update is one second. The update cycle may be changed in the lower input field.

### WinCC Channel Diagnosis

<table>
<thead>
<tr>
<th>Channels/Connections</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC S7 PROTOCOL SUITE</td>
<td></td>
</tr>
</tbody>
</table>
### A: Channel Diagnosis

<table>
<thead>
<tr>
<th>3</th>
<th>In case a connection problem exists, the right window will display in the Error Code line a value indicating a more specific cause of the problem. More detailed information on error codes may be obtained by clicking on the Error Code entry. This will display the description of the respective error code contained in the online help of WinCC. Furthermore, possible error causes are displayed.</th>
</tr>
</thead>
</table>
| **Error 7001 - CEC_STPCHK** | Communication aborted due to stop check.
- The connection was aborted by the channel because a VMD state of the CPU - STOP, HOLD or DEFECTIVE - was detected. |
### 3.8 Communication WinCC - SlotPLC

The program SlotPLC serves to test Step7 programs on the PC. Projects and files to be generated in this chapter may also be loaded onto your hard disk directly from the Online Support (link "Info" on http://support.automation.siemens.com/WW/view/en/21320307).

There is the option of copying the following components to hard disk:

- **S7_SlotPLC**
  - The STEP7 project to be generated.

- **WinCC_SlotPLC**
  - The WinCC project to be generated.

This chapter describes in detail the commissioning of a communication link between a WinCC project and SlotPLC.

**Summary on Example Design**

The example worked with programs only. Programs WinCC, Step7 and WinLC are installed on the computer used.
Summary of Configuration Steps

The following summary lists all configuration segments necessary for establishing the communication link.

- Installation of WinAC Basis
- Generation of STEP7 project S7_SlotPLC
- Creating WinCC project WinCC_SlotPLC
- Diagnostics of communication link

Required software

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC NET</td>
<td>Using installation of SIMATIC NET, all necessary drivers are installed.</td>
</tr>
<tr>
<td>Win AC</td>
<td>Using the installation of Win AC, Win LC is also installed as an option.</td>
</tr>
<tr>
<td>STEP7</td>
<td>STEP7 software to create STEP7 program.</td>
</tr>
<tr>
<td>WinCC</td>
<td>WinCC with SIMATIC S7 Protocol Suite communication driver to generate the WinCC project.</td>
</tr>
</tbody>
</table>
3.8.1 Installation of WinAC Basis

Installation of WinAC Basis is performed using the SIMATIC WinAC CD. After inserting the CD, the installation starts automatically but may also started manually by executing the file Setup.exe.

The following description gives a short summary for successful software installation.

Summary of Installation Steps

The following summary lists the required steps for successful installation of the WinAC software

- A: Installation of software
- B: Summary of installed components
## A: Installation of software

1. After inserting the CD, the installation starts. Follow the installation instructions.

   ![SIMATIC WinAC Basic V4.0 Setup: Setup language](image1)

   - Select setup language: Deutsch
   - Select language: English
   - Select Langue d'installation: Français

2. Select the following components to be installed. Select the component SIMATIC Computing V3.1. CP 5611 was recognized automatically. The WinAC CP5611 DP driver must be installed.

   ![SIMATIC WinAC Basis V4.0 Setup: Components](image2)

   - Programs to be installed:
   - Siemens WinCC V4.0 7 MB
   - Adobe Acrobat Reader V5.05 20 MB
   - SIMATIC WinLC V4.0 10 MB
   - WinAC CP 5611 DP Driver V1.5 7 MB
   - SIMATIC Computing V3.1 23 MB

   - Description: SIMATIC/Windows Logic Controller 4.0

   - Required on C: 43 MB
   - Available on C: 7334 MB

   ![Next, Cancel, Back buttons](image3)
A: Installation of software

3 During installation, the Setting PG/PC Interface program opens. CP5611 was automatically assigned to access point COMPUTING. Finish the program with OK.
A: Installation of software

4 The computer must be restarted after installation.

- Setup has successfully installed and configured the software on your computer.
- You can find information in the "readme" file.
- The computer has to be restarted. Setup can restart the computer now, or you can do it yourself later.

- Yes, restart the computer now.
- No, the computer will be restarted later.

Setup is finished.
### B: Summary of installed components

<table>
<thead>
<tr>
<th></th>
<th>B: Summary of installed components</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the Start menu, the item PC Based Control was created under SIMATIC.</td>
</tr>
</tbody>
</table>

![Diagram showing the Start menu with PC Based Control under SIMATIC]
3.8.2 Creating STEP7 Project S7_SlotPLC

The following description shows in detail the necessary configuration steps for creating and commissioning of STEP7 project S7_SlotPLC.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the STEP7 project S7_SlotPLC.

- A: Creating STEP7 project
- B: Configuring hardware
- C: Loading of hardware configuration
- D: Creating STEP7 program
- E: Testing of STEP7 program
A: Creating STEP7 project

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creating a new STEP7 project in SIMATIC Manager. This is started using Start → SIMATIC → SIMATIC Manager.</td>
</tr>
<tr>
<td></td>
<td>SIMATIC Manager</td>
</tr>
<tr>
<td>2</td>
<td>The SIMATIC Manager opens. Using menu item File → New, the dialog to specify parameters of a new STEP7 project opens. Enter the name of the newly created project in the Name field. Names of STEP7 projects created as part of this manual must start with the character sequence S7. Furthermore, they contain a description of the communication type used. The current example has the name S7_SlotPLC. By default, projects are saved in directory C:\PROGRAM FILES\SIEMENS\STEP7\S7proj. However, this may be changed at any time by clicking the Browse button. The New dialog is closed by clicking the OK button.</td>
</tr>
</tbody>
</table>
### B: Configuring hardware

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The new project is displayed in SIMATIC Manager. Hardware must be configured for it. Only one component is required. This is a SIMATIC PC station. The component is added in SIMATIC Manager using &quot;R on the name of project S7_SlotPLC and Insert New Project → SIMATIC PC Station.</td>
</tr>
<tr>
<td>2</td>
<td>Using &quot;D on component SIMATIC PC Station(1) in the right window will display the Hardware item. Using &quot;D on the Hardware item or &quot;R and Open Object on it will start the HWConfig program.</td>
</tr>
<tr>
<td>3</td>
<td>The HWConfig program opens. It is used to exactly specify the hardware used in the PLC, and to configure its properties.</td>
</tr>
</tbody>
</table>
B: Configuring hardware

4 Using the subsequently displayed button in the toolbar of HWConfig program, the hardware catalog opens. This is used to select the required hardware components.

5 The hardware catalog and the presently still vacant PC module rack are displayed.
B: Configuring hardware

6 Only one WinLC controller must be installed on the module rack. This uses Drag&Drop for the component from the hardware catalog into its slot 2 in the module rack.

7 In the following, the fully configured hardware design of the example is shown.

8 Settings made now must be saved in program HWConfig and must be compiled. This is done using the toolbar button displayed in the following.
### C: Loading of hardware configuration

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Prior to loading, the WinLC program must be started. This is started using Start → SIMATIC → PC Based Control → WinLC.</td>
</tr>
<tr>
<td>2</td>
<td>Afterwards, the following window is shown. The module displayed in the window is reset by using the <strong>RESET</strong> button, and switched into programmable run mode using the <strong>RUN-PO</strong> button.</td>
</tr>
<tr>
<td>3</td>
<td>The hardware configuration created in the HWConfig program must be transferred to the PC station. In order to implement this, the name of the PC station in SIMATIC Manager must be identical with the name in Station Configuration Editor. In the example, the PC station is named SIMATIC PC Station(1). The Station Configuration Editor is started using Start → Station Configuration Editor. Using the Station Name button, the name issued for the PC station here may be changed. Loading of the hardware configuration uses the toolbar button of the HWConfig program shown in the following.</td>
</tr>
</tbody>
</table>
C: Loading of hardware configuration

4 A dialog opens which allows selection of components to be loaded. Close the dialog with OK.

5 Now the configuration data are transferred to the WinLC program. “Simulated modules” may have to be put into the STOP status. The HWConfig program may be terminated. Components newly added are displayed in SIMATIC Manager for SIMATIC PC Station(1).
D: Creating STEP7 program

For the current example project, only one operations block, OB1, and one data block are needed. OB1 is available by default. The needed data block must first be created. This is done in SIMATIC Manager using the Blocks subtree of entry S7 program(1) of the configured central module and Insert New Object → Data Block.

The property dialog of the data block opens. Enter DB75 as the name for the block and close the dialog by clicking OK.
### D: Creating STEP7 program

#### 2
The newly created data block DB75 is opened in the right window of the project. Using `Ctrl` on it or using `R` and Open Object, the contents of the block may be programmed. The program KOP/AWL/FUP is started.

#### 3
The program KOP/AWL/FUP opens. The New Data Block dialog appears and must be acknowledged by clicking OK.

---

<table>
<thead>
<tr>
<th>Open Object</th>
<th>Ctrl+Alt+O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
</tr>
<tr>
<td>Insert New Object</td>
<td></td>
</tr>
<tr>
<td>PLC</td>
<td></td>
</tr>
<tr>
<td>Compare Blocks...</td>
<td>Reference Data</td>
</tr>
<tr>
<td>Print</td>
<td></td>
</tr>
<tr>
<td>Rename</td>
<td>F2</td>
</tr>
<tr>
<td>Object Properties...</td>
<td>Alt+Return</td>
</tr>
<tr>
<td>Special Object Properties</td>
<td></td>
</tr>
</tbody>
</table>
D: Creating STEP7 program

4 Programming of DB75.
Here, two tags of length 16 bits are created. Their sum is supposed to be determined in OB1 and written to another tag of length 16 bits.
Furthermore, two tags of length 16 bits are created, whose values are to be cyclically incremented in OB1.
The following shows the completely programmed data block DB75.

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Type</th>
<th>Initial value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td></td>
<td></td>
<td></td>
<td>STRUCT</td>
</tr>
<tr>
<td>+0.0</td>
<td>Var_01</td>
<td>WORD</td>
<td>#16#0</td>
<td>Value 1</td>
</tr>
<tr>
<td>+2.0</td>
<td>Var_02</td>
<td>WORD</td>
<td>#16#0</td>
<td>Value 2</td>
</tr>
<tr>
<td>+4.0</td>
<td>Var_03</td>
<td>WORD</td>
<td>#16#0</td>
<td>Sum</td>
</tr>
<tr>
<td>+6.0</td>
<td>Var_04</td>
<td>WORD</td>
<td>#16#0</td>
<td>Inc 1</td>
</tr>
<tr>
<td>+8.0</td>
<td>Var_05</td>
<td>WORD</td>
<td>#16#0</td>
<td>Inc 2</td>
</tr>
<tr>
<td>-10.0</td>
<td>END_STRUCT</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5 The data block must be saved. Furthermore, it must be loaded into the PLC. This is done using the toolbar button displayed in the following. Please make sure that any loading of the central module is possible only in operational switch positions STOP or RUN-P.

6 Programming of OB1.
This must be opened beforehand in program KOP/AWL/FUP.
Initially, two values created in DB75 are added and the result is again saved in DB75.

Netzwerk 1: Addition

<table>
<thead>
<tr>
<th>Opcode</th>
<th>DB</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBW</td>
<td>75</td>
<td></td>
</tr>
<tr>
<td>DBW</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>DBW</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>DBW</td>
<td>4</td>
<td></td>
</tr>
</tbody>
</table>
D: Creating STEP7 program

Next, the count of a value created in DB75 is implemented every second.

**Network 2: Second Cycle**

Generation of a second cycle at M 0.0

```
AN  M  0.0
L   S5T4S
SD  T  1
A   T  1
=   M  0.0
```

**Network 3: Counting in a second cycle**

Counting a value in a second cycle
At 10000, reset to 0

```
AN  M  0.0
JC  M001
L   DBW  6
L   1
+I
T   DBW  6
L   10000
<\n JC  M001
L   0
T   DBW  6
M001: NOP  0
```

Next, the count of a value created in DB75 is implemented for each run of OB1.

**Network 4: Counting in the cycle time**

Counting a value each time the OB is executed
At 10000, reset to 0

```
L   DBW  8
L   1
+I
T   DBW  8
L   10000
<\n JC  M002
L   0
T   DBW  8
M002: NOP  0
```

7 The OB1 block must be saved and loaded onto the PLC. This is done using the respective toolbar button. Thus, the STEP7 project is complete and ready to run. The KOP/AWL/FUP program may be terminated.
E: Testing of STEP7 program

1. Testing of program using STEP7 software.

A tag table is created for this. This is done in SIMATIC Manager using the Monitor / Modify Tag.

2. An editor is displayed to create and use such a tag table.

In the following, the complete tag table is shown. All tags created in DB75 are entered.
### E: Testing of STEP7 program

<table>
<thead>
<tr>
<th></th>
<th>Monitoring current tag values. By clicking the toolbar button shown in the following, the current values of respective tags in the PLC are displayed in the Status Value column.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Controlling of tag values. In the Control Value column, values may be entered. By clicking the toolbar button displayed in the following, these values are written to the corresponding tags in the PLC. Please make sure that any controlling of tags is possible only in operational switch position RUN-P.</td>
</tr>
<tr>
<td></td>
<td>The so-created tag table may now be saved. In the current example, it is save under the name VAT1. If the program function in the PLC has now been checked, the tag table may be closed. Thus, configuration of the STEP7 project is complete and SIMATIC Manager may be terminated.</td>
</tr>
</tbody>
</table>

VAT1
3.8.3 Creating WinCC Project WinCC_SlotPLC

The following description shows in detail the necessary configuration steps for creating and commissioning of WinCC project WinCC_SlotPLC.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the WinCC project WinCC_SlotPLC.

- A: Creating WinCC project
- A: Creating WinCC project
- C: Creating WinCC tags
- D: Creating WinCC picture
A: Creating WinCC project

1 Creating a new WinCC project in WinCC Explorer.
   This is started using Start → SIMATIC → WinCC → Windows Control Center.

2 WinCC Explorer is opened.
   Using menu item File → New, the dialog to specify the properties of a new WinCC project opens.
   The following example project creates a single-user project. Finish the dialog with OK.
A: Creating WinCC project

3 The Create a New Project dialog opens.

Enter a project name for the new project. WinCC projects created as part of this manual begin with a character sequence of WinCC, and furthermore contain a description of communication partners, as well as communication type used. The current example has the name WinCC_SlotPLC.

Furthermore, in the Project Path field, the storage location of the new project must be set.

The Create a New Project dialog is closed by clicking the Create button.
### B: Establishing connection

1. **The new project is displayed in WinCC Explorer.**
   
   Installing of required communication driver. This is done by clicking on the Tag management item and Add New Driver.

2. **The Add New Driver Dialog opens.**
   
   It offers a selection of all communication drivers available for installation. For communication with the WinLC station, the SIMATIC S7 Protocol Suite driver is required. It must be selected in the dialog. Close the dialog with Open.
B: Establishing connection

3 The newly added driver SIMATIC S7 Protocol Suite displays as a subitem of Tag Management.

The driver contains a channel unit with the name SlotPLC. A new connection must be created for it. This is done using \(\text{CR}\) on the SlotPLC and New Connection entry.

<table>
<thead>
<tr>
<th>SIMATIC S7 PROTOCOL SUITE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Industrial Ethernet</strong></td>
</tr>
<tr>
<td><strong>Industrial Ethernet (II)</strong></td>
</tr>
<tr>
<td><strong>MPI</strong></td>
</tr>
<tr>
<td><strong>Named Connectors</strong></td>
</tr>
<tr>
<td><strong>PROFIBUS</strong></td>
</tr>
<tr>
<td><strong>PROFIBUS (II)</strong></td>
</tr>
<tr>
<td><strong>Slot PLC</strong></td>
</tr>
<tr>
<td><strong>Soft PLC</strong></td>
</tr>
<tr>
<td><strong>TCP/IP</strong></td>
</tr>
</tbody>
</table>
B: Establishing connection

4 The property dialog of the connection opens. Enter the name of the new connection on the General tab register. It is Slot_PLC_01 in the current example. Specify connection parameters using the Properties button.

Connection properties

[Image of the Connection properties window]

Please make certain that the connection name does not include any national special characters or the characters $, " or ".

[OK] [Cancel] [Help]
Establishing connection

The Connection Parameter dialog opens. On the Connection tab register, the parameters for the desired communication connection are specified.

In the Station Address field, enter the address of the station. In the Slot No. field, enter the assigned index of the WinLC station in the Station Configuration Editor.

Close the dialog with OK.

![Connection Parameter - Soft PLC](image)
C: Creating WinCC tags

1 Creating WinCC tags required for example.
This is done by clicking on the entry for the newly created connection Slot_PLC_01 and New Tag.
2. Creating WinCC tags

The property dialog of the tag opens.

The example uses S16x_SlotPLC_01 as the name for the first tag. The tag is of data type Signed 16-Bit Value. Using the Select button, the address of the new tag is set.
C: Creating WinCC tags

3 The Address Properties dialog opens. Enter DB as data range and the value 75 as DB No. In the Address field, set Word and set the value to 0 in the DW field. The Address Properties dialog is closed by clicking OK, and the Tag Properties dialog is also closed using OK.

4 Creating the remaining required WinCC tags.

The procedure is analogous to Steps 1 to 3 as described. Names, data types, and addresses of tags used in this example may be obtained from the following display.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>S16x_SoftPLC_01</td>
<td>Signed 16-bit value</td>
<td>DB75,DW0</td>
</tr>
<tr>
<td>S16x_SoftPLC_02</td>
<td>Signed 16-bit value</td>
<td>DB75,DW2</td>
</tr>
<tr>
<td>S16x_SoftPLC_03</td>
<td>Signed 16-bit value</td>
<td>DB75,DW4</td>
</tr>
<tr>
<td>S16x_SoftPLC_04</td>
<td>Signed 16-bit value</td>
<td>DB75,DW6</td>
</tr>
</tbody>
</table>
### D: Creating WinCC picture

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creating a WinCC picture to visualize the previously created tags. To do so, open the Graphics Designer editor using the Open command.</td>
</tr>
<tr>
<td>2</td>
<td>The Graphics Designer editor is displayed. In it, a new WinCC picture is already open. Configuring a Smart object I/O Field to display the first tag. Select the I/O field in the object palette and place it onto the picture using the mouse.</td>
</tr>
</tbody>
</table>
3 After placement of the I/O field on the picture, its configuration dialog opens. In the Tag field, the tag S16x_SlotPLC_01 is set using the button shown in the following.

Tag updates are left at 2s. The additional set options should retain their default values as well. Finish the dialog with OK.
D: Creating WinCC picture

4 Changes of output format for I/O field.
Open its property dialog. This is done by clicking on the I/O field and Properties.

5 The Object Properties dialog opens.
On the Properties tab register, select the Output/Input entry in the left window. Using on the set output value will make the display field editable. Enter the new format s99999. Using this format, the I/O field is capable to display signed values with a maximum of 5 digits.
Close the dialog with OK.

6 Creating an additional three I/O fields to display the remaining tags.
The procedure is analogous to Steps 2 to 5 as described.
The picture must be saved.
In the example project, it was saved under the name SlotPLC_DWG_01.pdl. The picture may be switched directly from Graphics Designer into Runtime by using the button displayed in the following.

Once the picture is in Runtime, the PLC has been started, and the network connection has been established, the current tag values of the PLC are displayed. These may also be changed by input of values into the individual I/O fields.

If no connection to the PLC exists, the I/O fields are shown in gray tones. In this case, some error must exist in some part of the communication link.
3.8.4 Diagnostics of Communication Link Using SlotPLC

The following description shows options available for diagnostics of the communication link between the WinCC project WinCC_SlotPLC and the SIMATIC S7 station.

Diagnostics of an example in accordance with the following description is only meaningful if the following checks listed have successfully been concluded.

- Installation of Win AC Basis
- Generation of STEP7 project S7_SlotPLC
A: WinCC Explorer

1. Diagnostics of communication link in WinCC Explorer.
   Switch the WinCC_SlotPLC project into Runtime. This is done in WinCC Explorer using the toolbar button displayed in the following.

   ![Activate](image)

   The created WinCC picture SlotPLC_DWG_01.pdl may also be switched directly from Graphics Designer into Runtime.

2. In WinCC Explorer, using the menu Tools ➔ Status of Driver Connections, a dialog may be opened to monitor all configured connections. However, this menu item is only active if the project is in Runtime.

3. The Status - Logical Connections dialog is displayed.
   This dialog lists all configured connections. In the current example, only the connection Slot_PLC_01 exists.

   The displayed values correspond to the status at the moment the dialog was opened. By selecting the corresponding checkbox, a cyclic display update may also be achieved.
3.9 Communication WinCC - WinCC Using OPC DA

Projects and files to be generated in this chapter may also be loaded onto your hard disk directly from the Online Support (link "Info" on http://support.automation.siemens.com/WW/view/en/21320307).

There is the option of copying the following components to hard disk:

WinCC_OPC_SERVER
The Server WinCC project to be generated.

WinCC_OPC_CLIENT
The Client WinCC project to be generated.

This chapter describes in detail the implementation of a communication link between two WinCC stations using OPC.

The WinCC OPC Server is installed on the computer serving as server which provides the data of a WinCC project to other applications on the computer, as well as to the entire connected network environment.

Summary on Example Design

The WinCC OPC Server must be installed from the WinCC CD on the computer serving as server. This may have already happened during installation of WinCC.

The WinCC OPC Client must be installed from the WinCC CD on the computer serving as client. This may have already happened during installation of WinCC.

Both WinCC stations may be connected using any network connection.
Summary of Configuration Steps

The following summary lists all configuration segments necessary for establishing the communication link.

- Configuration of WinCC stations
- Generation of WinCC project WinCC_OPC_SERVER
- Generation of WinCC project WinCC_OPC_CLIENT
- Diagnostics of communication link

Required software

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC</td>
<td>WinCC with OPC Server as well as OPC Client to create WinCC projects.</td>
</tr>
</tbody>
</table>

Required hardware on computer

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network connection</td>
<td>Any network connection to establish link to network.</td>
</tr>
</tbody>
</table>
3.9.1 Configuring WinCC Stations for OPC (WinCC - WinCC)

The following description contains notes to be taken into consideration during configuration of WinCC stations.

During access to an OPC server from a WinCC client station, three constellations are possible in general. These differ on where these two components are located.

- Server and client are on the same computer
- Server and client are on different computers but within the same work group
- Server and client are on different computers in the same domain, or in different domains in trust positions

The first of the above constellations is not goal-oriented for communication between a WinCC OPC server and a WinCC OPC client. This constellation, however, may very well be used in many cases, such as communication with the S7-OPC server.

In the following steps described, the local circumstances must be taken into consideration.

- A: Installing software components
- B: Organization of network
- C: Organization of user structure
- D: Setting DCOM configuration
### A: Installing software components

| OPC server and OPC client of WinCC are required. The OPC servers are located on the WinCC Installation CD. The OPC client is automatically installed with WinCC.  
  
The OPC server must be installed on the computer which will serve as server. This may have happened during installation of WinCC. However, it may also be installed after the fact without any problems.  
  
Following installation of components on the respective computers, these computers must be rebooted.

![Select Components](image-url)

Activate or deactivate the components which should be installed or deinstalled, respectively.

<table>
<thead>
<tr>
<th>Components</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC</td>
<td>298 MB</td>
</tr>
<tr>
<td>Help</td>
<td>49 MB</td>
</tr>
<tr>
<td>Communication</td>
<td>1 MB</td>
</tr>
<tr>
<td>OPC Server</td>
<td>11 MB</td>
</tr>
<tr>
<td>Options</td>
<td>45 MB</td>
</tr>
</tbody>
</table>

- Description
  - Worldwide standardized and common manufacturer software interface for process connections

Available: 7400 MB
B: Organization of network

1 Organization of network

Settings required for the respective computers for organizing the network are implemented in the Network program. This is started using Start → Settings → Control Panel → System.

On the Identification tab register, the computer assignment may be made either to a work group or to a domain by using the Change button.
C: Organization of user structure

| 1 | Defining the user on both computers. This is facilitated on each computer using the User Manager program. This is started using Start ➔ Programs ➔ Administrative Tools ➔ Computer Management. If a work group is used, it must be ascertained that the user of the client station is known at the server station. Furthermore, the user of the server station must be known at the client station in order to use full functionality of OPC. If the domain concept is used, no attention needs to be paid to this since all users in the entire domain are known. For cross-domain access to a server station, however, a reciprocal trust position of both domains is required. |
D: Setting DCOM configuration

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Following installation of WinCC, the DCOM settings of the OPC server of WinCC are configured properly. These settings must be changed if the registered user of the OPC client or server computer does not have administrator authorization if the OPC server is registered under a different user account than the OPC client.</td>
</tr>
<tr>
<td>2</td>
<td>Setting of DCOM configuration for WinCC-OPC server. The settings for DCOM configuration are implemented using the DCOM Configuration Properties program. This can be started via Start → Run and entering the program name dcomcnfg.exe.</td>
</tr>
<tr>
<td>3</td>
<td>The Component Services application opens. Select under Component Services → Station → DCOM Configuration the OPCServer.WinCC entry. For the WinCC-OPC-HDA server, the OPCHDAServers.WinCC entry must be used. For the WinCC-OPC A&amp;E server, the OPCServerAE.WinCC entry must be used. In the pop-up menu of OPCServer.WinCC, select the Properties entry.</td>
</tr>
</tbody>
</table>
Click on the Security tab register. In the Access Permissions area, mark the Customize option. Click the Edit button.
The Properties of OPCServer.WinCC dialog is displayed.
The Access Permission dialog opens. Add users Administrators, Interactive, Everyone, Network and System with Allow Authorization. Close the dialog by clicking OK.

For the configuration phase, it may be useful to grant everyone access permissions to avoid problems beforehand due to insufficient access rights. After successful commissioning of communication, any desired restrictions on access authorizations for certain users may be easily configured.
D: Setting DCOM configuration

6 In the Launch Permission area, mark the Customize option. Click the Edit button. The Launch Permission dialog opens. Add users Everyone and Network with Allow Authorization. Close the dialog by clicking OK.

7 Close the dialog by clicking OK.
3.9.2 Creating WinCC Project WinCC_OPC_SERVER

The following description shows in detail the necessary configuration steps for creating and successful commissioning of WinCC project WinCC_OPC_SERVER.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the WinCC project WinCC_OPC_SERVER.

- A: Creating WinCC project
- B: Creating internal tags
- C: Creating WinCC picture
### A: Creating WinCC project

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| **1** | Creating a new WinCC project in WinCC Explorer.  
This is started using Start → SIMATIC → WinCC → Windows Control Center. |
| **2** | WinCC Explorer is opened.  
Using menu item File → New, the dialog to specify the properties of a new WinCC project opens.  
The following example project creates a single-user project.  
Finish the dialog with OK. |

![WinCC Explorer dialog](image-url)
### A: Creating WinCC project

3. The Create a New Project dialog opens. Enter a project name for the new project. WinCC projects created as part of this manual begin with a character sequence of WinCC, and furthermore contain a description of communication partners, as well as communication type used. The current example has the name WinCC_OPC_SERVER. Furthermore, in the Project Path field, the storage location of the new project must be set. The Create a New Project dialog is closed by clicking the Create button.
B: Creating internal tags

1 Creating internal tags required for example.
This is done in Tag Management using the entry for Internal Tags and New Tag.

2 The property dialog of the tag opens.
The example uses S16i_OPCServer_01 as the name for the first tag. The tag is of data type Signed 16-Bit Value.
### B: Creating internal tags

3 Creating the remaining required tags.

The procedure is analogous to Steps 1 to 3 as described. Names, data types, and addresses of tags used in this example may be obtained from the following display.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>@ConnectedRTClient</td>
<td>Unsigned 16-bit value</td>
<td></td>
</tr>
<tr>
<td>@CurrentUser</td>
<td>Text tag 8-bit character</td>
<td></td>
</tr>
<tr>
<td>@DeltaLoaded</td>
<td>Unsigned 32-bit value</td>
<td></td>
</tr>
<tr>
<td>@LocalMachineName</td>
<td>Text tag 8-bit character</td>
<td></td>
</tr>
<tr>
<td>@RedundantServer</td>
<td>Unsigned 16-bit value</td>
<td></td>
</tr>
<tr>
<td>S16i_OPCServer_01</td>
<td>Signed 16-bit value</td>
<td></td>
</tr>
<tr>
<td>S16i_OPCServer_02</td>
<td>Signed 16-bit value</td>
<td></td>
</tr>
<tr>
<td>S16i_OPCServer_03</td>
<td>Signed 16-bit value</td>
<td></td>
</tr>
<tr>
<td>S16i_OPCServer_04</td>
<td>Signed 16-bit value</td>
<td></td>
</tr>
</tbody>
</table>
C: Creating WinCC picture

1. Creating a WinCC picture to visualize the previously created tags.

   To do so, open the Graphics Designer editor using \( \text{Open} \) and Open.

2. The Graphics Designer editor is displayed. In it, a new WinCC picture is already open.

   Configuring a Smart object I/O Field to display the first tag. Select the I/O field in the object palette and place it onto the picture using the mouse.
3 After placement of the I/O field on the picture, its configuration dialog opens. In the Tag field, the tag SERVER_PC_S16i.OPCServer_01 is set using the button shown in the following.

Tag updates are set to Upon Change. The additional set options should retain their default values. Finish the dialog with OK.
C: Creating WinCC picture

4 Changes of output format for I/O field.

Open its property dialog. This is done by clicking \texttt{R} on the I/O field and Properties.

The Object Properties dialog opens.

On the Properties tab register, select the Output/Input entry in the left window. Using \texttt{D} on the set output value will make the display field editable. Enter the new format \texttt{s99999}. Using this format, the I/O field is capable to display signed values with a maximum of 5 digits.

6 Creating an additional three I/O fields to display the remaining tags. The procedure is analogous to Steps 2 to 5 as described.
C: Creating WinCC picture

Creating a simple tag simulation. The sum of tags S16i_OPCServer_01 and S16i_OPCServer_02 is supposed to be stored in tag S16i_OPCServer_03. The value of tag S16i_OPCServer_04 is supposed to be incremented every 250ms. The requirements posed are satisfied by two C actions. Each is generated using Properties ➔ Geometry ➔ Position X of the I/O field displaying the respective tag. A detailed description of the C action is found following this section.

The picture must be saved. In the example project, it was saved under the name com_3_OPCServer_01.pdl. The picture may be switched directly from Graphics Designer into Runtime by using the button displayed in the following.

These may also be changed by input of values into the individual I/O fields.
C action to generate sum

```c
#include "apdefap.h"
long _main(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName)
{
    //get tag values
    int iValue_01 = GetTagSDWord("S16i_OPCServer_01");
    int iValue_02 = GetTagSDWord("S16i_OPCServer_02");

    //calculate sum and set tag value
    SetTagSDWord("S16i_OPCServer_03", (iValue_01 + iValue_02));

    //return constant property value
    return GetLeft(lpszPictureName, lpszObjectName);
}
```

- The above described C action is configured for the I/O Field3 object using Properties  Geometry  Position X. The C action is triggered upon changes of tags S16i_OPCServer_01 and S16i_OPCServer_02.
- The values of both tags S16i_OPCServer_01 and S16i_OPCServer_02 are read. Their sum is formed and written to tag S16i_OPCServer_03.
- The C action is configured for an object property which serves to provide a trigger. The current value of the property is returned to it.

C action for incrementing

```c
#include "apdefap.h"
long _main(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName)
{
    //get tag value
    int iValue = GetTagSDWord("S16i_OPCServer_04");

    if (iValue < 10000)
    {
        //increment and set tag value
        SetTagSDWord("S16i_OPCServer_04", ++iValue);
    } else
    {
        //reset tag value
        SetTagSDWord("S16i_OPCServer_04", 0);
    }

    //return constant property value
    return GetLeft(lpszPictureName, lpszObjectName);
}
```

- The above described C action is configured for the I/O Field4 object using Properties  Geometry  Position X. The C action is triggered at 250ms.
- The value of tag S16i_OPCServer_04 is read. If this has not yet reached 10000, it is incremented and rewritten into the tag. Otherwise the tag value is set to zero.
- The C action is configured for an object property which serves to provide a trigger. The current value of the property is returned to it.
3.9.3 Creating WinCC Project WinCC_OPC_CLIENT

The following description shows in detail the necessary configuration steps for creating and successful commissioning of WinCC project WinCC_OPC_CLIENT.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the WinCC project WinCC_OPC_CLIENT.

- A: Creating WinCC project
- B: Establishing connection
- C: Creating WinCC picture
### A: Creating WinCC project

<table>
<thead>
<tr>
<th>A: Creating WinCC project</th>
</tr>
</thead>
</table>
| **1** Creating a new WinCC project in WinCC Explorer.  
WinCC Explorer is started using Start ➔ SIMATIC ➔ WinCC ➔ Windows Control Center. |
| **2** WinCC Explorer is opened.  
Using menu item File ➔ New, the dialog to specify the properties of a new WinCC project opens.  
The following example project creates a single-user project.  
Finish the dialog with OK. |

![WinCC Explorer](image-url)

Create a New Project

- Single-User Project
- Multi-User Project
- Client Project

Open an Existing Project

OK  Cancel
### A: Creating WinCC project

3. The Create a New Project dialog opens.

   Enter a project name for the new project. WinCC projects created as part of this manual begin with a character sequence of WinCC, and furthermore contain a description of communication partners, as well as communication type used. The current example has the name WinCC_OPC_CLIENT.

   Furthermore, in the Project Path field, the storage location of the new project must be set.

   The Create a New Project dialog is closed by clicking the Create button.

![Create a new project dialog](image-url)
B: Establishing connection

1. The new project is displayed in WinCC Explorer. Installing of required communication driver. This is done by clicking on the Tag management item and Add New Driver.

2. The Add New Driver Dialog opens. It offers a selection of all communication drivers available for installation. In the current example, the OPC communication driver is required. It must be selected in the dialog. Close the dialog with Open.

3. The newly added OPC communication driver is displayed as a subitem of tag management. The OPC communication driver receives a channel unit. Establishing a connection to a certain OPC server, as well as selection of items required from this server, may be facilitated using the OPC Item Manager. This is started using on the entry for OPC Groups (OPCHN Unit #1) channel unit and System Parameters.
B: Establishing connection

4 The OPC Item Manager opens.

Here the desired OPC server may be selected. It may be located on the local computer or on another computer accessible through a network connection. In the current example, the desired OPC server, according to the following display, is located on the WinCCOPC Server computer in the ZIP domain.

Using $\mathbf{D}$ on the entry of a work group or domain will list all available computers. Using $\mathbf{D}$ on the entry of a computer will list all available OPC servers.

On the desired server station, the entry OPCServer.WinCC of the WinCCOPC server must be selected. Using the Browse Server button, you may obtain a summary of all items made available by this WinCC-OPC server. However, this is only the case if the WinCC project was opened from the server station.
B: Establishing connection

5 The Filter Criteria dialog opens. This allows you more detailed specification of the type of desired items. If you wish a display of available items, no settings need to be made here. The dialog may be concluded with Continue.

![Filter Criteria dialog](image)

6 A dialog for the selection of desired items is opened. The four internal tags created previously in the server project are offered for selection as WinCCOPC server items. However, this is only the case if the WinCC project on the server station is in Runtime.

These four items must be selected in the right window. Using the Add Items button, these may be inserted into the WinCC project.

![OPC Server dialog](image)
**B: Establishing connection**

7 However, a new connection must be established beforehand where these items can be inserted as WinCC tags. This connection can be generated automatically by the OPC Item Manager. The New Connection dialog is displayed. Only the name of the new connection needs to be specified. The current example uses the name WinCC_OPC_01. Close the dialog with OK.

![New Connection](image1)

8 The Add Tag dialog opens. Here you specify which connection the tags should be added to. In the current example, they are supposed to be added to the previously created connection WinCC_OPC_01. This must be selected in the lower Add Here field.

The tag names used by OPC Item Manager may have optionally added a prefix and a suffix. In the current example, the tag name should be preceded by the prefix SERVER_PC_.

The WinCC tags are created using the Finish button. The OPC Item Manager is closed using the Finish button.

![Add Tags](image2)
### B: Establishing connection

The following display lists WinCC tags generated by the OPC Item Manager.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERVER_PC_SI6i_OPCServer_01</td>
<td>Signed 16-bit value</td>
<td>&quot;SI6i_OPCServer_01&quot;, &quot;&quot;, 2</td>
</tr>
<tr>
<td>SERVER_PC_SI6i_OPCServer_02</td>
<td>Signed 16-bit value</td>
<td>&quot;SI6i_OPCServer_02&quot;, &quot;&quot;, 2</td>
</tr>
<tr>
<td>SERVER_PC_SI6i_OPCServer_03</td>
<td>Signed 16-bit value</td>
<td>&quot;SI6i_OPCServer_03&quot;, &quot;&quot;, 2</td>
</tr>
<tr>
<td>SERVER_PC_SI6i_OPCServer_04</td>
<td>Signed 16-bit value</td>
<td>&quot;SI6i_OPCServer_04&quot;, &quot;&quot;, 2</td>
</tr>
</tbody>
</table>
### C: Creating WinCC picture

<table>
<thead>
<tr>
<th></th>
<th>Creating WinCC picture</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creating a WinCC picture to visualize the previously created tags. To do so, open the Graphics Designer editor using <code>R</code> and Open.</td>
</tr>
</tbody>
</table>

![Graphics Designer editor](image1)

<table>
<thead>
<tr>
<th></th>
<th>The Graphics Designer editor is displayed. In it, a new WinCC picture is already open.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Configuring a Smart object <code>I/O Field</code> to display the first tag. Select the I/O field in the object palette and place it onto the picture using the mouse.</td>
</tr>
</tbody>
</table>

![Object Palette](image2)
After placement of the I/O field on the picture, its configuration dialog opens. In the Tag field, the tag SERVER_PC_S16i_OPCServer_01 is set using the button shown in the following.

Tag updates are left at 2s. The additional set options should retain their default values. Finish the dialog with OK.
C: Creating WinCC picture

4 Changes of output format for I/O field.
Open its property dialog. This is done by clicking \( \text{R} \) on the I/O field and Properties.

5 The Object Properties dialog opens.
On the Properties tab register, select the Output/Input entry in the left window. Using \( \text{D} \) on the set output value will make the display field editable. Enter the new format s99999. Using this format, the I/O field is capable to display signed values with a maximum of 5 digits.

6 Creating an additional three I/O fields to display the remaining tags.
The procedure is analogous to Steps 2 to 5 as described.
C: Creating WinCC picture

7

The picture must be saved.
In the example project, it was saved under the name com_3_OPCClient_01.pdl. The picture may be switched directly from Graphics Designer into Runtime by using the button displayed in the following.

Once the picture is in Runtime and the network connection has been established, the current tag values of the server project are displayed. These may also be changed by input of values into the individual I/O fields. Of course, the server project must also be in Runtime.

If no connection exists, the I/O fields are shown in gray tones. In this case, some error must exist in some part of the communication link.
3.9.4 Diagnostics of Communication Link Using OPC

The following description shows options available for diagnostics of the communication link between the WinCC project WinCC_OPC_SERVER and the WinCC project WinCC_OPC_CLIENT.

Depending on transport protocol used (such as TCP/IP), time-outs of up to 6 minutes may occur. Therefore, under certain circumstances, corrections after connections disruptions may take effect after several minutes only.

- A: WinCC Explorer
- B: Channel Diagnosis
A: WinCC Explorer

### A: WinCC Explorer

1. Diagnostics of communication link in WinCC Explorer.
   Switch the WinCC_OPC_CLIENT project into Runtime. This is done in WinCC Explorer using the toolbar button displayed in the following. The WinCC_OPC_SERVER project must also be in Runtime.

2. In WinCC Explorer, using the menu Tools ➔ Connection Status, a dialog may be opened to monitor all configured connections. However, this menu item is only active if the project is in Runtime.

3. The Status - Logical Connections dialog is opened.
   This dialog lists all configured connections. In the current example, only the connection WinCC_OPC_01 exists.
   The displayed values correspond to the status at the moment the dialog was opened. By selecting the corresponding checkbox, a cyclic display update may also be achieved.
Another option to obtain information on the connection status in general but also on the connection status of individual tags is provided by tag management.

The status of a configured connection may be obtained as a tooltip by simply moving the mouse over it.

The current process value of a certain tag, as well as its status, may be obtained as a tooltip by simply moving the mouse over it. This procedure allows determination of errors of a single tag only, not of errors concerning the entire connection.
B: Channel Diagnosis

1. Diagnostics of communication link using the WinCC Channel Diagnosis program.
   This is started using Start → SIMATIC → WinCC → Tools → Channel Diagnosis.

2. The WinCC Channel Diagnosis program is opened.
   The Channels/Connections tab register displays exact information on the status of each configured connection. The default value for display update is one second. The update cycle may be changed in the lower input field.
3.10 Communication WinCC - WinCC Using OPC XML

Projects and files to be generated in this chapter may also be loaded onto your hard disk directly from the Online Support (link "Info" on http://support.automation.siemens.com/WW/view/en/21320307).

There is the option of copying the following components to hard disk:

- **WinCC_OPC_XML_SERVER**
  The Server WinCC project to be generated.

- **WinCC_OPC_XML_CLIENT**
  The Client WinCC project to be generated.

This chapter describes in detail the implementation of a communication link between two WinCC stations using OPC.

The WinCC OPC XML Server is installed on the computer serving as server which provides the data of a WinCC project to other applications on the computer, as well as to the entire connected network environment and the internet.

**Summary on Example Design**

The WinCC OPC XML Server must be installed from the WinCC CD on the computer serving as server. This may have already happened during installation of WinCC.

Both WinCC stations may be connected using any network connection or the internet.
Summary of Configuration Steps

The following summary lists all configuration segments necessary for establishing the communication link.

- Configuration of WinCC stations
- Generation of WinCC project WinCC_OPC_XML_SERVER
- Generation of WinCC project WinCC_OPC_XML_CLIENT
- Diagnostics of communication link

Required software

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IIS</td>
<td>Internet Information Server.</td>
</tr>
<tr>
<td>WinCC</td>
<td>WinCC with OPC Server as well as OPC Client to create WinCC projects.</td>
</tr>
</tbody>
</table>

Required hardware on computer

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network connection</td>
<td>Any network connection to establish link to the internet.</td>
</tr>
</tbody>
</table>
3.10.1 Requirement for Utilization of OPC XML

OPC XML permits access to process tags through the internet. In order to operate OPC XML, additional software components must be installed. The following installation sequence must be observed.

1. Internet Information Server (IIS)
2. Microsoft .NET Framework V1.1
3. WinCC OPC XML Server

Internet Information Server (IIS)

The Internet Information Server must be installed prior to the WinCC OPC XML Server.

<table>
<thead>
<tr>
<th>Installation of IIS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open Control Panel. In the Control Panel, select the Add or Remove Programs item.</td>
</tr>
<tr>
<td>2. In the Add or Remove Programs dialog, select Add or Remove Windows Components.</td>
</tr>
<tr>
<td>3. The Windows Components Wizard opens. In this dialog, select and install IIS.</td>
</tr>
</tbody>
</table>

Microsoft .NET Framework V 1.1

The .NET Framework is also a requirement for utilization of the WinCC OPC XML Server. You may download the setup for .NET Framework directly from the Microsoft homepage.

http://msdn.microsoft.com/downloads
3.10.2 Configuration of WinCC Stations for OPC XML

The following description contains notes to be taken into consideration during configuration of WinCC stations.

- A: Installing software components
- B: Setting of Authentication
A: Installing software components

1 Required are the WinCC OPC XML Server as well as the WinCC OPC XML Client of WinCC. The WinCC OPC XML servers are located on the WinCC Installation CD. The WinCC OPC XML client is automatically installed with WinCC.

The WinCC OPC XML server must be installed on the computer which will serve as server. Requirements for installation and utilization of the WinCC OPC XML server are described in Chapter Requirements for Utilization of OPC-XML.

Following installation of components on the respective computers, these computers must be rebooted.
## B: Setting of Authentication

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| 1 | Access authorizations must be set on the computer which serves as WinCC OPC XML server.  
| 2 | In the Management Panel of Internet Information Services, a new virtual folder has been created for the WinCC OPC XML server under Standard Web site. The Properties dialog opens using Properties on item WinCC OPC XML. |
B: Setting of Authentication

3 Using the Directory Security tab register, you may edit the control for Anonymous Access and authentication. The current example activates anonymous access, and user name and password are not modified. Finish the dialog with OK.

Anonymous access should not be used for security reasons. However, in our case it represents the simplest option for authentication.
3.10.3 Creating WinCC Project WinCC_OPC_XML_SERVER

The following description shows in detail the necessary configuration steps for creating and successful commissioning of WinCC project WinCC_OPC_XML_SERVER.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the WinCC project WinCC_OPC_XML_SERVER.

- A: Creating WinCC project
- B: Creating internal tags
- C: Creating WinCC picture
A: Creating WinCC project

1. Creating a new WinCC project in WinCC Explorer. This is started using Start → SIMATIC → WinCC → Windows Control Center.

2. WinCC Explorer is opened. Using menu item File → New, the dialog to specify the properties of a new WinCC project opens. The following example project creates a single-user project. Finish the dialog with OK.
A: Creating WinCC project

3 The Create a New Project dialog opens. Enter a project name for the new project. WinCC projects created as part of this manual begin with a character sequence of WinCC, and furthermore contain a description of communication partners, as well as communication type used. The current example has the name WinCC_OPC_XML_SERVER.

Furthermore, in the Project Path field, the storage location of the new project must be set.

The Create a New Project dialog is closed by clicking the Create button.
Creating internal tags

1. Creating internal tags required for example.
   This is done in Tag Management using right-click on the entry for Internal Tags and New Tag.

2. The property dialog of the tag opens.
   The example uses S16i_OPCServer_01 as the name for the first tag. The tag is of data type Signed 16-Bit Value.
B: Creating internal tags

3 Creating the remaining required tags.
The procedure is analogous to Steps 1 to 3 as described. Names, data types and addresses of tags used in this example may be obtained from the following display.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>@ConnectedRTCie...</td>
<td>Unsigned 16-bit</td>
<td></td>
</tr>
<tr>
<td>@CurrentUser</td>
<td>Text tag 8-bit char</td>
<td></td>
</tr>
<tr>
<td>@DeltaLoaded</td>
<td>Unsigned 32-bit</td>
<td></td>
</tr>
<tr>
<td>@LocalMachineName</td>
<td>Text tag 8-bit char</td>
<td></td>
</tr>
<tr>
<td>@RedundantServe...</td>
<td>Unsigned 16-bit</td>
<td></td>
</tr>
<tr>
<td>S16i_OPCServer_01</td>
<td>Signed 16-bit value</td>
<td></td>
</tr>
<tr>
<td>S16i_OPCServer_02</td>
<td>Signed 16-bit value</td>
<td></td>
</tr>
<tr>
<td>S16i_OPCServer_03</td>
<td>Signed 16-bit value</td>
<td></td>
</tr>
<tr>
<td>S16i_OPCServer_04</td>
<td>Signed 16-bit value</td>
<td></td>
</tr>
</tbody>
</table>
### C: Creating WinCC picture

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creating a WinCC picture to visualize the previously created tags. To do so, open the Graphics Designer editor using <code>R</code> and <code>Open</code>.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Graphics Designer editor" /></td>
</tr>
<tr>
<td>2</td>
<td>The Graphics Designer editor is displayed. In it, a new WinCC picture is already open. Configuring a Smart object → I/O Field to display the first tag. Select the I/O field in the object palette and place it onto the picture using the mouse.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Object Palette" /></td>
</tr>
</tbody>
</table>
3 After placement of the I/O field on the picture, its configuration dialog opens. In the Tag field, the tag S16i_OPSCServer_01 is set using the button shown in the following.

Tag updates are set to Upon Change. The additional set options should retain their default values. Finish the dialog with OK.
C: Creating WinCC picture

4 Changes of output format for I/O field.
Open its property dialog. This is done by clicking \(\text{Ctrl} + \text{R}\) on the I/O field and Properties.

5 The Object Properties dialog opens.
On the Properties tab register, select the Output/Input entry in the left window. Using \(\text{Ctrl} + \text{D}\) on the set output value will make the display field editable. Enter the new format s99999. Using this format, the I/O field is capable to display signed values with a maximum of 5 digits.

6 Creating an additional three I/O fields to display the remaining tags.
The procedure is analogous to Steps 2 to 5 as described.
C: Creating WinCC picture

7 Creating a simple tag simulation.
The sum of tags S16i_OPCServer_01 and S16i_OPCServer_02 is supposed to be stored in tag S16i_OPCServer_03.
The value of tag S16i_OPCServer_04 is supposed to be incremented every 250ms.
The requirements posed are satisfied by two C actions. Each is generated using Properties ➔ Geometry ➔ Position X of the I/O field displaying the respective tag.
A detailed description of the C action is found following this section.

8 The picture must be saved.
In the example project, it was saved under the name OPC_XML_Server_01.pdl. The picture may be switched directly from Graphics Designer into Runtime by using the button displayed in the following.

These may also be changed by input of values into the individual I/O fields.
C action to generate sum

```c
#include "apedefap.h"

long XasIn(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName)
{
    //get tag values
    int iValue_01 = GetTagSDWord("S16i_OPCServer_01");
    int iValue_02 = GetTagSDWord("S16i_OPCServer_02");

    //calculate sum and set tag value
    SetTagSDWord("S16i_OPCServer_03", (iValue_01 + iValue_02));

    //return constant property value
    return GetLeft(lpszPictureName, lpszObjectName);
}
```

- The above described C action is configured for the I/O Field3 object using Properties Geometry Position X. The C action is triggered upon changes of tags S16i_OPCServer_01 and S16i_OPCServer_02.
- The values of both tags S16i_OPCServer_01 and S16i_OPCServer_02 are read. Their sum is formed and written to tag S16i_OPCServer_03.
- The C action is configured for an object property which serves to provide a trigger. The current value of the property is returned to it.

C action for incrementing

```c
#include "apedefap.h"

long XasIn(char* lpszPictureName, char* lpszObjectName, char* lpszPropertyName)
{
    //get tag value
    int iValue = GetTagSDWord("S16i_OPCServer_04");

    if (iValue < 10000)
    {
        //increment and set tag value
        SetTagSDWord("S16i_OPCServer_04", ++iValue);
    }
    else
    {
        //reset tag value
        SetTagSDWord("S16i_OPCServer_04", 0);
    }

    //return constant property value
    return GetLeft(lpszPictureName, lpszObjectName);
}
```

- The above described C action is configured for the I/O Field4 object using Properties Geometry Position X. The C action is triggered at 250ms.
- The value of tag S16i_OPCServer_04 is read. If this has not yet reached 10000, it is incremented and rewritten into the tag. Otherwise the tag value is set to zero.
- The C action is configured for an object property which serves to provide a trigger. The current value of the property is returned to it.
3.10.4 Creating WinCC Project WinCC_OPC_XML_CLIENT

The following description shows in detail the necessary configuration steps for creating and successful commissioning of WinCC project WinCC_OPC_XML_CLIENT.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the WinCC project WinCC_OPC_XML_CLIENT.

- A: Creating WinCC project
- B: Establishing connection
- C: Creating WinCC picture
### A: Creating WinCC project

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| **1** | Creating a new WinCC project in WinCC Explorer.  
WinCC Explorer is started using Start → SIMATIC → WinCC → Windows Control Center. |
| **2** | WinCC Explorer is opened.  
Using menu item File → New, the dialog to specify the properties of a new WinCC project opens.  
The following example project creates a single-user project.  
Finish the dialog with OK. |
A: Creating WinCC project

3 The Create a New Project dialog opens.

Enter a project name for the new project. WinCC projects created as part of this manual begin with a character sequence of WinCC, and furthermore contain a description of communication partners, as well as communication type used. The current example has the name WinCC_OPCODE/XML_CLIENT.

Furthermore, in the Project Path field, the storage location of the new project must be set.

The Create a New Project dialog is closed by clicking the Create button.
B: Establishing connection

1. The new project is displayed in WinCC Explorer.
   Installing of required communication driver. This is done by clicking on the Tag Management item and Add New Driver.

2. The Add New Driver Dialog opens.
   It offers a selection of all communication drivers available for installation.
   In the current example, the OPC communication driver is required. It must be selected in the dialog. Close the dialog with Open.

3. The newly added OPC communication driver is displayed as a subitem of Tag Management.
   Establishing a connection to a certain OPC server, as well as selection of items required from this server, may be facilitated using the OPC Item Manager. This is started using on the entry for OPC Groups (OPCHN Unit #1) channel unit and System Parameters.
B: Establishing connection

4 The OPC Item Manager opens. Here the desired OPC server may be selected. It may be located on the local computer or on another computer accessible through a network connection.

Using the OPC Web Server button, a connection may be established to the WinCC OPC XML server.

5 The Add OPC Web Server dialog opens. Here, the URL of the WinCC OPC XML server must be specified. Enter the URL as follows: "http://xxx/wincc-opc-xml/dawebservice.asmx". Replace xxx with either the IP address or the computer name where OPC XML Web Service runs. Close the dialog by clicking the OK button.
B: Establishing connection

6 The OPC Web Server is now visible in OPC Item Manager. The just added OPC Web Server must now be selected. Using the Browse Server button, you may obtain a summary of all items made available by this WinCC-OPC XML server. However, this is only the case if the WinCC project was opened from the server station.

7 The Filter Criteria dialog opens. This allows you more detailed specification of the type of desired items. If you wish a display of available items, no settings need to be made here. The dialog may be concluded with Continue.
### B: Establishing connection

8. A dialog for the selection of desired items is opened. The four internal tags created previously in the server project are offered for selection as WinCC OPC XML server items. However, this is only the case if the WinCC project on the server station is in Runtime. These four items must be selected in the right window. Using the Add Items button, these may be inserted into the WinCC project. If you do not have any items available for selection in this dialog, use Error Diagnostics to check your network connections.

![OPCXML Connection Example](image)

9. If no connection has been configured yet, a new connection may now be established. The OPCTags dialog must be closed with Yes.

![OPCXML Connection Example](image)
### B: Establishing connection

**10** The New Connection dialog opens. Only the name of the new connection needs to be specified. The current example uses the name WinCC-OPC-XML-Connection-01. Close the dialog with OK.

![New Connection Dialog](image1)

**11** The Add Tag dialog opens. Here you specify which connection the tags should be added to. In the current example, they are supposed to be added to the previously created connection WinCC-OPC-XML-Connection-01. This must be selected in the lower Add Here field.

The tag names used by OPC Item Manager may have optionally added a prefix and a suffix. In the current example, the tag name should be preceded by the prefix OPC_Server.

The WinCC tags are created using the Finish button.

The OPC Item Manager is closed using the Finish button.

![Add Tags Dialog](image2)
**B: Establishing connection**

The following display lists WinCC tags generated by the OPC Item Manager.
### C: Creating WinCC picture

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creating a WinCC picture to visualize the previously created tags. To do so, open the Graphics Designer editor using <code>F2</code> and Open.</td>
</tr>
<tr>
<td></td>
<td><img src="image1" alt="Graphics Designer" /></td>
</tr>
</tbody>
</table>
| 2 | The Graphics Designer editor is displayed. In it, a new WinCC picture is already open. Configuring a Smart object `I/O Field` to display the first tag. Select the `I/O field` in the object palette and place it onto the picture using the mouse. | ![Object Palette](image2)
### C: Creating WinCC picture

3 After placement of the I/O field on the picture, its configuration dialog opens.

In the Tag field, the tag `OPC_ServerS16i.OPCServer_01` is set using the button shown in the following.

![Tag configuration dialog](image)

Tag updates are left at 2s. The additional set options should retain their default values. Finish the dialog with OK.
C: Creating WinCC picture

4 Changes of output format for I/O field.
Open its property dialog. This is done by clicking on the I/O field and Properties.

5 The Object Properties dialog opens.
On the Properties tab register, select the Output/Input entry in the left window. Using on the set output value will make the display field editable. Enter the new format s99999. Using this format, the I/O field is capable to display signed values with a maximum of 5 digits.

6 Creating an additional three I/O fields to display the remaining tags.
The procedure is analogous to Steps 2 to 5 as described.
The picture must be saved.
In the example project, it was saved under the name OPC.XML_CLIENT_01.pdl. The picture may be switched directly from Graphics Designer into Runtime by using the button displayed in the following.

Once the picture is in Runtime and the network connection has been established, the current tag values of the server project are displayed. These may also be changed by input of values into the individual I/O fields. Of course, the server project must also be in Runtime.

If no connection exists, the I/O fields are shown in gray tones. In this case, some error must exist in some part of the communication link.
3.10.5 Diagnostics of Communication Link Using OPC XML

The following description shows options available for diagnostics of the communication link between the WinCC project WinCC_OPC_SERVER and the WinCC project WinCC_OPC_CLIENT.

Depending on transport protocol used (such as TCP/IP), time-outs of up to 6 minutes may occur. Therefore, under certain circumstances, corrections after connection disruptions may take effect after several minutes only.

A: WinCC Explorer

<table>
<thead>
<tr>
<th></th>
<th>A: WinCC Explorer</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Diagnostics of communication link in WinCC Explorer.</td>
</tr>
<tr>
<td></td>
<td>Switch the WinCC_OPC_CLIENT project into Runtime. This is done in WinCC Explorer using the toolbar button displayed in the following. The WinCC_OPC_SERVER project must also be in Runtime.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Activate" /></td>
</tr>
<tr>
<td>2</td>
<td>In WinCC Explorer, using the menu item Tools ➔ Connection Status, a dialog may be opened to monitor all configured connections. However, this menu item is only active if the project is in Runtime.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Tools" /></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Language..." /></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Status of Driver Connections" /></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Status of Server Connections" /></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Status of Client Connections" /></td>
</tr>
</tbody>
</table>
The Status - Logical Connections dialog is opened. This dialog lists all configured connections. In the current example, only the connection WinCC_OPC_01 exists.

The displayed values correspond to the status at the moment the dialog was opened. By selecting the corresponding checkbox, a cyclic display update may also be achieved.
A: WinCC Explorer

4 Another option to obtain information on the connection status in general but also on the connection status of individual tags is provided by Tag Management.

The status of a configured connection may be obtained as a tooltip by simply moving the mouse over it.

<table>
<thead>
<tr>
<th>Name</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC-OPC-XML-Connection_01</td>
<td><a href="http://192.1">http://192.1</a></td>
</tr>
</tbody>
</table>

Status: OK

The current process value of a certain tag, as well as its status, may be obtained as a tooltip by simply moving the mouse over it. This procedure allows determination of errors of a single tag only, not of errors concerning the entire connection.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPC_Server5161.OPCServer_01</td>
<td>Signed</td>
</tr>
<tr>
<td>OPC_Server5161.OPCServer_02</td>
<td>Signed</td>
</tr>
<tr>
<td>OPC_S</td>
<td>Process value: 0</td>
</tr>
<tr>
<td>OPC_S</td>
<td>Quality: 4c</td>
</tr>
<tr>
<td>OPC_S</td>
<td>Start value</td>
</tr>
</tbody>
</table>
B: Channel Diagnosis

1. Diagnostics of communication link using the WinCC Channel Diagnosis program.
   This is started using Start ➔ SIMATIC ➔ WinCC ➔ Tools ➔ Channel Diagnosis.

2. The WinCC Channel Diagnosis program is opened.
   The Channels/Connections tab register displays exact information on the status of each configured connection. The default value for display update is one second. The update cycle may be changed in the lower input field.
3.10.6 Error Diagnostics (OPC XML)

The following description shows options available for diagnostics of the communication link between the WinCC project WinCC_OPC_XML_SERVER and the WinCC project WinCC_OPC_XML_CLIENT.

Problem: The WinCC_OPC_XML_Server is not available

<table>
<thead>
<tr>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Try to ping the server.</td>
</tr>
<tr>
<td>Open the command prompt using Start ➔ Programs ➔ Accessories ➔ Command prompt. Enter the following command: ping xxx.xxx.xxx.xxx Replace xxx with the IP address of the server. If you receive a reply, check the entered web address once again.</td>
</tr>
<tr>
<td>➔ The WinCC OPC XML server is available, but the website is not</td>
</tr>
</tbody>
</table>
Problem: The WinCC OPC XML server is available, but the website is not

<table>
<thead>
<tr>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Check whether or not IIS is activated. Open the Management Panel of IIS and select the item Standard Web site. If the standard Web site is not activated, activate it and again attempt to establish operation of the WinCC OPC XML Client.</td>
</tr>
<tr>
<td>2. Check the physical network connections of your computer. Try to access a different website. If the WebNavigator Server is still not available, check with your System Administrator.</td>
</tr>
</tbody>
</table>
3.11 Communication Using WinCC Web Navigator

Projects and files to be generated in this chapter may also be loaded onto your hard disk directly from the Online Support (link "Info" on http://support.automation.siemens.com/WW/view/en/21320307).

There is the option of copying the following components to hard disk:

- **WinCC_Web_SERVER**
  
  The Server WinCC project to be generated.

This chapter describes in detail the implementation of a communication link between two WinCC stations using WinCC WebNavigator.

The WinCC WebNavigator Server is installed on the computer serving as server which provides the data of a WinCC project to the entire connected network environment as well as the internet.

**Summary on Example Design**

The WinCC WebNavigator Server must be installed from the WinCC WebNavigator CD on the computer serving as server.

Both WinCC stations may be connected using any network connection or the internet.
Summary of Configuration Steps

The following summary lists all configuration segments necessary for establishing the communication link.

- Configuring WinCC Stations
- Establishing communication link
- Commissioning of WinCC stations
- Generation of WinCC project WinCC_Web_Server
- Error diagnostics

Required software

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IIS</td>
<td>Internet Information Server.</td>
</tr>
<tr>
<td>WinCC</td>
<td>WinCC with WinCC WebNavigator Server as well as WebNavigator Client.</td>
</tr>
</tbody>
</table>

Required hardware on computer

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network connection</td>
<td>Any network connection to establish link to the internet.</td>
</tr>
</tbody>
</table>
3.11.1 Configuring WinCC Stations for Web Navigator

The following description contains notes to be taken into consideration during configuration of WinCC stations.

- A: Installing software component - Server
- B: Installing software component - Client
A: Installing software component - Server

<table>
<thead>
<tr>
<th></th>
<th>A: Installing software component - Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>For WinCC WebNavigator, Internet Information Services are required. Open Control Panel. In the Control Panel, select the</td>
</tr>
<tr>
<td></td>
<td>Add or Remove programs item. In the Add or Remove programs dialog, select Add or Remove Windows Components. The Windows</td>
</tr>
<tr>
<td></td>
<td>Components Wizard opens. In this dialog, select and install IIS.</td>
</tr>
<tr>
<td>2</td>
<td>Installing WinCC WebNavigator Server. Insert the WinCC WebNavigator CD. The setup for WinCC WebNavigator starts. Execute</td>
</tr>
<tr>
<td></td>
<td>all steps of the installation wizard.</td>
</tr>
</tbody>
</table>
### B: Installing software component - Client

<table>
<thead>
<tr>
<th></th>
<th>Installing software component - Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Installing WebNavigator Client.</td>
</tr>
<tr>
<td>2</td>
<td>Select the option Complete and finish the setup for WebNavigator Client.</td>
</tr>
</tbody>
</table>

![Setup Type](image)

**Setup Type:**
- **Complete:** All program features will be installed. (Requires the most disk space.)
- **Custom:** Choose which program features you want installed and where they will be installed. Recommended for advanced users.
3.11.2 Creating WinCC Project WinCC_Web_Server

The following description shows in detail the necessary configuration steps for creating and successful commissioning of WinCC project WinCC_Web_Server.

Summary of Configuration Steps

The following summary lists all necessary configuration steps to create the WinCC project WinCC_Web_Server.

- A: Creating WinCC project
- B: Creating internal tags
- C: Creating WinCC picture
A: Creating WinCC project

   This is started using Start → SIMATIC → WinCC → Windows Control Center.

2. WinCC Explorer is opened.
   Using menu item File → New, the dialog to specify the properties of a new WinCC project opens.
   The following example project creates a single-user project.
   Finish the dialog with OK.
A: Creating WinCC project

3 The Create a New Project dialog opens. Enter a project name for the new project. WinCC projects created as part of this manual begin with a character sequence of WinCC, and furthermore contain a description of communication partners, as well as communication type used. The current example has the name WinCC_Web_Server. Furthermore, in the Project Path field, the storage location of the new project must be set. The Create a New Project dialog is closed by clicking the Create button.
B: Creating internal tags

1. Creating internal tags required for example.
   This is done in Tag Management using the entry for Internal Tags and New Tag.

2. The property dialog of the tag opens.
   The example uses S16i_Web_01 as the name for the first tag. The tag is of data type Signed 16-Bit Value.
B: Creating internal tags

3 Creating the remaining required tags.

The procedure is analogous to Steps 1 to 3 as described. Names, data types, and addresses of tags used in this example may be obtained from the following display.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>S16i_Web_01</td>
<td>Signed 16-bit value</td>
</tr>
<tr>
<td>S16i_Web_02</td>
<td>Signed 16-bit value</td>
</tr>
<tr>
<td>S16i_Web_03</td>
<td>Signed 16-bit value</td>
</tr>
<tr>
<td>S16i_Web_04</td>
<td>Signed 16-bit value</td>
</tr>
</tbody>
</table>
C: Creating WinCC picture

1. Creating a WinCC picture to visualize the previously created tags.
   To do so, open the Graphics Designer editor using `Open` and `Open`.

   ![Graphics Designer editor]

2. The Graphics Designer editor is displayed. In it, a new WinCC picture is already open.
   Configuring a Smart object `→ I/O Field` to display the first tag. Select the I/O field in the object palette and place it onto the picture using the mouse.

   ![Object Palette]

---

WinCC Communication Manual V6  Edition 12/2004, 6AV6392-1CA06-0AB0
3 After placement of the I/O field on the picture, its configuration dialog opens.
In the Tag field, the tag S16i_Web_01 is set using the button shown in the following.

Tag updates are set to Upon Change. The additional set options should retain their default values. Finish the dialog with OK.
C: Creating WinCC picture

4 Changes of output format for I/O field.
Open its property dialog. This is done by clicking R on the I/O field and Properties.

5 The Object Properties dialog opens.
On the Properties tab register, select the Output/Input entry in the left window. Using D on the set output value will make the display field editable. Enter the new format s99999. Using this format, the I/O field is capable to display signed values with a maximum of 5 digits.

6 Creating an additional three I/O fields to display the remaining tags.
The procedure is analogous to Steps 2 to 5 as described.
### C: Creating WinCC picture

#### 7
Creating a simple tag simulation.
The sum of tags S16i_Web_01 and S16i_Web_02 is supposed to be stored in tag S16i_Web_03.
The value of tag S16i_Web_04 is supposed to be incremented every 250ms.
The requirements posed are satisfied by two C actions. Each is generated using Properties ➔ Geometry ➔ Position X of the I/O field displaying the respective tag.
A detailed description of the C action is found following this section.

#### 8
The picture must be saved.
In the example project, it was saved under the name Web_Server_01.pdl. The picture may be switched directly from Graphics Designer into Runtime by using the button displayed in the following.

These may also be changed by input of values into the individual I/O fields.
C action to generate sum

```c
#include "spdefap.h"
long_draw(char* pszPictureName, char* pszObjectName, char* pszPropertyName)
{
    //get tag values
    int iValue_01 = GetTagSDWord('S16i_Web_01');
    int iValue_02 = GetTagSDWord('S16i_Web_02');
    //calculate sum and set tag value
    SetTagSDWord('S16i_Web_03', (iValue_01 + iValue_02));
    //return constant property value
    return GetLeft(pszPictureName, pszObjectName);
}
```

- The above described C action is configured for the I/O Field3 object using Properties -> Geometry -> Position X. The C action is triggered upon changes of tags S16i_Web_01 and S16i_Web_02.
- The values of both tags S16i_Web_01 and S16i_Web_02 are read. Their sum is formed and written to tag S16i_Web_03.
- The C action is configured for an object property which serves to provide a trigger. The current value of the property is returned to it.

C action for incrementing

```c
#include "spdefap.h"
long_draw(char* pszPictureName, char* pszObjectName, char* pszPropertyName)
{
    //get tag value
    int iValue = GetTagSDWord('S16i_Web_04');
    if (iValue < 10000)
    {
        //increment and set tag value
        SetTagSDWord('S16i_Web_04', ++iValue);
    }
    else
    {
        //reset tag value
        SetTagSDWord('S16i_Web_04', 0);
    }
    //return constant property value
    return GetLeft(pszPictureName, pszObjectName);
}
```

- The above described C action is configured for the I/O Field4 object using Properties Geometry Position X. The C action is triggered at 250ms.
- The value of tag S16i_Web_04 is read. If this has not yet reached 10000, it is incremented and rewritten into the tag. Otherwise the tag value is set to zero.
- The C action is configured for an object property which serves to provide a trigger. The current value of the property is returned to it.
3.11.3 Configuring WinCC Web Navigator Server

The following chapter shows in detail the required configuration steps in WinCC project WinCC_Web_Server in order to configure the WinCC WebNavigator Server.

- A: Establishing a user
- B: Configuring WebNavigator
- C: Publishing WinCC pictures
### A: Establishing a user

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Opening User Administrator. This is done in WinCC Explorer using the User Administrator item.</td>
</tr>
<tr>
<td>2</td>
<td>Establishing a new group in User Administrator. By pressing the button, a new user group is added. For example, the name WebUser is entered as a group name.</td>
</tr>
<tr>
<td>3</td>
<td>Establishing a new user. This is done using the button. In the example, the user is issued the user name WebClientUser with password 123456.</td>
</tr>
<tr>
<td>4</td>
<td>Activating the WebNavigator option for the just created users. This is done by activating the WebNavigator checkbox. The picture Web_Server_01 is entered as the start-up picture. User Administrator may be closed.</td>
</tr>
</tbody>
</table>

![WebNavigator](attachment:image.png)
B: Configuring WebNavigator

1. Starting Web Configurator. This is done in WinCC Explorer using Ctrl+R on the items WebNavigator and Web Configurator.

2. Start the WinCC Web Configurator Wizard which will guide you through the WinCC Web Navigator Server configuration. Push the Continue button.
B: Configuring WebNavigator

3 On the next page of the Wizard, you may select if the WinCC WebNavigator Server is supposed to be created as the new Standard Web site or to be added to another existing website. In this example, the WinCC WebNavigator Server is added to an already existing virtual folder. Using the Search button, you may search for an existing web site.

4 If you have successfully installed IIS, a standard Web site already exists. Select the existing standard Web site and close the dialog by clicking OK.
B: Configuring WebNavigator

The just selected standard Web site is now recorded in the dialog. Using the Continue button, you may switch to the next page in the Wizard.

The settings for this page are left at the default values in this example. Using the Finish button, the configuration of WinCC WebNavigator Server is concluded.
C: Publishing WinCC pictures

1. Starting Web View Publisher. This is done in WinCC Explorer using the items WebNavigator and Web View Publisher.

2. The WinCC Web Publishing Wizard is started. By pushing the Continue button, you get to the next page of the WinCC Web Publishing Wizard.
3 C: Publishing WinCC pictures

On the next page of the Wizard, the path to pictures and WebServer is specified. In this example, no server prefix is issued. The first path to be specified must point to the directory GraCs of your WinCC project. The second directory to be specified must point to the installation directory of WinCC-WebNavigator-Server\Server\Web\Pictures. The Wizard page may be closed with Continue.
C: Publishing WinCC pictures

4 In the next step, the pictures to be published may be selected. In this example, the picture Web_Server_01.PDL is selected. The Wizard page may be closed with Continue.

5 In the next step, functions may be selected. This example does not contain any functions. The page may be closed with Continue.
The pictures are now published. Using Finish, the Wizard may be closed.

The WinCC Web Publishing Wizard is finished collecting information.

To publish your pictures, press Finish!

Ready.

The picture(s) have been published successfully.

Don't show this dialog in the future.

OK

Finish
3.11.4 Commissioning of WinCC Web Client

This chapter describes access to WinCC WebNavigator Server using WinCC WebNavigator Client.

A: Starting WinCC WebNavigator Client

<table>
<thead>
<tr>
<th></th>
<th>A: Starting WinCC WebNavigator Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open Internet Explorer.</td>
</tr>
<tr>
<td></td>
<td>In the address line, enter <a href="http://xxx.xxx.xxx.xxx/WebNavigator">http://xxx.xxx.xxx.xxx/WebNavigator</a>. Replace xxx with the IP address of the WinCC WebNavigator Server. Confirm the entered address with the Return key.</td>
</tr>
<tr>
<td>2</td>
<td>During the initial use of WebNavigator Client, you must confirm the security warning with Yes.</td>
</tr>
</tbody>
</table>
A: Starting WinCC WebNavigator Client

3 Register at Server. Enter user name and password of user WebClientUser, as previously created in UserAdministration.

4 Upon successful logon at the WinCC WebNavigator Server, the start-up picture set for this user is loaded.
3.11.5 Error Diagnostics (WinCC Web Navigator)

The following description shows options available for diagnostics of the communication link between the WinCC project WinCC_Web_Server and WinCC WebNavigator Client.

Problem: WinCC WebNavigator server is not available

<table>
<thead>
<tr>
<th>Procedure</th>
<th>1 Try to ping the server.</th>
</tr>
</thead>
</table>
|           | Open the command prompt using Start ➔ Programs ➔ Accessories ➔ Command prompt. Enter the following command: ping xxx.xxx.xxx.xxx Replace xxx with the IP address of the server. If you receive a reply, check the entered web address once again. ➔ The WinCC WebNavigator server is available, but the website is not available.
| 2 WinCC WebNavigator server is not available using ping |
|           | Try to open the WebNavigator Client on the WebNavigator Server. To do so, open Internet Explorer and, instead of the IP address of the server, enter localhost. ➔ WinCC WebNavigator Server is running but cannot be reached through the internet. |
| 3 WebNavigator server is not available on the server computer using localhost. | ➔ The WinCC WebNavigator server is available, but the website is not available. |
Problem: The WinCC WebNavigator server is available, but the website is not

<table>
<thead>
<tr>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
</tbody>
</table>

Problem: WinCC WebNavigator Server is running but cannot be reached through the internet

<table>
<thead>
<tr>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
</tbody>
</table>
## Index

<table>
<thead>
<tr>
<th>A</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access</td>
<td>27</td>
</tr>
<tr>
<td>Access Methods</td>
<td>9</td>
</tr>
<tr>
<td>Industrial Ethernet</td>
<td>27</td>
</tr>
<tr>
<td>MPI</td>
<td>20</td>
</tr>
<tr>
<td>Access Point</td>
<td>86</td>
</tr>
<tr>
<td>Industrial Ethernet</td>
<td>86</td>
</tr>
<tr>
<td>Actuator-Sensor Level</td>
<td>16</td>
</tr>
<tr>
<td>Acyclic Reading</td>
<td>53</td>
</tr>
<tr>
<td>Addressing</td>
<td>110</td>
</tr>
<tr>
<td>Alarm Logging Runtime</td>
<td>44</td>
</tr>
<tr>
<td>AUI</td>
<td>29</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>B</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bridge</td>
<td>13</td>
</tr>
<tr>
<td>Bus</td>
<td>5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell Level</td>
<td>16</td>
</tr>
<tr>
<td>Central Module</td>
<td>136</td>
</tr>
<tr>
<td>COM Port</td>
<td>63</td>
</tr>
<tr>
<td>COM PROFIBUS</td>
<td>69</td>
</tr>
<tr>
<td>Communication</td>
<td>131</td>
</tr>
<tr>
<td>Communication Driver</td>
<td>63</td>
</tr>
<tr>
<td>Industrial Ethernet</td>
<td>74</td>
</tr>
<tr>
<td>PROFIBUS</td>
<td>67</td>
</tr>
<tr>
<td>Serial Communication</td>
<td>63</td>
</tr>
<tr>
<td>Communication Partners</td>
<td>63, 65, 69</td>
</tr>
<tr>
<td></td>
<td>70, 72, 74</td>
</tr>
<tr>
<td>Industrial Ethernet</td>
<td>74</td>
</tr>
<tr>
<td>MPI</td>
<td>65</td>
</tr>
<tr>
<td>PROFIBUS</td>
<td>67</td>
</tr>
<tr>
<td>PROFIBUS DP</td>
<td>69</td>
</tr>
<tr>
<td>PROFIBUS FDL</td>
<td>72</td>
</tr>
<tr>
<td>PROFIBUS FMS</td>
<td>70</td>
</tr>
<tr>
<td>Serial Communication</td>
<td>63</td>
</tr>
<tr>
<td>Communication Processor</td>
<td>64, 86</td>
</tr>
<tr>
<td></td>
<td>176, 290</td>
</tr>
<tr>
<td>CP 1612</td>
<td>131</td>
</tr>
<tr>
<td>CP 1613</td>
<td>176</td>
</tr>
<tr>
<td>CP 5613</td>
<td>290</td>
</tr>
<tr>
<td>Industrial Ethernet</td>
<td>292</td>
</tr>
<tr>
<td>MPI</td>
<td>73</td>
</tr>
<tr>
<td>PROFIBUS</td>
<td>66</td>
</tr>
<tr>
<td>Restart</td>
<td>86</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>D</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Type</td>
<td>44</td>
</tr>
<tr>
<td>Space Requirement</td>
<td>44</td>
</tr>
<tr>
<td>Diagnosis</td>
<td></td>
</tr>
<tr>
<td>SlotPLC</td>
<td>433</td>
</tr>
<tr>
<td>Web Navigator</td>
<td>533</td>
</tr>
<tr>
<td>Diagnostics</td>
<td></td>
</tr>
<tr>
<td>Hard Net</td>
<td>125</td>
</tr>
<tr>
<td>Industrial Ethernet</td>
<td>125, 170</td>
</tr>
<tr>
<td>OPC</td>
<td>467</td>
</tr>
<tr>
<td>OPC XML</td>
<td>501, 505</td>
</tr>
<tr>
<td>Redundancy</td>
<td>396</td>
</tr>
<tr>
<td>S7 PROFIBUS</td>
<td>340</td>
</tr>
<tr>
<td>S7-OPC</td>
<td>287</td>
</tr>
<tr>
<td>Soft Net</td>
<td>170</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>217</td>
</tr>
<tr>
<td>DP</td>
<td>24, 69</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet Address</td>
<td>86</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>F</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>FDL</td>
<td>24, 72</td>
</tr>
<tr>
<td>Field Level</td>
<td>16</td>
</tr>
<tr>
<td>FMS</td>
<td>24, 70, 344</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>G</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway</td>
<td>13</td>
</tr>
<tr>
<td>Global Script Runtime</td>
<td>44</td>
</tr>
<tr>
<td>Graphics Runtime</td>
<td>44</td>
</tr>
<tr>
<td>H</td>
<td>64</td>
</tr>
<tr>
<td>------------</td>
<td>----</td>
</tr>
<tr>
<td>Hard Net</td>
<td></td>
</tr>
<tr>
<td>Diagnostics</td>
<td></td>
</tr>
<tr>
<td>Industrial Ethernet</td>
<td></td>
</tr>
<tr>
<td>PROFIBUS</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>I</th>
<th>110</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O</td>
<td></td>
</tr>
<tr>
<td>Industrial Ethernet</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td>29</td>
</tr>
<tr>
<td>Access Methods</td>
<td></td>
</tr>
<tr>
<td>Communication Partners</td>
<td></td>
</tr>
<tr>
<td>Diagnostics</td>
<td>125</td>
</tr>
<tr>
<td>Electrical Network</td>
<td></td>
</tr>
<tr>
<td>Optical Network</td>
<td></td>
</tr>
<tr>
<td>Protocol Profiles</td>
<td></td>
</tr>
<tr>
<td>Standardization</td>
<td></td>
</tr>
<tr>
<td>Transfer Medium</td>
<td></td>
</tr>
<tr>
<td>Transport Protocols</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>O</th>
<th>25</th>
<th>32</th>
<th>263</th>
<th>435</th>
</tr>
</thead>
<tbody>
<tr>
<td>OLM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OLP</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OPC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Client</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Diagnostics</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OPC Scout</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Server</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OLC Item Manager</td>
<td>271</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OPC XML</td>
<td>471</td>
<td>473</td>
<td>474</td>
<td></td>
</tr>
<tr>
<td>OPC XML Client</td>
<td></td>
<td>501</td>
<td>505</td>
<td></td>
</tr>
<tr>
<td>OPC XML server</td>
<td></td>
<td>488</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Organization of Data</td>
<td>55</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>P</th>
<th>24</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA</td>
<td></td>
</tr>
<tr>
<td>PDU</td>
<td></td>
</tr>
<tr>
<td>Point to Point</td>
<td>5</td>
</tr>
<tr>
<td>Power Supply Unit</td>
<td>136</td>
</tr>
<tr>
<td>PROFIBUS</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td>67</td>
</tr>
<tr>
<td>Communication Partner</td>
<td>67</td>
</tr>
<tr>
<td>Electrical Network</td>
<td>25</td>
</tr>
<tr>
<td>Number of Participants</td>
<td>22</td>
</tr>
<tr>
<td>Optical Network</td>
<td>25</td>
</tr>
<tr>
<td>PROFIBUS DP</td>
<td>24</td>
</tr>
<tr>
<td>PROFIBUS FDL</td>
<td>24</td>
</tr>
<tr>
<td>PROFIBUS FMS</td>
<td>24</td>
</tr>
<tr>
<td>PROFIBUS PA</td>
<td>24</td>
</tr>
<tr>
<td>Protocol Architecture</td>
<td>24</td>
</tr>
<tr>
<td>S7 Functions</td>
<td>24</td>
</tr>
<tr>
<td>Standard</td>
<td>22</td>
</tr>
<tr>
<td>Transfer Medium</td>
<td>25</td>
</tr>
<tr>
<td>Protocol</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>28</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>R</th>
<th>136</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack</td>
<td></td>
</tr>
<tr>
<td>Redundancy</td>
<td>344</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>396</td>
</tr>
<tr>
<td>Repeater</td>
<td>13</td>
</tr>
<tr>
<td>Ring</td>
<td></td>
</tr>
<tr>
<td>Router</td>
<td></td>
</tr>
<tr>
<td>Runtime</td>
<td></td>
</tr>
</tbody>
</table>
### Index

#### S
- S7 Functions 28
  - Industrial Ethernet 28
  - PROFIBUS 24
- S7 PROFIBUS 24
  - Diagnostics 340
  - S7-OPC 221
  - Diagnostics 287
- SEND/RECEIVE 24
  - Industrial Ethernet 28
  - PROFIBUS 24
- Serial Communication 63
- Setting PG/PC Interface 86
- SIMATIC Manager 136
- SIMATIC NET 82
- SIMATIC Redundancy 344
  - SIMATIC S5 72
  - ETHERNET LAYER 4 76
  - ETHERNET TF 76
  - PMC Ethernet 76
  - PROFIBUS FDL 72
  - PROFIBUS FMS 344
- Single-User 110
- SlotPLC 399
  - Diagnosis 433
  - WinAC 401
- Soft Net 64
  - Diagnostics 170
  - Industrial Ethernet 73
  - PROFIBUS 66
- Star 5
- Subnet 181
- Sub-Net 136
- System 110

#### T
- Tag 44
  - Space Requirement 44
  - Tag Logging Runtime 44
- TCP/IP 174
  - Diagnostics 217
- Telegram 44
  - Number of Telegrams 44
- TF 28
  - Token 23
  - Token Passing 9
  - Topology 5
  - Transfer Medium 8
  - Industrial Ethernet 29
  - MPI 20
  - Tree 5
  - Type Conversion 44
- UDP 28
- Update 110
  - Update Cycle 44
  - Upon Change 44
- WAN 8
- Web Navigator 507
  - Configuring 509
  - Diagnosis 533
  - Web Navigator client 531
  - Web Navigator server 512
  - WinAC 401
  - WinCC Explorer 110
  - WinCC OPC 435
  - WinCC OPC Server 435
  - WinCC OPC XML 474
  - WinCC SlotPLC 399
  - WinCC Web Navigator 507